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Plug-in Overview

TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions provides the interoperability between
TIBCO ActiveMatrix BusinessWorks™ and the SAP system. The plug-in was formerly known as TIBCO
ActiveMatrix® Adapter for SAP. With the plug-in, you can manage and transfer IDocs, and manage and
perform the RFC/BAPI invocation.

TIBCO ActiveMatrix BusinessWorks is a leading integration platform which can integrate a wide variety of
technologies and systems within enterprise and on cloud. TIBCO ActiveMatrix BusinessWorks includes an
Eclipse-based graphical user interface (GUI) provided by TIBCO Business Studio™ for design, testing, and
deployment. If you are not familiar with TIBCO ActiveMatrix BusinessWorks, see the TIBCO ActiveMatrix
BusinessWorks documentation for more details.

This product has certified integration with SAP NetWeaver® and SAP®S/4HANA, on-premises edition.
 

 
 

 

TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions extends TIBCO ActiveMatrix BusinessWorks,
and adds an SAP Connection shared resource, an SAP TIDManager shared resource, and an SAP palette to
TIBCO Business Studio:

● SAP Connection

Use the SAP Connection shared resource to establish bidirectional connections with the SAP system and
download schemas at design time. The Message Source Configuration connection is added where the
Kafka or JMS Server Configurations are maintained.

● SAP TIDManager

Use the SAP TIDManager shared resource to manage the check of duplicate IDoc messages published
from the SAP system.

● SAP Palette

— Dynamic Connection

Use the Dynamic Connection activity to establish a dynamic connection for invoking RFC/BAPIs.

— IDoc Acknowledgment

Use the IDoc Acknowledgment activity to update the IDoc status in the SAP system.

— IDoc Confirmation

Use the IDoc Confirmation activity to confirm the status of the IDocs posted to the SAP system.

The IDoc Confirmation activity requires TIBCO Enterprise Message Service. For
confirming IDocs without using TIBCO Enterprise Messaging Service, see IDoc Processing
Without Messaging

— IDoc Converter

Use the IDoc Converter activity to convert a raw IDoc into XML output. For more information on
this activity, see IDoc Processing Without Messaging

— IDoc Listener
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Use the IDoc Listener activity to receive the IDocs published from the SAP system.

The IDoc Listener activity can be configured to use either the TIBCO Enterprise Messaging
Service or Apache Kafka. This activity can also be configured without using messaging.
For more information on using the IDoc Listener activity without messaging, see IDoc
Processing Without Messaging

— IDoc Parser

Use the IDoc Parser activity to retrieve the IDocs processed by the IDoc Listener activity, and then
parse the IDocs as the activity output.

The IDoc Parser activity requires the TIBCO Enterprise Messaging Service.

— IDoc Reader

Use the IDoc Reader activity to post the IDocs to the SAP system.

The IDoc Reader activity requires the TIBCO Enterprise Messaging Service.

— Post IDoc to SAP

Use the Post IDoc to SAP activity to post the IDocs to the SAP system without the need to use the
messaging service like TIBCO Enterprise Messaging Service .

— IDoc Renderer

Use the IDoc Renderer activity to receive the IDoc in XML format and provide output in raw IDoc
format.

— RFC BAPI Listener

Use the RFC BAPI Listener activity to listen on the SAP system and receive RFC/BAPI requests from
the SAP system.

— Invoke RFC BAPI in SAP

Use the Invoke RFC BAPI in SAP activity to invoke RFC/BAPIs in the SAP system.

— Reply from RFC BAPI in SAP

Use the Reply from RFC BAPI in SAP activity to receive the return message from the SAP system
when the invocation of the RFC/BAPI is completed.

The plug-in supports the following SAP integration interfaces:

● Business Application Programming Interface (BAPI)

BAPIs are the methods exposed by SAP business objects. This interface is best used with the plug-in for
performing real-time queries and updates to and from the SAP system. BAPIs are the SAP
recommended integration interfaces over Remote Function Calls (RFCs).

● RFC

By using the RFC interface, non-SAP and SAP applications can execute SAP Advanced Business
Application Programming (Advanced Business Application Programming) functions, which have been
RFC-enabled. They are similar to BAPIs in functionality, but are not attached to SAP business objects.

● Application Link Enabling/Intermediate Documents (ALE/IDoc)

IDocs are document containers for business transactional data, such as sales orders (for example:
ORDERS01) and order invoices (for example: INVOIC02). ALE helps achieve cross-business
functionality and facilitates the event driven, asynchronous exchange of information directly out of
business transactions.

6

TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions User's Guide



Getting Started

This tutorial is designed for the beginners who want to use TIBCO ActiveMatrix BusinessWorks Plug-in for
SAP Solutions in TIBCO Business Studio.

All the operations are performed in TIBCO Business Studio. See TIBCO Business Studio Overview to get
familiar with TIBCO Business Studio.

A basic procedure of using TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions includes:

1. TIBCO Business Studio Overview

2. Creating a Project

3. Creating and Configuring an SAP Connection

4. (Optional) Creating and Configuring an SAP TIDManager Shared Resource

5. Configuring a Process

6. Testing a Process

7. Deploying an Application

When configuring the shared resources or activities, you might find that some fields inherit the module
properties. To specify those fields, you have to specify the corresponding module properties in the Module
Properties tab of the Module Properties editor.

TIBCO Business Studio Overview
TIBCO Business Studio is an Eclipse-based integration development environment, which is used to design,
develop, and test ActiveMatrix BusinessWorks applications.

TIBCO Business Studio provide a workbench in which you can create, manage, and navigate resources in
your workspace. A workspace is the central location on your machine where all data files are stored.

The following table introduces the workbench UI elements highlighted in the image:
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Sl. No. UI Element Description

1. Menu Contains menu items such as File, Edit, Navigate, Search,
Project, Run, Window, and Help.

2. Toolbar Contains buttons for frequently used commands such as:

● New 

● Save 

● Enable/Disable Business Studio Capabilities 

● Create a new BusinessWorks Application Module 

● Debug 

● Run 

3. Perspectives Contains an initial set and layout of views must perform a
certain task. TIBCO Business Studio opens the Design
perspective by default. Use the DESIGN perspective when
designing a process and the Debug perspective when
testing and debugging a process. To change the
perspective, select Window > Open Perspective >
perspective_name from the main menu. Or, you can click
the icon at the upper right-hand side of the workbench
and select the perspective to open.

4. Views Displays resources and allow for navigation in the
workbench. For example, the Project Explorer view
displays the ActiveMatrix BusinessWorks applications,
modules, and other resources in your workspace, and the
Properties view displays the properties for the selected
resource. To open a view, select Window > Show View >
view_name from the main menu.

5. Editors Provides a canvas to configure, edit, or browse a resource.
Double-click a resource in a view to open the appropriate
editor for the selected resource. For example, double-click
on a process (MortgageAppConsumer.bwp) in the Project
Explorer view to open the process in the editor.

6. Palette Contains a set of widgets and a palette library. A palette
groups activities that perform similar tasks and provide
quick access to activities when configuring a process.

Creating a Project
The first task using the plug-in is creating a project. After creating a project, add resources and processes.

An Eclipse project is an application module configured for TIBCO ActiveMatrix BusinessWorks. An
application module is the smallest unit of resources, which is named, versioned, and packaged as part of an
application.
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When you import an existing project to the current workspace of TIBCO Business Studio, if you click Select
root directory in the Import Projects dialog, you must select the Copy projects into workspace check box.

Procedure

1. Start TIBCO Business Studio using one of the following ways:

● Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business
Studio version_number > Studio for Designers.

● Mac OS and Linux: run the TIBCO Business Studio executable file located in the TIBCO_HOME/
studio/version_number/eclipse directory.

On macOS, to load the environment variables in the launchd.conf file correctly, ensure
that the shell is bash when you start TIBCO Business Studio on a command line.

2. From the menu, click File > New > BusinessWorks Resources to open the BusinessWorks Resource
wizard.

3. In the Select a wizard dialog box, click BusinessWorks Application Module and click Next to open the
New BusinessWorks Application Module wizard.

4. In the Project dialog box, configure the project that you want to create:
a) In the Project name field, enter a project name.
b) By default, the created project is located in the workspace current in use. If you do not want to use

the default location for the project, clear the Use default location check box and click Browse to
select a new location.

c) Use the default version of the application module, or enter a new version in the Version field.
d) Keep the Create empty process and Create Application check boxes selected to automatically create

an empty process and an application when creating the project.
e) Select the Use Java configuration check box if you want to create a Java module.

A Java module provides the Java tooling capabilities.
f) Click Finish to create the project.

Result

The project with the specified settings is displayed in the Project Explorer view.
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Creating and Configuring an SAP Connection
After creating a project, you can add an SAP Connection shared resource to establish connections between
the plug-in and the SAP system.

Prerequisites

The SAP Connection shared resource is available at the Resources level. Ensure that you have created a
project. See Creating a Project for details.

Procedure

1. In the Project Explorer view, expand the created project.

2. Right-click the Resources folder, and then click New > SAP Connection to open the SAP Connection
wizard.

3. In the New SAP Connection dialog, the resource folder, package name, and resource name of the SAP
connection are provided by default. If you do not want to use the default configurations, change them
accordingly. Click Finish to open the SAP Connection editor.

● In a project, all the SAP Connection shared resources cannot use the same name, even if the
shared resources belong to different packages.

● When the SAP Connection shared resource is created for the first time in a TIBCO
ActiveMatrix BusinessWorks project, predefined module properties starting with SAP* are
created. The predefined module properties must not be deleted.

4. In the Client Connection panel, select a client connection type from the Connection Type list.

5. In the Project Explorer view, expand the Module Descriptors folder under the created project, and then
double-click Module Properties to open the Module Properties editor.

6. Specify the corresponding module properties inherited by the basic parameters of the client connection.
See Client Connection for details. Click Save.

7. Return to the SAP Connection editor, and then click Test Connection to validate the client connection in
the Client Connection Configuration tab.

8. If you want to establish an outbound connection with the SAP system, click the Server Connection
Configuration tab to configure the server connection:
a) In the Server Connection panel, select the Enabled check box.
b) From the Connection Type list, select a connection type.
c) In the Module Properties editor, specify the corresponding module properties inherited by the basic

parameters of the server connection.
See Server Connection for details.
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9. In the Message Source Configuration tab, the configurations for Kafka, JMS, or NoMessaging can be
added. For Kafka, the configurations need to be added at the shared resource level. For JMS and
NoMessaging, it can be added at the activity level or the shared resource level.

10. Click Save

Creating and Configuring an SAP TIDManager Shared Resource
To manage the check of duplicate IDoc messages published from the SAP system, create an SAP
TIDManager shared resource.

The SAP TIDManager shared resource is only used in the IDoc Listener activity.

Prerequisites

The SAP TIDManager shared resource is available at the Resources level. Ensure that you have created a
project. See Creating a Project for details.

Procedure

1. Expand the created project in the Project Explorer view.

2. Right-click the Resources folder and click New > SAP TIDManager to open the SAP TIDManager
wizard.

3. In the SAP TIDManager dialog, the resource folder, package name, and resource name of the SAP
TIDManager shared resource are provided by default. If you do not want to use the default
configurations, change them accordingly. Click Finish to open the SAP TIDManager editor.

In a project, all the SAP TIDManager shared resources cannot use the same name, even if the
shared resources belong to different packages.

4. From the TID Management resource list, select a mode:

● None: the check of duplicate IDoc messages is disabled. The database table is not required.

If the system or application that receives the IDocs can handle the duplicate IDoc messages, select
None from the TID Management resource list.

● Active: the check of duplicate IDoc messages is enabled. The database table is required to store the
TID information.

For the supported databases, see the readme file.
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5. If you select Active from the TID Management resource list, configure the SAP TIDManager shared
resource to do the check of duplicate IDoc messages:
a) From the Database Driver list, select a JDBC driver according to the type of the database to be

connected.
b) Specify values for the following fields:

● Database URL: the URL of the database to be connected.

● Username: the valid user name used to connect to the database.

● Password: the valid password corresponding to the user name.
c) Click Test Connection to validate the connection.

6. Click Save.

Configuring a Process
After creating a project, an empty process is created. You can add activities to an empty process to complete
a task.

Prerequisites

Ensure that you have created an empty process when creating a project. See Creating a Project for details.

Procedure

1. In the Project Explorer view, click the created project and open the empty process from the Processes
folder.

2. Select an activity from the Palette view and drop it in the Process editor.
For example, select and drop the RFC BAPI Listener, the Invoke RFC BAPI in SAP, and the Reply from
RFC BAPI in SAP activities from the SAP palette.

3. Drag the  icon to create a transition between the added activities.

4. Configure the added SAP activities.
See SAP Palette for details.
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When mapping the output of the previous activity as the input of the current activity, choose
the AutoMap option.

5. Click File > Save to save the project.

Testing a Process
After configuring a process, test the process to check whether the process completes your task.

Prerequisites

Ensure that you have configured a process. See Configuring a Process for details.

Procedure

1. On the toolbar, click  Debug > Debug Configurations.

2. Click BusinessWorks Application > BWApplication in the left panel.
By default, all the applications in the current workspace are selected in the Applications tab. Ensure
that only the application you want to debug is selected in the Applications tab in the right panel.

3. Click Debug to test the process in the selected application.
TIBCO Business Studio changes to the Debug perspective. The debug information is displayed in the
Console view.

4. In the Debug tab, expand the running process and click an activity.

5. In the upper-right corner, click the Job Data tab, and then click the Output tab to check the activity
output.

Deploying an Application
After testing, if the configured process works as expected, deploy the application that contains the
configured process into a runtime environment, and then use the bwadmin utility to manage the deployed
application.

Before deploying an application, you must generate an application archive, which is an enterprise archive
(EAR) file created in TIBCO Business Studio.

Deploying an application involves the following tasks:

1. Uploading an application archive

2. Deploying an application archive

3. Starting an application

See TIBCO ActiveMatrix BusinessWorks Administration for more details about how to deploy an application.
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Preparing the SAP System

Before using the plug-in, you have to ensure that your SAP account and your SAP system meet the
following requirements, and you must enable the SAP system for messaging with the TIBCO environment.

No modifications of code are required in the SAP system itself.

SAP Account Requirements
An SAP account is required to connect to the SAP system to communicate with the plug-in.

Before configuring the plug-in at design time, ensure that your SAP account and your SAP system meet the
following requirements:

● Your SAP account has access to a dedicated SAP application server and has permission to extract
metadata for BAPIs, RFCs, and IDocs by using TIBCO Business Studio.

● Your SAP account has authorization from the SAP system administrator to execute RFCs and access
tables in the SAP system.

● If you want to use different connections between design-time and runtime inbound activities, obtain the
relevant connection information.

● If you want to configure a load-balanced inbound activity, obtain the parameters used to connect to a
messaging server for a specific logon group from the SAP Connection shared resource.

● To download SAP schema correctly, the SAP user ID defined in the SAP Connection shared resource
must have access to the following function modules through RFC. Ensure that the security authorization
profiles assigned to the SAP user ID have either the appropriate function group or function module.

— IDOCTYPES_LIST_WITH_MESSAGES

— IDOCTYPE_READ_COMPLETE

— RFC_GET_STRUCTURE_DEFINITION_P

— RFC_FUNCTION_SEARCH

— RFC_GET_FUNCTION_INTERFACE_P

— DDIF_FIELDINFO_GET

— SWO_QUERY_OBJTYPES

— SWO_QUERY_ATTRIBUTES

— SWO_QUERY_METHODS

IDocs/RFCs/BAPIs specific to a particular language cannot be retrieved if you log on to the SAP system
from the SAP GUI or TIBCO Business Studio with a different language.

Enabling Outbound Messaging
To enable outbound messaging at run time, ensure that you implement the configurations of invoking
BAPIs/RFCs and publishing IDocs from the SAP system.
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Implementing Configurations of Invoking BAPIs/RFCs from the SAP System
To enable outbound messaging at run time, you have to implement the configurations of invoking BAPIs/
RFCs from the SAP system.

Procedure

1. Define an RFC destination in the SAP system.
After creating an RFC destination, map it to a program ID. The outbound activity is registered on the
SAP gateway with this program ID. Therefore, the outbound activity can receive BAPIs/RFCs invoked
on the RFC destination.

For details, see "Defining Logical Systems and RFC Destinations" at http://help.sap.com/saphelp_srm70/
helpdata/en/9f/9925413fabef23e10000000a155106/content.htm.

2. Ensure that your SAP account is authorized to execute BAPIs and RFCs.

Implementing Configurations of Publishing IDocs from the SAP System
To enable outbound messaging, you have to implement the configurations of publishing IDocs from the
SAP system.

Procedure

1. Create a logical system for the plug-in.
For details, see "Defining/Setting Up a Logical System" at http://help.sap.com/saphelp_nw73/
helpdata/en/aa/b4b13b00ae793be10000000a11402f/content.htm.

2. Create a distribution model.
For details, see "Creating the ALE Distribution Model" at https://help.sap.com/saphelp_erp60_sp/
helpdata/en/56/b1b13bb3acef3ce10000000a11402f/content.htm.

3. Configure RFC communication.

4. Test the SAP ALE configuration.

5. In the SAP system, run transaction code BD12 to send IDocs to any logical system.

Enabling Inbound Messaging
To enable inbound messaging at run time, ensure that you implement the configurations of invoking
BAPIs/RFCs and transferring IDocs from the TIBCO environment in the SAP system.

Implementing Configurations of Invoking BAPIs/RFCs from the TIBCO Environment
To use the plug-in to invoke BAPIs/RFCs in the SAP system, ensure that your account has the authorization
to invoke BAPIs/RFCs.

Authorization for each business activity has to be given to the SAP client when that activity is performed by
using the plug-in. For example, if the inbound activity is configured to create sales orders in the SAP
system, the SAP client requires all the required permissions to create a sales order.

Validate the authorizations in the SAP GUI by executing the BAPI/RFC through the transaction code SE37
without specifying a destination.

15

TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions User's Guide

http://help.sap.com/saphelp_srm70/helpdata/en/9f/9925413fabef23e10000000a155106/content.htm
http://help.sap.com/saphelp_srm70/helpdata/en/9f/9925413fabef23e10000000a155106/content.htm
http://help.sap.com/saphelp_nw73/helpdata/en/aa/b4b13b00ae793be10000000a11402f/content.htm
http://help.sap.com/saphelp_nw73/helpdata/en/aa/b4b13b00ae793be10000000a11402f/content.htm
https://help.sap.com/saphelp_erp60_sp/helpdata/en/56/b1b13bb3acef3ce10000000a11402f/content.htm
https://help.sap.com/saphelp_erp60_sp/helpdata/en/56/b1b13bb3acef3ce10000000a11402f/content.htm


Implementing Configurations of Transferring IDocs from the TIBCO Environment
To enable inbound messaging, you have to implement the configurations of transferring IDocs from the
TIBCO environment to the SAP system.

Procedure

1. Create a logical system for the plug-in.
For details, see "Defining/Setting Up a Logical System" at http://help.sap.com/saphelp_nw73/
helpdata/en/aa/b4b13b00ae793be10000000a11402f/content.htm.

2. Create a distribution model.
For details, see "Creating the ALE Distribution Model" at https://help.sap.com/saphelp_erp60_sp/
helpdata/en/56/b1b13bb3acef3ce10000000a11402f/content.htm.

3. Define a partner profile.
For details, see "Configuring the Port and Partner Profile" at http://help.sap.com/saphelp_erp60_sp/
helpdata/en/88/bac79fd384c64ea61983dd93af507e/frameset.htm.

Implementing Configurations for Acknowledging Outbound IDocs from the TIBCO
Environment

To enable the IDoc Acknowledgment feature, you want to acknowledge IDocs in the TIBCO environment
sent by the SAP system.

Procedure

1. Modify the inbound partner profile for the sending partner on the outbound IDoc with the message
type of ALEAUD and process of AUD1.

2. Maintain accordingly as required configuration maintained in SAP transactions WE47 - Process IDoc
Status Values and WELI - Process Status Groups.
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Working with Secure Communication

The Secure Network Communication (SNC) component secures communication between TIBCO
ActiveMatrix BusinessWorks Plug-in for SAP Solutions and the SAP system.

SNC Introduction
You can use the SNC component for secure communication between TIBCO ActiveMatrix BusinessWorks
Plug-in for SAP Solutions and the SAP system.

SNC provides the following levels of security protection between the plug-in and the SAP system:

● Authentication

● Integrity

● Privacy

For more information about SNC, see "Secure Network Communications (SNC)" at http://help.sap.com/
saphelp_nw70ehp1/helpdata/en/e6/56f466e99a11d1a5b00000e835363f/frameset.htm.

SAP Cryptographic Library for SNC
The SAP Cryptographic Library is the default security product for performing encryption functions in SAP
systems. For example, you can use it for providing SNC.

The SAP Cryptographic Library provides the entire functionality defined in the standard interface of
Generic Security Services Application Programming Interface Version 2 (GSS-API V2).

Setting Up SNC
You can set up SNC in the SAP system and the plug-in.

Procedure

1. Install the SAP Cryptographic Library.
For details, see "Installing the SAP Cryptographic Library on the AS ABAP" at https://help.sap.com/
saphelp_nw70/helpdata/en/96/709b3ad94e8a3de10000000a11402f/frameset.htm.

2. Set the trust manager profile parameters.
For details, see "Setting the Trust Manager Profile Parameters" at https://help.sap.com/saphelp_nw70/
helpdata/en/3d/bf463c6796e61ce10000000a114084/content.htm?frameset=/en/
96/709b3ad94e8a3de10000000a11402f/frameset.htm&current_toc=/en/6a/
44b2420e71c511e10000000a1550b0/plain.htm&node_id=813.

3. Create a SNC PSE.
For details, see "Creating the SNC PSE" at http://help.sap.com/saphelp_nw73ehp1/helpdata/en/
07/03473cbff75b01e10000000a114084/content.htm.

4. Set the SNC parameters.
For details, see "Setting the SNC Profile Parameters" at http://help.sap.com/saphelp_nw73ehp1/
helpdata/en/19/164442c1a1c353e10000000a1550b0/content.htm.

5. Install the SAP Cryptographic Library on the plug-in.
For details, see Installing the SAP Cryptographic Library on the Plug-in.

6. Configure SNC for the connection between AS Java and AS ABAP.
For details, see "Configuring SNC: AS Java to AS ABAP" at http://help.sap.com/saphelp_nw73ehp1/
helpdata/en/c3/d2281db19ec347a2365fba6ab3b22b/content.htm.
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7. Set the SNC parameter specific to an inbound or outbound activity.
For details, see "Configuring SNC: External Programs to AS ABAP Using RFC" at http://help.sap.com/
saphelp_nw73/helpdata/en/d9/e8a740bbaa4d8f8bee6f7b173bd99f/content.htm or "RFC: TCP/IP
Connection - Registered Program" at http://help.sap.com/saphelp_nw73/helpdata/en/4d/
a8410336831f8de10000000a15822b/content.htm.

8. Set SNC in TIBCO Business Studio for the plug-in.
For details, see Setting SNC in TIBCO Business Studio for the Plug-in.

Installing the SAP Cryptographic Library on the Plug-in
To set up SNC, you have to install the SAP Cryptographic Library on the plug-in.

Procedure

1. Obtain the SAP Cryptographic Library installation package, and extract it to a temporary directory.

2. Copy the SAP Cryptographic Library file to a specific folder.
Ensure that you specify the path of this folder in the SNC Lib field in the Client Connection panel of the
Client Connection Configuration tab or the Server Connection panel of the Server Connection
Configuration tab.

3. Create the SEC directory.

4. Set the SECUDIR environment variable to point to the sec directory.

Setting SNC in TIBCO Business Studio for the Plug-in
To set SNC in TIBCO Business Studio for the plug-in, you have to perform the configurations for both the
outbound and inbound activities.

1. To perform the SNC connection configuration for the outbound activity, you have to perform the SNC
configurations in the Server Connection panel of the Server Connection Configuration tab of the SAP
Connection shared resource. For details, see Server Connection .

2. To perform the SNC connection configuration for the inbound activity, you have to perform the SNC
configurations in the Client Connection panel of the Client Connection Configuration tab of the SAP
Connection shared resource. For details, see Client Connection.

3. The plug-in supports additional properties as the part of the SNC connectivity, but these properties are
only available to the Dynamic Connection activity. For details, see Dynamic Connection.
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Enabling Trace for the SAP JCo Libraries

You can use Java properties and environment variables to enable trace for the SAP JCo libraries used by the
plug-in.

For more information about the Java properties, see SAP Help Portal or the SAP JCo documentation.

● Java properties used to enable the JCo trace in the SAP JCo libraries

— jco.trace_level: the trace level for JCo. The value range is 0 - 10.

— jco.trace_path: the location of the path for JCo trace files.

● Java property used to enable the JCo trace at the JNI middleware layer in the SAP JCo libraries

— jrfc.trace: the switch of the RFC trace. Set the value to 1 to enable the RFC trace.

● Environment variables used to enable the CPIC trace between the SAP JCo libraries and the SAP
gateway

— CPIC_TRACE: the level of the CPIC trace. The value range is 0 - 3.

— CPIC_TRACE_DIR: the location of the path for CPIC trace files.

You can configure the Java properties and environment variables in the following ways:

● TIBCO Business Studio

You can configure the Java properties as VM arguments in the ActiveMatrix BusinessWorks application.
In the case of the environment variables, you have to export the variables before starting TIBCO
Business Studio. The JCo trace and CPIC trace messages are stored in the trace files specified.

● AppNodes in TIBCO ActiveMatrix BusinessWorks

If the ActiveMatrix BusinessWorks application is deployed to an AppNode, you can configure the Java
properties and environment variables in the configuration file config.ini.

● TIBCO® Enterprise Administrator

With the web based GUI, you can configure the Java properties as the user-defined properties
maintained at the AppNode level.
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Enabling Java Property for the SAP Activities

If the IDoc data contains one or more end of line characters, then the Java property
com.tibco.bw.palette.sap.IDocCustomDelimiter must be specified.

The value of the java property is of type string and is printed after each IDoc data as a part of the raw IDoc
received by IDoc Listener, IDoc Parser, and IDoc Reader activities.

If the TIBCO ActiveMatrix BusinessWorks™ application containing the IDoc Listener, IDoc Parser, and IDoc
Reader activities are running on separate appnodes ensure the java property
com.tibco.bw.palette.sap.IDocCustomDelimiter is set to the same value for each appnode.

For example, com.tibco.bw.palette.sap.IDocCustomDelimiter=_tibsap_
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SAP Connection

You can use the SAP Connection shared resource to establish bidirectional connections with the SAP system
and download schemas at design time.

● When the SAP Connection shared resource is created for the first time in a TIBCO ActiveMatrix
BusinessWorks project, predefined module properties starting with SAP* are created. The predefined
module properties must not be deleted.

● The SAP connection created in the shared module does not set to default, when SAP Plug-in activities
are created in the application module. User needs to manually select the SAP connection from the
shared module.

● The configuration property RFC/BAPI No of Threads is available in the Advanced section of the Client
Connection for SAP Connection shared resource. The default value is 8 but it should be maintained
accordingly based on the number of BW engine threads available for your SAP application.

General

In the General panel, specify the package where the shared resource is stored in the Package field, and
provide a short description for this shared resource in the Description field. The panel also shows the share
resource name, which you defined when creating the shared resource.

If an SAP Connection shared resource is referenced by an activity and has downloaded schema, you cannot
rename this connection.

The General panels in the Client Connection Configuration, Server Connection Configuration, and the
Message Source Configuration tabs are the same.

Client Connection
You can configure the client connection to establish an inbound connection with the SAP system.

In the Client Connection panel of the Client Connection Configuration tab, specify the basic and advanced
options of the client connection.

After specifying the client connection, you have to click Test Connection to validate the connection.

The following table lists the configurations in the Client Connection panel:

Field
Module
Property? Description

Connection Type No The client connection type.

The plug-in provides the following client connection types:

● Dedicated Application Server
● Load Balancing
● SNC
● SNC with Load Balancing

The default type is Dedicated Application Server.
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Field
Module
Property? Description

Application Server Yes The network name of the machine where the SAP system exists.

This field is displayed only when you select Dedicated
Application Server or SNC from the Connection Type
list.

System Number Yes The SAP system number.

This field is displayed only when you select Dedicated
Application Server or SNC from the Connection Type
list.

System Name Yes The SAP system ID.

This field is displayed only when you select Load
Balancing and SNC with Load Balancing from the
Connection Type list.

Msg Server Yes The message server of the SAP system.

This field is displayed only when you select Load
Balancing and SNC with Load Balancing from the
Connection Type list.

Logon Group Name Yes The SAP logon group server to be used with the load balancing
and SNC load balancing connection.

The default value is PUBLIC.

This field is displayed only when you select Load
Balancing and SNC with Load Balancing from the
Connection Type list.

SNC Mode Yes Whether to enable the SNC connection.

● The value of 1 indicates that the SNC connection is enabled.

● The value of 0 indicates that the SNC connection is disabled.

For more information about SNC, see Working with Secure
Communication.

This field is displayed only when you select SNC and
SNC with Load Balancing from the Connection Type
list.

SNC Partnername Yes The SNC name of the communication partner.

This field is displayed only when you select SNC and
SNC with Load Balancing from the Connection Type
list.
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Field
Module
Property? Description

SNC QOP Yes The protection quality of the SNC connection.

● The value of 1 indicates that only authentication is applied.

● The value of 2 indicates that the integrity protection is
applied.

● The value of 3 indicates that the privacy protection is applied.

● The value of 8 indicates that the default protection is applied.

● The value of 9 indicates that the maximum protection is
applied.

This field is displayed only when you select SNC and
SNC with Load Balancing from the Connection Type
list.

SNC Lib Yes The library path of the external security product.

This field is displayed only when you select SNC and
SNC with Load Balancing from the Connection Type
list.

Client Yes An SAP client number.

Username Yes The valid user name used to log on to an SAP client.

Password Yes The valid password corresponding to the user name.

This password is not required when you log on by
using the SNC connection type.

The following advanced options are displayed when you click Show/Hide Advanced Options:

Language No The language used to connect to the SAP system.

The default language is English.

Code Page Yes The character set used by the SAP system.

The default value is blank.

This field can only be specified in the special cases.
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Field
Module
Property? Description

Maximum Number
of Reconnect
Attempts

Yes The maximum number of times that the plug-in can retry to
establish a connection before sending an IDoc message or RFC/
BAPI request to the SAP system.

The default value is -1, which indicates that the plug-in can retry
indefinitely.

For the IDoc Reader activity, if an IDoc message is
persisted on the JMS destination where the activity
retrieve messages, the attempt can continue infinitely
regardless of the configured number of retries.

Interval between
Reconnect
Attempts(ms)

Yes The time interval in milliseconds between two successive
attempts to establish a connection before sending an IDoc
message or RFC/BAPI request to the SAP system.

The default value is 30000.

Max Connections Yes The number of SAP connections in the client connection.

The default value is 1, and the value range is 1 - 99.

Disable Connection
Pooling

No Whether to disable connection pooling.

If you want to close the connection automatically after the RFC/
BAPI call is completed, select this check box.

This check box is cleared by default.

RFC Trace Yes Whether to enable the RFC trace.

● The value of 1 indicates that the RFC trace is enabled.

● The value of 0 indicates that the RFC trace is disabled.

The default value is 0.

USE SAP GUI Yes Whether to enable the SAP GUI.

● The value of 1 indicates that the SAP GUI is enabled to carry
out debugging of RFCs.

● The value of 2 indicates that the SAP GUI is enabled to carry
out debugging of RFCs until it is used by the invocation of an
RFC.

● The value of 0 indicates that the SAP GUI is disabled to carry
out debugging of RFCs.

The default value is 0.
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Field
Module
Property? Description

RFC/BAPI No. of
Threads

Yes Specifies the number of threads in the thread pool provided by
SAP Connection Shared Resource.

The default value is 8.

● This property controls the number of concurrent
threads used for invoking a RFC/BAPI in SAP and
returning the reply back to the RFC/BAPI Listener
activity.

● The maximum effective number for the number of
threads is 99. If a number larger than 99 is given, at
run time considers the default value which is 8.

Server Connection
You can specify the server connection to establish an outbound connection with the SAP system.

Server Connection

In the Server Connection panel of the Server Connection Configuration tab, you can specify the basic and
advanced options of the server connection.

If you want to enable the server connection, select the Enabled check box and specify the fields in the Server
Connection panel.

When the SAP Connection shared resource is referenced, you cannot do any operations on the Enabled
check box. Therefore, ensure that you have configured the server connection accordingly before using it in
the plug-in activities.

The following fields are available in the Server Connection panel when you select the Enabled check box:

Field
Module
Property? Description

Connection Type No The server connection type.

The plug-in provides the following server connection types:

● Default
● SNC

The default type is Default.
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Field
Module
Property? Description

Program ID Yes The program ID that identifies the RFC server program for the
SAP system. The ProgramID is required by the plug-in but it is up
to you to define the Program ID based on the requirements.

The program ID is case sensitive.

An RFC destination corresponding to the program ID
must exist in the SAP system.

If a server connection is not used by an activity, the
program ID is ignored and not registered in the SAP
system.

Gateway Service Yes The SAP gateway service.

The default service is sapgw00.

● When specifying a value as a service name, the
service name must exist in the services file
maintained at the operating system level. To avoid
having to maintain the services file, the TCP/IP port
number such as 33xx, where xx is the range from 00
to 99, depending on the instance number of the SAP
server can be specified as a value instead.

Gateway Host Yes The Gateway host name, IP address, or router string.

If no machine exists as a gateway host, this field is specified as the
application server.

SNC Mode Yes Whether to enable the SNC connection.

● The value of 1 indicates that the SNC connection is enabled.

● The value of 0 indicates that the SNC connection is disabled.

This field is displayed only when you select SNC from
the Connection Type list.

SNC QOP Yes The protection quality of the SNC connection.

● The value of 1 indicates that only authentication is applied.

● The value of 2 indicates that the integrity protection is applied.

● The value of 3 indicates that the privacy protection is applied.

● The value of 8 indicates that the default protection is applied.

● The value of 9 indicates that the maximum protection is
applied.

This field is displayed only when you select SNC from
the Connection Type list.
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Field
Module
Property? Description

SNC Myname Yes The SNC name of the initiator.

This field is displayed only when you select SNC from
the Connection Type list.

SNC Lib Yes The library path of the external security product.

This field is displayed only when you select SNC from
the Connection Type list.

The following advanced options are displayed when you click Show/Hide Advanced Options:

Maximum time
between two startup
attempts in case of
failures(secs)

Yes The maximum time interval in seconds between two successive
attempts to establish a connection to the gateway host.

If the connection cannot be established after the maximum time
interval, the server connection is suspended.

The default value is 60.

Max Connections Yes The number of SAP connections in the server connection.

The default value is 1, and the value range is 1 - 99.

RFC Trace Yes Whether to enable the RFC trace.

● The value of 1 indicates that the RFC trace is enabled.

● The value of 0 indicates that the RFC trace is disabled.

The default value is 0.

Message Source
You can provide the message source related configuration.

In the Messaging Source Configuration panel of the Message Source Configuration tab, specify the
Messaging Source as JMS or Kafka or No Messaging.

After specifying the Kafka Connection, click the Validate Bootstrap Servers button to check the availability
of host and port.

The following table lists the configurations in the Messaging Source Configuration panel:

Field
Module
Property? Description

Messaging Source No Select the messaging source from the list where the received
IDocs are persisted. The following are the options for the
messaging source:

● JMS

● Kafka

● No Messaging
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Field
Module
Property? Description

JMS Connection No This field is available when JMS is selected in the Messaging
Source field.

Click  to select a JMS Connection shared resource. The JMS
Connection shared resource establishes connections between the
plug-in and the EMS server.

If no matching JMS Connection shared resources are found, click
Create Shared Resource to create one. For more details, see the
TIBCO ActiveMatrix BusinessWorks documentation.

Bootstrap Servers Yes This field is available when Kafka is selected in the Messaging
Source field.

A list of host or port pairs to use for establishing the initial
connection to the Kafka cluster. Multiple hosts and ports can be
added by using the comma separator (,)
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SAP TIDManager

You can use the SAP TIDManager shared resource to manage the check of duplicate IDoc messages
published from the SAP system or check for duplicate tRFC or qRFC calls from the SAP system.

The SAP TIDManager shared resource is used in IDoc Listener and RFC BAPI Listener activities.

The SAP TIDManager created in the shared module does not set to default, when SAP Plugin activities are
created in the application module. User needs to manually select the SAP TIDManager from the shared
module.

General

In the General panel, specify the package where the shared resource is stored in the Package field, and the
name to be displayed as the label for the shared resource in the process in the Name field. You can also
provide a short description for this shared resource in the Description field.

Basic Configuration

In the Basic Configuration panel, select the TID management mode, and specify the related parameters.

If you select Active from the TID Management resource list, you have to click Test Connection to validate
the database connection after specifying the SAP TIDManager shared resource.

The following table lists the configurations in the Basic Configuration panel:
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Field
Module
Property? Description

TID
Management
resource

No The TID management mode.

The plug-in provides the following modes:

● None: the check of duplicate IDoc messages is disabled.

If the system or application that receives the IDocs can handle the
duplicate IDoc messages, you can select the None mode.

When running a process that contains an IDoc Listener
activity configured with the None mode, if the EMS
server does not start, the IDoc transaction is still
confirmed after it is rolled back.

● Active: the check of duplicate IDoc messages is enabled. When an
IDoc is published from the SAP system, the SAP TIDManager
shared resource checks if the activity receives a duplicate TID. If
the TID is a duplicate, the shared resource does not store its
information in the database table and the corresponding message
is not processed. Otherwise, the TID information is stored in the
database table.

The following TID information is stored in the database table:

— TID

— status: CREATED, COMMITTED, and CONFIRMED

— creationDate

— updateDate

For more information, see TIBCO ActiveMatrix BusinessWorks Plug-
in for SAP Solutions Installation for details about how to create a
database table required in active mode.

In the case of bgRFC, when a row of data where the TID is the same
as the last 24 characters of the unit ID and the status is COMMITTED
is available in the database table, no transaction confirmation
operation is performed in the SAP system.

The default mode is Active.

The following fields are displayed when you select Active from the TID Management resource list:

Database Driver Yes The JDBC driver.

For the supported databases, see the readme file.

Database URL Yes The URL of the database to be connected to store the TID
information.

While configuring the Database URL and specifying the
port along with the service name, use the appropriate
delimiter / or : according to the database being used.

Login
Timeout(msec)

Yes The timeout value in milliseconds for logging in to the database.

The default value is 30000.
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Field
Module
Property? Description

Maximum
Connections

Yes The maximum number of connections that the plug-in can use in the
database connection pool.

The default value is 1.

You have to configure the maximum number of
connections according to the number of messages being
processed concurrently by the IDoc Listener activities.

Retry Count Yes The number of times that the shared resource can retry to establish a
connection with the database.

The default value is 3.

Retry
Interval(msec)

Yes The time interval in milliseconds between two successive attempts to
establish a connection with the database.

The default value is 30000.

The actual retry interval is longer than the configured
interval, because the JDBC driver need time to establish
connections and return errors.

Username Yes The valid user name used to log on to the database.

Password Yes The valid password corresponding to the user name.

To support the bgRFC protocol for the IDoc Listener activity, the SAP TIDManager shared resource is
modified to handle the unit ID instead of the TID. The unit ID is sent with the transaction by the SAP
system. Because the unit ID is longer than the TID and the TID is used as a key for the database used by the
SAP TIDManager shared resource, the last 24 characters of the unit ID are used.
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SAP Palette

A palette groups the activities that connect the same external applications together. A SAP palette is added
after installing TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions.

The SAP palette contains the following activities:

● Dynamic Connection

● IDoc Acknowledgment

● IDoc Confirmation

● IDoc Converter

● IDoc Listener

● IDoc Parser

● IDoc Reader

● IDoc Renderer

● Post IDoc to SAP

● Invoke RFC BAPI in SAP

● RFC BAPI Listener

● Reply from RFC BAPI in SAP

The bgRFC protocol of type T is supported for the IDoc Listener activity.

Dynamic Connection
Use the Dynamic Connection activity to create dynamic connections at run time for invoking RFC/BAPIs,
which include RFC/BAPIs as part of a transaction and also posting IDocs using the Post IDoc to SAP
activity.

The Dynamic Connection activity cannot be used to create dynamic connections for invoking RFC/BAPIs in
load-balancing mode.

General Tab

On the General tab, maintain a reference to the SAP Connection shared resource and configure the activity
accordingly to either create a dynamic connection or close an existing dynamic connection.

The following table lists the configurations on the General tab of the Dynamic Connection activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.
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Field
Module
Property? Description

SAP
Connection

Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes connections between the plug-
in and the SAP system.

If no matching SAP Connection shared resources are found, click
Create Shared Resource to create one. For more details, see Creating
and Configuring an SAP Connection.

The SAP Connection shared resource is used to provide
default settings for any connection parameters not defined in
the input of the activity.

Terminate
Connection

No Select this check box to terminate the dynamic connection when it is no
longer required.

This check box is the same as the Context End check box in the
Advanced tab of the Invoke RFC BAPI in SAP activity. When a
dynamic connection with the selected Transactional check box is used,
if you want to end the transaction, you must select both the Terminate
Connection check box and Transactional check box instead of selecting
the Context End check box.

Transactional No Select this check box to enable the dynamic connection to be used with
one or more RFC/BAPIs as part of a transaction.

● As part of the same ActiveMatrix BusinessWorks process,
using a dynamic connection with RFC/BAPIs running as
a transaction or non-transaction is not supported.

● The Transactional check box is not applicable for the Post
IDoc to SAP activity.

Description Tab

On the Description tab, enter a short description for the Dynamic Connection activity.

Input Tab

On the Input tab, specify detailed information for the dynamic connection you want to configure for
invoking RFC/BAPIs.

The following table lists the input elements on the Input tab of the Dynamic Connection activity:

Input Item Data Type Description

sessionID String Enter the session ID of the dynamic connection that is used for
invoking RFC/BAPIs and for posting IDocs using Post IDoc to
SAP activity.

The session ID has to be mapped when you are terminating an
existing dynamic connection.
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Input Item Data Type Description

contextTimeout Long Enter the timeout value in milliseconds for the activity to wait
for the subsequent activity to be invoked.

The default value is 30000. This field is used only when the
dynamic connection is used as part of a transaction.

This input element is the same as the Commit Expiry(ms) field
in the Advanced tab of the Invoke RFC/BAPI activity, and can
be overwritten by the Commit Expiry(ms) field.

● The module property of the long type cannot be
left blank, and its value range does not include
negative numbers.

● If you set the value of this input item to negative
numbers or zero, the default value of 30000 is
used automatically at run time.

The following input elements are under the DynamicConnections node:

connectionType String Specify the type of the dynamic connection.

The value of this input element is not case-sensitive.

● The value of 1 or dedicated indicates the dedicated
connection.

● The value of 2 or logongroup indicates the SAP logon
group connection.

● The value of 3 or snc indicates the SNC connection. For
more information about SNC, see Working with Secure
Communication.

● The value of 4 or sncwithlogongroup indicates the SNC
with Load Balancing connection.

appServer String Specify the SAP application server by using either the host
name or IP address.

systemNumber String Specify the system number of the SAP system.

client String Specify the client number of the SAP system.

userName String Specify the user ID used to log on to the SAP system.

password String Specify the password for logging on to the SAP system.

The password attribute is part of the XSD schema. You have to
define a module property as the password type, and map the
defined module property to the password.

This password is not required when you log on by
using the SNC connection type.
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Input Item Data Type Description

systemName String Specify the ID of the SAP system.

This field is required when using the connections of the logon
group and sncwithlogongroup type.

msgServer String Specify the SAP message server used for load balancing.

This field is required when using the connections of the logon
group and sncwithlogongroup type.

groupName String Specify the name of the SAP logon group.

This field is required when using the connections of the logon
group and sncwithlogongroup type.

snc_mode String Specify whether to enable SNC connectivity.

● To disable SNC connectivity, set the value to 0 .

● To enable SNC connectivity, set the value to 1.

snc_partnername String Specify the SNC name of the communication partner, which is
an application server, when you set snc_mode to 1.

snc_qop String Specify the SNC quality of protection if you set snc_mode to 1.

● To apply only authentication, set the value to 1.

● To apply integrity protection, set the value to 2.

● To apply privacy protection, set the value to 3.

● To apply the default protection, set the value to 8.

● To apply the maximum protection, set the value to 9.

snc_lib String Specify the path of the crypto libraries on the machine where
the ActiveMatrix BusinessWorks process is running.

snc_bSSO Specify whether to enable Single Sign-On (SSO).

● Set the value to 0 to disable SSO.

● Set the value to 1 to enable SSO.

snc_SSOrecv String Specify the string of the SSO logon ticket.

snc_x509 String Specify the X.509 certificate that the SNC connection uses for
authentication.

codePage String Specify the character sets used by SAP and databases.

The default value is blank.
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Input Item Data Type Description

language String Specify the language used to log on to the SAP system.

You can only specify a 1-character value for this field. If the
value is not populated, the default value is E, indicating
English.

rfcTrace String Specify whether to enable RFC trace as part of the connection.

● To disable RFC trace, set the value to 0, OFF, or false.

● To enable RFC trace, set the value to 1, ON, or true.

useSAPGUI String Specify whether to enable SAP GUI as part of the connection.

● To disable SAP GUI from carrying out debugging of RFCs,
set the value to 0.

● To enable SAP GUI to carry out debugging of RFCs, set the
value to 1.

● To enable SAP GUI to carry out debugging of RFCs until
used by an invocation of an RFC, set the value to 2.

Output Tab

The Output tab displays the detailed information about the dynamic connection.

The following table lists the output elements on the Output tab of the Dynamic Connection activity:

Output Item Data Type Description

sessionID String Displays the session ID associated with the dynamic
connection.

This is the same session ID that is mapped to the input schema
of the Invoke RFC/BAPI in SAP activity or posting IDocs in
Post IDoc to SAP activity or the Dynamic Connection activity
where the connection is being terminated.

CPIC_ID String Displays the CPIC ID associated with the dynamic connection
as part of a transaction.

The CPIC ID is provided only for information purposes.

The following input elements are under the DynamicConnections node:
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Output Item Data Type Description

connectionType String Displays the type of the dynamic connection.

The value of this output element is not case sensitive.

● The value of 1 or dedicated indicates the dedicated
connection.

● The value of 2 or logongroup indicates the SAP logon
group connection.

● The value of 3 or snc indicates the SNC connection.

● The value of 4 or sncwithlogongroup indicates the SNC
with Load Balancing connection.

appServer String Displays the SAP application server specified by using either
the host name or IP address.

systemNumber String Displays the system number of the SAP system.

client String Displays the client number of the SAP system.

userName String Displays the user ID used to log on to the SAP system.

password String Displays the password for logging on to the SAP system.

systemName String Displays the ID of the SAP system.

msgServer String Displays the SAP message server used for load balancing.

groupName String Displays the name of the SAP logon group.

snc_mode String Displays whether to enable SNC connectivity.

snc_partnername String Displays the SNC name of the communication partner, which
is an application server, if you set snc_mode to 1.

snc_qop String Displays the SNC quality of protection if you set snc_mode to
1.

snc_lib String Displays the path of the crypto libraries on the machine where
the ActiveMatrix BusinessWorks process is running.

snc_bSSO Displays whether to enable SSO.

snc_SSOrecv String Displays the string of the SSO logon ticket.

snc_x509 String Displays the X.509 certificate that the SNC connection uses for
authentication.

codePage String Displays the character sets used by SAP and databases.

language String Displays the language used to log on to the SAP system.
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Output Item Data Type Description

rfcTrace String Displays the string to enable RFC trace as part of the
connection.

useSAPGUI String Displays the string to enable SAP GUI as part of the
connection.

Fault Tab

On the Fault tab, you can find the error codes and error messages of the Dynamic Connection activity. See 
Error Codes for more detailed explanation of errors.

The following table lists error schema elements on the Fault tab of the Dynamic Connection activity:

Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.

IDoc Acknowledgment
Use the IDoc Acknowledgment activity to update the IDoc status in the SAP system. The IDoc status can be
updated for either positive or negative acknowledgments.

The ALEAUD message type along with the basic ALEAUD01 type is used for updating the IDoc status in
the SAP system. Even though the ALEAUD01 IDoc supports the sending of multiple IDoc status updates,
an ALEAUD01 IDoc is sent for each IDoc, which has to be updated in the SAP system.

General Tab

On the General tab, establish a connection to the SAP system.

The following table lists the configurations on the General tab of the IDoc Acknowledgment activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.

SAP
Connection

Yes Select the SAP Connection shared resource when you click .

The SAP Connection shared resource establishes connections between
the plug-in and the SAP system. If no matching SAP Connection
shared resources are found, click Create Shared Resource to create
one. For more details, see Creating and Configuring an SAP
Connection.

Description Tab

On the Description tab, enter a short description for the IDoc Acknowledgment activity.
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Input Tab

On the Input tab, specify detailed information about the IDoc status that you want to update in the SAP
system.

The following table lists the input elements on the Input tab of the IDoc Acknowledgment activity:

Input Item Data Type Description

idocStatus String (Optional) The status of the IDoc that you want to
update.

If the value is not populated, the default value is 39
and it can be used for both negative and positive
acknowledgments. Other statuses can be used at your
discretion or according to the SAP system
requirements. For details, see Implementing
Configurations for Acknowledging Outbound IDocs
from the TIBCO Environment.

statusCode String (Optional) The status code of the IDoc that you want
to update.

If the value is not populated, the default value is TIB.

idocNumber String (Required) The number of the IDoc that you want to
update.

msgType String (Required) The message type of the IDoc that needs to
be updated in the SAP system.

client String (Optional) The client in the SAP system for posting the
status to the IDoc.

If the value is not populated, the default value of
client is the client associated with the specified SAP
Connection shared resource.

senderPort String (Required) The IDoc number that has to be updated in
the SAP system.

senderPartnerNumber String (Required) The sender partner number in the IDoc
control record for posting the ALEAUD IDoc to the
SAP system.

receiverPort String (Required) The receiver port in the IDoc control record
for posting the ALEAUD IDoc to the SAP system.

receiverPartnerNumber String (Required) The receiver partner number in the IDoc
control record for posting the ALEAUD IDoc to the
SAP system.
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Input Item Data Type Description

successMessage String (Optional) The success message.

If successMessage is mapped to a value, a positive
acknowledgment is sent to the SAP system.

If the success message specified in this field
has more than 150 characters, only the first
150 characters of the success message are
displayed in the SAP system.

errorMessage String (Optional) The error message.

If errorMessage is mapped to a value, a negative
acknowledgment is sent to the SAP system.

If the error message specified in this field
has more than 150 characters, only the first
150 characters of the error message are
displayed in the SAP system.

● If you specify values for both the successMessage and errorMessage input elements at run time, a
negative acknowledgment is sent to the SAP system.

● If you do not specify values for both the successMessage and errorMessage input elements at run
time, no acknowledgment is sent to the SAP system, and the IDoc status in the SAP system is not
updated.

Output Tab

On the Output tab, find the IDoc acknowledgment results.

The following table lists the output elements on the Output tab of the IDoc Acknowledgment activity:

Output Item Data Type Description

TID String Displays the TID corresponding to the ALEAUD
IDoc used for updating the IDoc status in the SAP
system.

Fault Tab

In the Fault tab, you can find the error codes and error messages of the IDoc Acknowledgment activity. See 
Error Codes for more detailed explanation of errors.

The following table lists error schema elements on the Fault tab of the IDoc Acknowledgment activity:

Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.
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IDoc Confirmation
Use the IDoc Confirmation activity to confirm the status of the IDoc posted to the SAP system.

Before using the IDoc Confirmation activity, you have to select the IDoc Confirmation check box and
specify a destination in the Confirm IDoc Destination field in the Advanced tab of the IDoc Reader activity.

● The IDoc Confirmation activity requires TIBCO Enterprise Message Service. For confirming IDocs
without using TIBCO Enterprise Messaging Service, see IDoc Processing without Messaging

● When the IDoc Confirmation activity is processing messages, if an EMS server restarts, this activity
occasionally generates duplicate confirmation messages for the same IDoc.

● The IDoc Confirmation activity does not support the job tuning property, FlowLimit.

See Job Tuning for details.

General Tab

On the General tab, establish connections to the SAP system and the EMS server separately.

The following table lists the configurations on the General tab of the IDoc Confirmation activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.

SAP
Connection

Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes connections between the plug-
in and the SAP system.

If no matching SAP Connection shared resources are found, click
Create Shared Resource to create one. For more details, see Creating
and Configuring an SAP Connection.

Messaging
Source

No Specify the transport used by the activity.

Only the JMS type is supported.

JMS
Connection

Yes Click  to select a JMS Connection shared resource. The JMS
Connection shared resource establishes a connection between the plug-
in and the EMS server where the activity retrieves the IDoc to be
posted.

The JMS Connection shared resource is used for reading messages
containing IDoc data that has to be confirmed.

If no matching JMS Connection shared resources are found, click
Create Shared Resource to create one. For more details, see the TIBCO
ActiveMatrix BusinessWorks documentation.
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Field
Module
Property? Description

Max Session Yes The number of IDoc messages to be processed concurrently.

The default value is 1.

If you set the value of this field to negative numbers or zero, the value
of 1 is used automatically at run time.

See Job Tuning for details.

Description Tab

On the Description tab, enter a short description for the IDoc Confirmation activity.

Advanced Tab

On the Advanced tab, specify the destination used for reading messages containing IDoc data that has to be
confirmed.

The following table lists the configurations on the Advanced tab of the IDoc Confirmation activity:

Field
Module
Property? Description

Sequence Key No This field contains an XPath expression that specifies the order in
which the process runs. Process instances with sequencing keys that
have the same value are executed sequentially in the order in which the
process instances were created.

Custom Job Id No This field contains an XPath expression that specifies a custom job ID
for the process instance. This ID is displayed in the TIBCO
Administrator View Service dialog, and it is also available in the
$_processContext process variable.

Confirm IDoc
Destination

Yes The destination is used for reading messages containing IDoc data that
has to be confirmed.

This destination has to match the value of the Confirm IDoc
Destination field in the Advanced tab of IDoc Reader activity.

Output Tab

On the Output tab, you can find the IDoc confirmation results.

The following table lists the output elements on the Output tab of the IDoc Confirmation activity:

Output Item Data Type Description

TID String Displays the TID populated in the message from
the IDoc Reader activity.

correlationID String Displays the correlation ID populated in the
message from the IDoc Reader activity.
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Output Item Data Type Description

errorMessage String Displays the error message from either the IDoc
Reader or IDoc Confirmation activity during
processing.

If the IDoc Reader activity generates an error, no
further processing takes place in the IDoc
Confirmation activity, and the error message
reflects error information returned by the IDoc
Reader activity.

successMessage String Displays the success message only populated in
the case where the IDoc to be confirmed is sent to
the SAP system by using qRFC.

Because the IDoc number cannot be retrieved in
that case, no call is made to the SAP system for the
IDoc number and status. The value of the
successMessage output item is populated in the
following format:

IDoc sent to SAP via qRFC. IDoc number is

unavailable. The original TID is TID.

idocNumber String Displays the IDoc number populated by the IDoc
Confirmation activity by retrieving the
information from the SAP system.

The IDoc number is populated only
when the IDoc is posted to SAP by
using the tRFC protocol.

idocStatus String Displays the IDoc status populated by the IDoc
Confirmation activity by retrieving the
information from the SAP system.

The IDoc status is populated only when
the IDoc is posted to SAP by using the
tRFC protocol.
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IDoc Converter
Use the IDoc Converter activity to convert a raw IDoc received by the IDoc Listener activity from the SAP
system.

● To use the raw IDoc from the IDoc Listener activity as input, in the Doc Listener activity on the General
Tab select the NoMessaging option in the Messaging Source field.

● When the IDoc is fetched from the IDoc Converter activity, the XPath expression on the transition is set
and condition type changes to Success with Condition automatically based on the IDOCTYP and
CIMTYP fields from the SAPIDOC element provided on output from the IDoc Listener activity.
However, additional fields can be added as needed.

● To ensure the XPath expression is generated successfully, you need to specify the
idocListenerStatusListNOMSG schema and map to the IDoc Converter activity.

● If an IDoc is received by the IDoc Listener activity and there is no matching transition to the IDoc
Converter activity, then no further processing occurs for that IDoc. If notification or any required step is
needed then ensure that there is a transition from the IDoc Listener activity where the Condition Type
on the transition is set to Success with No Matching Condition.

General Tab

On the General tab, establish a connection to the SAP system for downloading the IDoc Schema.

The following table lists the configurations on the General tab of the IDoc Converter activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.

SAP
Connection

Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes an inbound connection
between the plug-in and the SAP system.

If no matching SAP Connection shared resources are found, right-click
the Resources folder, and then click New > SAP Connection to create a
new connection. For more information, see Creating and Configuring a
SAP Connection for details.

The connection to SAP system is only used for downloading
the IDoc schema during configuration of project.
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Field
Module
Property? Description

IDoc Name No Click Fetch IDoc to download the schema of the IDoc

In the Search IDoc dialog box, complete the following tasks:

1. Specify the IDoc filter to filter out the required IDoc types with the
basic IDoc type name.

The IDoc filter supports the wildcard search. The default value of
the IDoc Filter field is .*, and the value of this filed is case
sensitive.

2. Select an IDoc type.

● Basic Type: select Basic Type if you want to download the IDoc
schema of the basic type. Only the basic IDoc types matching
the IDoc filter can be filtered out.

● Extended Type: select Extended Type if you want to download
the IDoc schema of the extended type. The extended IDoc type
name includes the name of the basic IDoc type that it is
extended from. Therefore, the extended IDoc types can be
filtered out by using the corresponding basic IDoc type name.

3. Click Fetch IDoc.

4. Select the IDoc type that you want to download and click OK.

Ensure that the selected IDoc type and the associated segments
have been released in the SAP system.

You must clear the Download IDoc specific to SAP release check
box to filter those IDocs that have been released, but do not have a
release number assigned.

When the IDoc schema is downloaded, an XSD file is created. The XSD
file cannot be visible in the project, but it can be picked from the
activity if required.

● When an IDoc schema is downloaded to the plug-in, if
new segment definitions are added to the IDoc schema
because of the upgrade of the SAP system, you have to
refresh the IDoc schema in the plug-in.

● You must specify the correct version for the Seg. release
in IDoc type field in the outbound partner profile so that
the version of the segment definition in the downloaded
IDoc schema matches the version of the IDoc type from
the SAP system.

● If the IDoc schema requires to be refreshed from the SAP
system, then ensure that the Download IDoc specific to
SAP release check box is configured accordingly. The
Download IDoc specific to SAP check box is by default
always selected whenever the user clicks the Fetch IDoc
button.
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Field
Module
Property? Description

IDoc Output
Mode

No Specify the output of the IDoc Converter activity.

Default value is XML.

Description Tab

On the Description tab, enter a short description for the IDoc Converter activity.

Input Tab

On the Input tab, map the data being outputted from the IDoc Listener activity or Start activity (if using a
subprocess).

The following table lists the input elements on the Input tab of the IDoc Converter activity:

Input Item Data Type Description

SAPIDoc Complex Map the SAPIDOC element outputted from the IDoc Listener or
Start activity (if using a subprocess)

IDoc Complex Map the IDOC element outputted from the IDoc Listener or Start
activity (if using a subprocess)

Output Tab

The Output tab of the IDoc Converter activity shows the parsed IDoc in the XML format.

The output of the IDoc Converter activity follows the following rules:

● Any space characters at the beginning of the output item value are preserved.

● Any space characters at the end of the output item value are removed.

● When space characters at the end of the output item value are removed, and if the output item has no
value left, then the corresponding output item is not displayed in the activity output.

Fault Tab

On the Fault tab, you can the find the error codes and error messages of the IDoc Converter activity. See 
Error Codes for more detailed explanation of errors.

The following table lists error schema elements on the Fault tab of the IDoc Converter activity:

Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.

IDoc Listener
Use the IDoc Listener activity to receive IDocs published from the SAP system.

The IDoc Listener activity can process different IDoc messages using the same program ID, including
extended and customized basic IDocs.
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The IDocs are persisted to the TIBCO transport, for example, EMS, and confirmed in the SAP system. The
IDoc Listener activity serializes the IDoc data to the transport by using the raw IDoc format.

IDocs of SAP port type 4x are only supported using the tRFC, qRFC, and bgRFC (Type T only) protocols.

● The IDoc Listener activity is configured to use either the TIBCO Enterprise Messaging Service or Apache
Kafka. This activity can also be configured without using messaging service. For more information on
using the IDoc Listener activity without messaging service, see IDoc Processing Without Messaging

● In a project, the IDoc Listener activities cannot use the same SAP connection or the SAP connections
with the same combination of the gateway host, the gateway service, and the program ID.

● You need to delete the JMS Connection property from the process properties file if you are switching
from JMS Message Resource to NoMessaging or Kafka.

If you want to control the number of messages being processed concurrently by the activity, choose one of
the following configurations:

● Configure the Max Connections field of the referenced server connection according to the number of all
the IDoc Listener and RFC BAPI Listener activities and whether the TID management mode is Active .

● Configure the RFC destination accordingly by using the SAP transaction code, SMQS.

The IDoc Listener activity does not support the job tuning property, FlowLimit.

See Job Tuning for details.

General Tab

On the General tab, establish connections to the SAP system and the messaging source separately, and
choose an SAP TIDManager shared resource to manage the check of the duplicate IDoc messages.

The following table lists the configurations on the General tab of the IDoc Listener activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.

SAP
Connection

Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes connections between the plug-
in and the SAP system at run time.

Ensure that you have created an SAP Connection shared resource
accordingly first. For more details, see Creating and Configuring an
SAP Connection.

● The server connection created by clicking Create Shared
Resource cannot be enabled.

● When the server connection of an SAP Connection shared
resource is not enabled, you still can select this shared
resource by selecting the corresponding process property.
Therefore, if you want to select the SAP Connection
shared resource by selecting the corresponding process
property, ensure that the server connection of the shared
resource has been enabled.
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Field
Module
Property? Description

SAP TID
Manager

Yes Click  to select an SAP TIDManager shared resource. The SAP
TIDManager shared resource can manage the check of duplicate IDoc
messages for the activity.

If no matching SAP TIDManager shared resources are found, click
Create Shared Resource to create one. For more details, see Creating
and Configuring an SAP TIDManager Shared Resource.

Messaging
Source

No The following are the options for messaging source:

● JMS

● Kafka

● NoMessaging

When a messaging option is selected at the activity level,
it takes precedence over the SAP Connection Shared
Resource.

Select the messaging source where the received IDocs are persisted
from the list.

If the transport type is JMS, the control fields are passed as JMS
properties. The property name consists of the SAPIDOC_ prefix and
the IDoc control record field. For example, if the control field is
DOCNUM, the corresponding JMS property is SAPIDOC_DOCNUM.

If the transport type is Kafka, the control fields are passed as Kafka
header parameters.

For the IDoc Listener activity, except for the preceding JMS properties,
you can also use the SAPJCO_ JMS properties to route IDoc messages
to a specific receiver.

If the messaging source is selected as NoMessaging then the IDoc
received from the SAP system is outputted as a raw IDoc. If the raw
IDoc needs to be converted into XML format then process the output
from the IDoc Listener activity using the IDoc Converter activity. For
more information, see IDoc Processing Without Messaging.

JMS
Connection

Yes This field is available only when JMS is selected in the Messaging
Source field.

Click  to select a JMS Connection shared resource. The JMS
Connection shared resource establishes connections between the plug-
in and the EMS server where the activity saves the IDocs received from
the SAP system.

If no matching JMS Connection shared resources are found, click
Create Shared Resource to create one. For more details, see the TIBCO
ActiveMatrix BusinessWorks documentation.
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Field
Module
Property? Description

Producer
Properties

Yes You can provide the Kafka Producer properties for this field. This field
is available only when Kafka is selected in the Messaging Source field.
Multiple properties can be provided in key:value format and the
properties can be separated using the comma separator (,)

Description Tab

On the Description tab, you can enter a short description for the IDoc Listener activity.

Advanced Tab

On the Advanced tab, specify the destination used to persist the IDoc received from the SAP system.

The following table lists the configurations on the Advanced tab of the IDoc Listener activity:

Field
Module
Property? Description

Sequence Key No This field contains an XPath expression that specifies the order in
which the process runs. Process instances with sequencing keys that
have the same value are executed sequentially in the order in which the
process instances were created.

Custom Job Id No This field contains an XPath expression that specifies a custom job ID
for the process instance. This ID is displayed in the TIBCO
Administrator View Service dialog, and it is also available in the
$_processContext process variable. The custom job ID for the process
instance.

IDoc
Destination

Yes This field is available only when JMS is selected in the Messaging
Source field on the General Tab.

The destination is used to persist the IDocs received from the SAP
system.

When Kafka is selected in the Messaging Source field on the
General Tab, this field is not displayed and the Kafka Topic
is created by the plug-in with the IDoc Name.

IDoc
Expiration
(ms)

Yes This field is available only when JMS is selected in the Messaging
Source field on the General Tab.

This field allows for messages to be deleted from the EMS queue if not
processed by the mentioned time message will be removed from EMS
Queue.

This field is maintained in milliseconds (ms) and the default
is 0 where messages will not expire from EMS queue.

Output Tab

On the Output tab, find the information of the received IDocs.

The following table lists the output elements on the Output tab of the IDoc Listener activity:
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Output Item Data Type Description

IDocNumber String Displays the number of the received IDoc.

TID String Displays the TID of the transaction used to publish the IDoc
from the SAP system.

MessageID String This output is available only when JMS is selected in the
Messaging Source field on the General Tab.

Displays the message ID of the received IDoc.

TopicName String This output is available only when Kafka is selected in the
Messaging Source field on the General Tab.

Displays the topic name where the IDoc is published.

PartitionID Integer This output is available only when Kafka is selected in the
Messaging Source field on the General Tab.

The sequence ID of the partition to which a IDoc is sent within a
topic.

Offset Integer This output is available only when Kafka is selected in the
Messaging Source field on the General Tab.

The sequence ID number assigned to each IDoc within a
partition.

SAPIDoc Element This output is only available when No Messaging is selected in
the Messaging Source field on the General Tab.

Displays the IDoc Control record in XML format.

IDoc Element This output is only available when No Messaging is selected in
the Messaging Source field on the General Tab.

Displays the raw IDoc in text format where the IDoc Control
record and all the IDoc Data records are displayed separately.

IDoc Parser
Use the IDoc Parser activity when the XML output is required from the IDoc messages received by the IDoc
Listener activity.

Different IDoc types require different IDoc Parser activities to perform the parse process.

● The IDoc Parser activity requires the TIBCO Enterprise Message Service.

● The IDoc Parser activity does not support the job tuning property, FlowLimit.

See Job Tuning for details.

General Tab

On the General tab, establish connections to the SAP system and the messaging source separately, and
download the schema of the IDoc to be parsed by the IDoc Parser activity.

The following table lists the configurations on the General tab of the IDoc Parser activity:
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Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.

SAP
Connection

Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes an inbound connection
between the plug-in and the SAP system. The inbound connection is
only used to download the IDoc schema at design time.

If no matching SAP Connection shared resources are found, right-click
the Resources folder, and then click New > SAP Connection to create a
new connection. See Creating and Configuring an SAP Connection for
details.
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Field
Module
Property? Description

IDoc Name No Click Fetch IDoc to download the schema of the IDoc to be parsed.

In the Search IDoc dialog box, complete the following tasks:

1. Specify the IDoc filter to filter out the required IDoc types with the
basic IDoc type name.

The IDoc filter supports the wildcard search. The default value of
the IDoc Filter field is .*, and the value of this filed is case
sensitive.

2. Select an IDoc type.

● Basic Type: select Basic Type if you want to download the IDoc
schema of the basic type. Only the basic IDoc types matching
the IDoc filter can be filtered out.

● Extended Type: select Extended Type if you want to download
the IDoc schema of the extended type. The extended IDoc type
name includes the name of the basic IDoc type that it is
extended from. Therefore, the extended IDoc types can be
filtered out by using the corresponding basic IDoc type name.

3. Click Fetch IDoc.

4. Select the IDoc type that you want to download and click OK.

Ensure that the selected IDoc type and the associated segments
have been released in the SAP system.

You need to clear the Download IDoc specific to SAP release
checkbox to filter those IDocs that have been released, but do not
have a release number assigned.

When the IDoc schema is downloaded, an XSD file is created. The XSD
file cannot be visible in the project, but it can be picked from the
activity if required.

● When an IDoc schema is downloaded to the plug-in, if
new segment definitions are added to the IDoc schema
because of the upgrade of the SAP system, you have to
refresh the IDoc schema in the plug-in.

● You must specify the correct version for the Seg. release
in IDoc type field in the outbound partner profile so that
the version of the segment definition in the downloaded
IDoc schema matches the version of the IDoc type from
the SAP system.

● When the IDoc Parser activity is in the same process as
the JMS Send Message activity, if you refresh the IDoc
schema, it might cause TIBCO Business Studio to be
unresponsive. If the IDoc schema has to be refreshed,
temporarily remove the reference of the IDoc schema in
the JMS Send Message activity before refreshing the IDoc
schema.

● If the IDoc schema requires to be refreshed from the SAP
system, then ensure that the Download IDoc specific to
SAP release check box is configured accordingly. The
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Field
Module
Property? Description

Download IDoc specific to SAP check box is by default
always selected whenever the user clicks the Fetch IDoc
button.

Messaging
Source

No The messaging source where the activity retrieves the IDocs to be
parsed.

Only the JMS type is supported.

JMS
Connection

Yes Click  to select a JMS Connection shared resource. The JMS
Connection shared resource establishes a connection between the plug-
in and the EMS server where the activity retrieves the IDocs to be
parsed.

If no matching JMS Connection shared resources are found, click
Create Shared Resource to create one. For more details, see the TIBCO
ActiveMatrix BusinessWorks documentation.

Max Session Yes Specify the number of IDoc messages to be processed concurrently.

The default value is 1.

If you set the value of this field to negative numbers or zero, the value
of 1 is used automatically at run time.

See Job Tuning for details.

Description Tab

On the Description tab, enter a short description for the IDoc Parser activity.

Advanced Tab

On the Advanced tab, specify the destination used to retrieve the IDocs to be parsed, and the message
selector.

The following table lists the configurations on the Advanced tab of the IDoc Parser activity:

Field
Module
Property? Description

Sequence Key No This field contains an XPath expression that specifies the order
in which the process runs. Process instances with sequencing
keys that have the same value are executed sequentially in the
order in which the process instances were created.

Custom Job Id No This field contains an XPath expression that specifies a custom
job ID for the process instance. This ID is displayed in the
TIBCO Administrator View Service dialog, and it is also
available in the $_processContext process variable. The custom
job ID for the process instance.
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Field
Module
Property? Description

Receive IDoc
Destination

Yes This field is used to retrieve the IDoc to be parsed.

This destination must be the one that the IDoc
Listener activity uses to persist IDocs.

Acknowledge Mode No This field is used to control the acknowledgment of the
message from the Receive IDoc Destination Queue. The
possible values are:

● Auto for automatic acknowledgment.

● Client for Client acknowledgment.

The default value is automatic acknowledgment

When using Client Acknowledgment, you must
confirm the message using the Confirm activity
from the General Activities palette. In terms of error
handling, to capture the exception generated by the
activity during processing the message, the CatchAll
should be used.

Message Selector No The message selector is used to select a specific IDoc message
from the receive IDoc destination.

The default value is SAPIDOC_IDOCTYP = 'IDoc_Type' AND
SAPIDOC_CIMTYP = 'Cim_Type' .

You can also use other JMS properties, for example,
SAPIDOC_OUTMOD, SAPIDOC_STATUS, and SAPIDOC_CREDAT.

If a syntax error occurs, you can click Reset Syntax next to the
Message Selector field to reset this field.

Output Tab

The Output tab of the IDoc Parser activity shows the parsed IDoc in the XML format.

The output of the IDoc Parser activity follows the following rules:

● Any space characters at the beginning of the output item value are preserved.

● Any space characters at the end of the output item value are removed.

● When space characters at the end of the output item value are removed, if the output item has no value
left, the corresponding output item is not displayed in the activity output.

Fault Tab

On the Fault tab, you can find the error codes and error messages of the IDoc Parser activity. See Error
Codes for more detailed explanation of errors.

The following table lists error schema elements on the Fault tab of the IDoc Parser activity:
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Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.

IDocNumber String Displays the number of the received IDoc.

IDoc Reader
Use the IDoc Reader activity to post IDocs to the SAP system.

The IDoc Reader activity retrieves the XML message persisted on a messaging source, converts the message
into an IDoc, and then posts the IDoc to the SAP system.

IDocs of SAP port type 4x are only supported using tRFC and qRFC protocols.

● The IDoc Reader activity requires the TIBCO Enterprise Messaging Service.

● The IDoc Listener activity does not support the job tuning property, FlowLimit.

● In IDoc Reader activity, while reconnecting if SAP exhausted, the client connection exception is caught
by the IDocReaderFault exception and the IDoc messages remain in queue.

See Job Tuning for details.

General Tab

On the General tab, establish connections to the SAP system and the messaging source separately, and
download the schema of the IDoc to be posted to the SAP system.

The following table lists the configurations on the General tab of the IDoc Reader activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in
the process.

SAP Connection Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes connections between
the plug-in and the SAP system.

If no matching SAP Connection shared resources are found,
click Create Shared Resource to create one. For more details,
see Creating and Configuring an SAP Connection.
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Field
Module
Property? Description

IDoc Name No Click Fetch IDoc to download the schema of the IDoc to be
posted.

In the Search IDoc dialog box, complete the following tasks:

1. Specify the IDoc filter to filter out the required IDoc types
with the IDoc type name.

The IDoc filter supports the wildcard search. The default
value of the IDoc Filter field is .*, and the value of this filed
is case sensitive.

2. Select an IDoc type.

● Basic Type: select Basic Type if you want to download
the IDoc schema of the basic type. Only the basic IDoc
types matching the IDoc filter can be filtered out.

● Extended Type: select Extended Type if you want to
download the IDoc schema of the extended type. The
extended IDoc type name includes the name of the
basic IDoc type that it is extended from. Therefore, the
extended IDoc types can be filtered out by using the
corresponding basic IDoc type name.

3. Click Fetch IDoc.

4. Select the IDoc type that you want to download and click
OK.

Ensure that the selected IDoc type and the associated
segments have been released in the SAP system.

You need to clear the Download IDoc specific to SAP
release checkbox to filter those IDocs that have been
released but do not have a release number assigned.

When the IDoc schema is downloaded, an XSD file is created.
The XSD file cannot be visible in the project, but it can be
picked from the activity if required.

● When an IDoc schema is downloaded to the plug-
in, if new segment definitions are added to the
IDoc schema because of the upgrade of the SAP
system, you have to refresh the IDoc schema in
the plug-in.

● If the IDoc schema requires to be refreshed from
the SAP system, then ensure that the Download
IDoc specific to SAP release check box is
configured accordingly. The Download IDoc
specific to SAP check box is by default always
selected whenever user clicks the Fetch IDoc
button.
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Field
Module
Property? Description

Messaging Source No Select the messaging source where the activity retrieves
messages from the list.

Only the JMS type is supported.

JMS Connection Yes Click  to select a JMS Connection shared resource. The JMS
Connection shared resource establishes a connection between
the plug-in and the EMS server where the activity retrieves the
IDoc to be posted.

If no matching JMS Connection shared resources are found,
click Create Shared Resource to create one. For more details,
see the TIBCO ActiveMatrix BusinessWorks documentation.

When the fault-tolerant operation is not configured
on the EMS server and the server goes down, if the
server is restarted, the IDoc Reader activity might
retrieve a duplicate IDoc message.

Max Session Yes Enter the number of IDoc messages to be processed
concurrently.

The default value is 1.

If you set the value of this field to negative numbers or zero, the
value of 1 is used automatically at run time.

See Job Tuning for details.

Receive IDocs in
Raw Format

No Specify whether to receive IDocs in a raw format.

If you select this check box, the IDoc Name field and Fetch
IDocs button becomes unavailable because the IDoc schema is
not required for the raw IDoc format.

Description Tab

On the Description tab, enter a short description for the IDoc Reader activity.

Advanced Tab

On the Advanced tab, specify the destination used to retrieve IDocs to be posted, and the protocol used to
post IDocs.

The following table lists the configurations on the Advanced tab of the IDoc Reader activity:

Field
Module
Property? Description

Sequence Key No This field contains an XPath expression that specifies the order in
which the process runs. Process instances with sequencing keys that
have the same value are executed sequentially in the order in which the
process instances were created.
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Field
Module
Property? Description

Custom Job Id No This field contains an XPath expression that specifies a custom job ID
for the process instance. This ID is displayed in the TIBCO
Administrator View Service dialog, and it is also available in the
$_processContext process variable. The custom job ID for the process
instance.

Post IDoc
Destination

Yes This destination is used to retrieve the IDoc to be posted. For more
information on how to create IDoc in XML format, please refer 
Mapping Data for SAP Palette activities

IDoc Error
Destination

Yes This destination is used to forward the IDoc when an exception occurs
in the SAP system.

If the value of the IDoc Error Destination or Confirm IDoc
Destination field is invalid, the IDoc Reader activity fails to
be initialized during startup, and no IDoc messages are read
from the destination specified in the Post IDoc Destination
field for processing.

IDoc Error
Msg
Expiration
(ms)

Yes This field allows for messages on the IDoc Error Destination to be
deleted from EMS Server if not processed by the time mentioned. This
field is maintained in milliseconds (ms) and the default is 0 where
messages will not expire.

IDoc Input
Mode

No This protocol is used to post IDocs.

The plug-in supports the following protocols:

● tRFC: select tRFC if the message delivery in sequence is not
required.

● qRFC: select qRFC if the message delivery in sequence is required.
If you select qRFC from the IDoc Input Mode list, the queueName
attribute in the message sent to the destination specified in the
Confirm IDoc Destination field contains the value of the SAP
Queue Name field.

The default protocol is qRFC.

SAP Queue
Name

Yes The name of the queue is to be used when posting IDocs by the qRFC
protocol.

This field becomes available only when you select qRFC
from the IDoc Input Mode list.

IDoc
Confirmation

Yes This check box indicates whether IDoc confirmation is enabled.

Select this check box if you want to get information about the IDoc after
it is posted.
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Field
Module
Property? Description

Confirm IDoc
Destination

Yes This destination is used to confirm the posted IDocs.

This field is displayed only when you select the IDoc Confirmation
check box.

If the value of the IDoc Error Destination or Confirm IDoc
Destination field is invalid, the IDoc Reader activity fails to
be initialized during startup, and no IDoc messages are read
from the destination specified in the Post IDoc Destination
field for processing.

Output Tab

On the Output tab, find the information of the posted IDoc.

The following table lists the output elements on the Output tab of the IDoc Reader activity:

Output Item Data Type Description

MessageID String Displays the message ID of the posted IDoc.

TID String Displays the TID of the transaction that the SAP system uses to
receive the posted IDoc.

Dynamic Properties Complex Displays the JMS dynamic properties received in the JMS
message.

In case of any error posting in the IDoc, SAPPLUGIN_ERROR_MSG
and SAPPLUGIN_ERROR_MSGID are generated in the output of
dynamic properties.

Fault Tab

On the Fault tab, you can find the error codes and error messages of the IDoc Reader activity.

See Error Codes for more detailed explanation of errors.

The Fault tab has the following exceptions:

IDocReaderFault

The IDocReaderFault generates an exception and causes the activity to stop.

Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode? String Displays the error code.

Post IDoc to SAP
The Post IDoc to SAP activity is used to post IDocs to the SAP system without the need to use TIBCO
Enterprise Message Service where the IDoc would be passed as input to the activity.
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When using this activity, exceptions must be caught and handled accordingly in the catch process.

General Tab

On the General tab, establish connections to the SAP system and download the schema of the IDoc to be
posted to the SAP system.

The following table lists the configurations on the General tab of the Post IDoc to SAP activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in
the process.

SAP Connection Yes Click  to select a SAP Connection shared resource. The SAP
Connection shared resource establishes connections between
the plug-in and the SAP system.

If no matching SAP Connection shared resources are found,
click the Create Shared Resource to create one. For more
details, see Creating and Configuring an SAP Connection.
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Field
Module
Property? Description

IDoc Name No Click Fetch IDoc button to download the schema of the IDoc to
be posted.

In the Search IDoc dialog box, complete the following tasks:

1. Specify the IDoc filter to filter out the required IDoc types
with the IDoc type name.

The IDoc filter supports the wildcard search. The default
value of the IDoc Filter field is .*, and the value of this filed
is case sensitive.

2. Select an IDoc schema type.

● Basic Type: Select Basic Type if you want to download
the IDoc schema of the basic type. Only the basic IDoc
types matching the IDoc filter can be filtered out.

● Extended Type: Select Extended Type if you want to
download the IDoc schema of the extended type. The
extended IDoc type name includes the name of the
basic IDoc type, from which it is extended. Therefore,
the extended IDoc types can be filtered out by using the
corresponding basic IDoc type name.

3. Click Fetch IDoc button.

4. Select the IDoc type that you want to download and click
OK.

Ensure that the selected IDoc type and the associated
segments have been released in the SAP system.

You need to clear the Download IDoc specific to SAP
release checkbox to filter those IDocs that have been
released but do not have a release number assigned.

After the IDoc schema is downloaded, an XSD file is created.
The XSD file cannot be visible in the project, but it can be
picked from the activity if required.

● After an IDoc schema is downloaded to the plug-
in, if new segment definitions are added to the
IDoc schema because of the upgrade of the SAP
system, you have to refresh the IDoc schema in
the plug-in.

● If the IDoc schema requires to be refreshed from
the SAP system then ensure that the Download
IDoc specific to SAP release check box is
configured accordingly. The Download IDoc
specific to SAP check box is by default always
selected when user clicks the Fetch IDoc button.
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Field
Module
Property? Description

Process IDocs in
Raw Format

No Specify whether to process IDocs in a raw format.

If you select this check box, the IDoc Name field and Fetch
IDocs button becomes unavailable because the IDoc schema is
not required to post raw IDoc format. The user provides the
raw IDoc in the fixed schema in the Input tab.

Description Tab

On the Description tab, enter a short description for the Post IDoc to SAP activity.

Advanced Tab

On the Advanced tab, specify the posting of the IDoc to SAP confirmation mode, confirmation destination,
the messaging source, and the protocol used to post IDocs.

The following table lists the configurations on the Advanced tab of the Post IDoc to SAP activity:

Field
Module
Property? Description

IDoc Input
Mode

No This protocol is used to post IDocs.

The plug-in supports the following protocols:

● tRFC: Select tRFC if the message delivery in sequence is not
required.

● qRFC: Select qRFC if the message delivery in sequence is required.
If you select qRFC from the IDoc Input Mode list, the queueName
attribute in the message sent to the destination specified in the
Confirm IDoc Destination field contains the value of the SAP
Queue Name field.

The default protocol is tRFC.

SAP Queue
Name

Yes The name of the queue is to be used when posting IDocs by the qRFC
protocol.

This field becomes available only when you select qRFC
from the IDoc Input Mode list.

IDoc
Confirmation
Mode

Yes This mode is used for IDoc Confirmation.

There are three modes for IDoc Confirmation:

● None: No action is taken for IDoc Confirmation.

● JMS: This posts information about the IDoc after it is posted to SAP
on the JMS destination queue.

● NoMessaging: After the IDoc is posted to SAP, a confirmation
report is provided on the output of the activity.

The default mode for IDoc Confirmation is None.
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Field
Module
Property? Description

JMS
Connection

Yes Click  to select a JMS Connection shared resource. The JMS
Connection shared resource establishes a connection between the plug-
in and the EMS server where the activity retrieves the IDoc to be
posted.

If no matching JMS Connection shared resources are found, click
Create Shared Resource to create one. For more details, see the TIBCO
ActiveMatrix BusinessWorks documentation.

This field is displayed only when you select JMS in the IDoc
Confirmation Mode field.

Confirm IDoc
Destination

Yes This destination is used to confirm the posted IDocs.

This field is displayed only when you select JMS in the IDoc
Confirmation Mode field.

Input Tab

On the Input tab, specify the IDoc data for the selected IDoc.

The following table lists the input elements on the Input tab of the Post IDoc to SAP activity:

Input Item Data Type Description

ProcessInput Complex Enters the data for the IDoc to be posted.

Data for IDoc can be posted when IDocs are
received in XML and Raw format.

sessionID String (Optional) Enters the sessionID of the previous
activity for the use of Dynamic Connection instead of
SAP connection, which is configured in the General
Tab.

For information on how to create IDoc in XML format, please refer to Mapping Data for SAP Palette
Activities

Output Tab

On the Output tab, find the information of the posted IDoc.

The following table lists the output elements on the Output tab of the Post IDoc to SAP activity:

Output Item Data Type Description

TID String Displays the TID of the transaction that the SAP system uses to
receive the posted IDoc.

sessionID String Displays the sessionID provided in the Input tab for the use of
Dynamic Connection.
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Output Item Data Type Description

CPIC_ID String Displays the CPIC_ID associated with SAP Connection created
for a dynamic connection

correlationID String This output is available only when NoMessaging is selected in
the IDoc Confirmation Mode field on the Advanced Tab.

errorMessage String This output is available only when NoMessaging is selected in
the IDoc Confirmation Mode field on the Advanced Tab.

successMessage String This output is available only when NoMessaging is selected in
the IDoc Confirmation Mode field on the Advanced Tab.

Displays the success message only populated in the case where
the IDoc to be confirmed is sent to the SAP system by using
qRFC.

Because the IDoc number cannot be retrieved in that case, no call
is made to the SAP system for the IDoc number and status. The
value of the successMessage output item is populated in the
following format:

IDoc sent to SAP via qRFC. IDoc number is

unavailable. The original TID is TID.

idocNumber String This output is available only when NoMessaging is selected in
the IDoc Confirmation Mode field on the Advanced Tab.

Displays the IDoc number populated by the IDoc Confirmation
activity by retrieving the information from the SAP system.

The IDoc number is populated only when the IDoc is
posted to SAP by using the tRFC protocol.

idocStatus String This output is available only when NoMessaging is selected in
the IDoc Confirmation Mode field on the Advanced Tab.

Displays the IDoc status populated by the IDoc Confirmation
activity by retrieving the information from the SAP system.

The IDoc status is populated only when the IDoc is
posted to SAP by using the tRFC protocol.

Fault Tab

On the Fault tab, you can find the error codes and error messages of the Post IDoc to SAP activity and any
element for logging the posted IDoc.

See Error Codes for more detailed explanation of errors.

The Fault tab has the following exception:

SAPPluginException

The SAPPluginException generates an exception and causes the activity to stop.
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Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode? String Displays the error code.

any element - Displays the input IDoc data at run time.

The IDoc data is available only when the IDoc is not
malformed.

IDoc Renderer
The IDoc Renderer activity receives IDoc in XML format and provides output in raw IDoc format. The raw
IDoc format is the same as IDoc sent to the SAP system but no IDoc would be posted to SAP system.

The IDoc Renderer activity does not support Adapter to Plug-in migration.

General Tab

On the General tab, establish connections to the SAP system and download the schema of the IDoc to be
used to prepare raw IDoc.

The following table lists the configurations on the General tab of the IDoc Renderer activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in
the process.

SAP Connection Yes Click  to select a SAP Connection shared resource. The SAP
Connection shared resource establishes connections between
the plug-in and the SAP system.

If no matching SAP Connection shared resources are found,
click the Create Shared Resource to create one. For more
details, see Creating and Configuring an SAP Connection.

The SAP Connection is used only for design time.
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Field
Module
Property? Description

IDoc Name No Click Fetch IDoc button to download the schema of the IDoc to
be posted.

In the Search IDoc dialog box, complete the following tasks:

1. Specify the IDoc filter to filter out the required IDoc types
with the IDoc type name.

The IDoc filter supports the wildcard search. The default
value of the IDoc Filter field is .*, and the value of this filed
is case sensitive.

2. Select an IDoc schema type.

● Basic Type: Select Basic Type if you want to download
the IDoc schema of the basic type. Only the basic IDoc
types matching the IDoc filter can be filtered out.

● Extended Type: Select Extended Type if you want to
download the IDoc schema of the extended type. The
extended IDoc type name includes the name of the
basic IDoc type, from which it is extended. Therefore,
the extended IDoc types can be filtered out by using the
corresponding basic IDoc type name.

3. Click Fetch IDoc button.

4. Select the IDoc type that you want to download and click
OK.

Ensure that the selected IDoc type and the associated
segments have been released in the SAP system.

You need to clear the Download IDoc specific to SAP
release checkbox to filter those IDocs that have been
released but do not have a release number assigned.

After the IDoc schema is downloaded, an XSD file is created.
The XSD file cannot be visible in the project, but it can be
picked from the activity if required.

● After an IDoc schema is downloaded to the plug-
in, if new segment definitions are added to the
IDoc schema because of the upgrade of the SAP
system, you have to refresh the IDoc schema in
the plug-in.

● If the IDoc schema requires to be refreshed from
the SAP system, then ensure that the Download
IDoc specific to SAP release check box is
configured accordingly. The Download IDoc
specific to SAP check box is by default always
selected when the user clicks the Fetch IDoc
button.

Description Tab

On the Description tab, enter a short description for the IDoc Renderer activity.
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Advanced Tab

On the Advanced tab, specify the input mode that use tRFc or qRFC. No queue names are taken.

The following table lists the configurations on the Advanced tab of the Post IDoc to SAP activity:

Field
Module
Property? Description

IDoc Input
Mode

No The plug-in supports the following protocols:

● tRFC: Select tRFC if the message delivery in sequence is not
required.

● qRFC: Select qRFC if the message delivery in sequence is required.
If you select qRFC from the IDoc Input Mode list, the queueName
attribute in the message sent to the destination specified in the
Confirm IDoc Destination field contains the value of the SAP
Queue Name field.

The default protocol is tRFC.

While using the raw IDoc output with a subsequent PostIDoc
activity the IDoc Input Mode field across these activities
should match.

Input Tab

On the Input tab, specify the IDoc data for the selected IDoc.

The following table lists the input elements on the Input tab of the IDoc Renderer activity:

Input Item Data Type Description

IDocRendererInput Complex Enters the data to prepare the IDoc data into raw
format.

For information on how to create IDoc in XML format, please refer to Mapping Data for SAP Palette
Activities

Output Tab

On the Output tab, find the information of the posted IDoc.

The following table lists the output elements on the Output tab of the IDoc Renderer activity:

Output Item Data Type Description

data String Displays the raw IDoc data that was prepared by the input IDoc
XML data.

Fault Tab

On the Fault tab, you can find the error codes and error messages of the IDoc Renderer activity.

See Error Codes for more detailed explanation of errors.

The Fault tab has the following exceptions:
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● SAPPluginException

The SAPPluginException throws an exception and causes the activity to stop.

Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode? String Displays the error code.

Invoke RFC BAPI in SAP
Use the Invoke RFC BAPI in SAP activity to invoke RFC/BAPIs in the SAP system.

Only request/reply requests are supported. Asynchronous requests are not supported.

General Tab

On the General tab, establish connections to the SAP system, and download the schema of the RFC/BAPI to
be invoked in the SAP system.

The following table lists the configurations on the General tab of the Invoke RFC BAPI in SAP activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.

SAP
Connection

Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes connections between the plug-
in and the SAP system.

If no matching SAP Connection shared resources are found, click
Create Shared Resource to create one. For more details, see Creating
and Configuring an SAP Connection.

When a process contains multiple Invoke RFC BAPI
activities, if you want the activities to use different SAP
Connection shared resources, you have to create process
properties for the shared resources to be used, and then
choose the corresponding process property for the activity. If
you choose different SAP Connection shared resources for

the Invoke RFC BAPI activities in a process by clicking ,
the activities use the same shared resource.
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Field
Module
Property? Description

RFC/BAPI No Click Fetch Function Module to download the schema of the RFC/
BAPI to be invoked in the SAP system.

In the Fetch Function Module dialog, you can use the RFC/BAPI tab or
BOR tab to download the schema of the RFC/BAPI to be invoked in the
SAP system.

The RFC/BAPI tab is useful when the name of the function module,
function group, or both are known. The BOR tab is useful for browsing
SAP business objects based on application objects.

In the RFC/BAPI tab, complete the following tasks:

1. Specify the RFC/BAPI filter or the RFC/BAPI group filter to filter
out the required RFC/BAPI types with the RFC/BAPI type name.

Both the RFC/BAPI filter and the RFC/BAPI group filter support the
wildcard search.

2. Click Fetch RFC/BAPIs.

3. Select the RFC/BAPI type that you want to download and click OK.

Ensure that the selected RFC/BAPI type has been released in the
SAP system.

In the BOR tab, complete the following tasks:

1. Specify values for the Object Type Filter, Object Name Filter, and
Object Text Filter fields to filter out the required business objects.

All the object type filter, object name filter, and object text filter
support the wildcard search. The values of the preceding three
fields are case sensitive.

2. Click Fetch Object Types.

3. Expand an object type in the Object Type column, select the method
that you want to download, and click OK.

After the RFC/BAPI schema is downloaded, an XSD file is created. The
XSD file is intentionally invisible in the project, but it can be picked
from the activity if required.

● The plug-in does not support basXML and class-based
exceptions.

● When you download more than one page of the RFC/
BAPI schema spanning, only the first page is cached for
subsequent activities.

● If an RFC/BAPI function group is inactive in the SAP
system, the RFC/BAPIs in the function group are still
displayed in the search result.

● If a business object does not contain any released key
attributes, non-key attributes, or methods, the business
object is still displayed in the object type search result.

● In a process, you cannot associate the same RFC/BAPI
with multiple Invoke RFC BAPI in SAP activities. If you
want to use the Invoke RFC BAPI in SAP activities with
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Field
Module
Property? Description

the same RFC/BAPI, create different processes for the
activities.

● If the schema for an RFC/BAPI activity is refreshed, then
the other RFC/BAPI activities in the same process that are
using the same schema may not be refreshed.

Description Tab

On the Description tab, enter a short description for the Invoke RFC BAPI in SAP activity.

Advanced Tab

On the Advanced tab, select the Transactional check box to support one or more RFC/BAPI calls to be
executed as a transaction or logical unit of work in the SAP system.

The following configurations are displayed on the Advanced tab of the Invoke RFC BAPI in SAP activity
when you select the Transactional check box:

Field
Module
Property? Description

Invocation
Protocol

No Specify the invocation protocol for the activity. They are:

● Request/Reply

If Request/Reply is selected, the Transactional check box is
available.

● tRFC

If tRFC is selected, the support for asynchronous request is enabled.

The default value is Request/Reply.

For one way invocation protocol, the confirmation report
following the invocation is not available.

Context End No If you want to end the RFC/BAPI transaction at this activity, select this
check box.

This check box is cleared by default.

This check box is the same as the Terminate Connection check box in
the Advanced tab of the Dynamic Connection activity. When a
dynamic connection with the selected Transactional check box is used,
if you want to end the transaction, you must select the Terminate
Connection check box instead of selecting the Context End check box.

Auto Commit No If you want the transaction or logical unit of work to be committed
automatically when the transaction or logical unit of work consists of
only one RFC/BAPI call and the RFC/BAPI call does not return any
errors, select this check box.

This check box is cleared by default.
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Field
Module
Property? Description

Commit
Expiry(ms)

No Specify the timeout value in milliseconds for the activity to wait for the
subsequent activity to be invoked.

The default value is 30000.

This field is the same as the contextTimeout input item in the Input
tab of the Dynamic Connection activity, and can overwrite the
contextTimeout input item.

Input Tab

On the Input tab, enter the request of the RFC/BAPI to be invoked, the session ID of the previous activity,
and the timeout value for the activity to wait for invoking the RFC/BAPI.

The following table lists the input elements on the Input tab of the Invoke RFC BAPI in SAP activity:

Input Item Data Type Description

sessionID String Enter the session ID of the previous activity when the
Transactional check box in the Advanced tab is selected.

If the Invoke RFC BAPI in SAP activity invokes the
first RFC/BAPI in the context of the transaction,
leave this element blank.

timeout Long Enter the timeout value in milliseconds for the activity to wait
for invoking the RFC/BAPI.

The default value is 600000.

The module property of the long type cannot be left
blank, and its value range does not include the
negative numbers.

RfcRequest Complex Enter the request of the RFC/BAPI to be invoked.

Output Tab

The Output tab shows the session ID of the activity and the response of the invoked RFC/BAPI . It also
shows the CPIC_ID associated to the SAP connection. If the invocation protocol of tRFC is selected, the
output shows SessionID, CPIC_ID and TID.

Fault Tab

On the Fault tab, you can find the error codes and error messages of the Invoke RFC BAPI in SAP activity
and the SAP system. The SAP system exceptions are returned by the RFC/BAPI invoked in the SAP system.

See Error Codes for more detailed explanation of errors of the Invoke RFC BAPI in SAP activity.
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● If you want to catch the SAP system exception in a process, it is good practice to use the Catch fault
handler, instead of the Catch ALL fault handler.

● If the exception that is sent back to the SAP system has more than 50 characters, then the SAP system
can only retrieve the first 50 characters.

● If you catch a SAPSystemException, then the schema is inline with the Invoke RFC BAPI in SAP activity,
which will cause issues if the corresponding RFC or BAPI changes in terms of exceptions.

The following table lists error schema elements in the Fault tab of the Invoke RFC BAPI in SAP activity:

Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.

RFC BAPI Listener
Use the RFC BAPI Listener activity to listen to the SAP system and receive RFC/BAPI requests from the
SAP system.

The RFC BAPI Listener supports the Request/Reply and one way invocation protocols tRFC and qRFC.

In a project, RFC BAPI Listener activities cannot have the following configurations:

● The same RFC/BAPI and use the same SAP Connection shared resource.

● The same RFC/BAPI and use the SAP Connection shared resources with the same combination of the
gateway host, the gateway service, and the program ID.

If you want to control the number of messages being processed concurrently in the activity, choose one of
the following configurations:

● Configure the Max Connections field of the referenced server connection according to the number of all
the IDoc Listener and RFC BAPI Listener activities.

● Configure the RFC destination accordingly by using the SAP transaction code, SMQS.

The RFC BAPI Listener activity does not support the job tuning property, FlowLimit.

See Job Tuning for details.

General Tab

On the General tab, establish connections to the SAP system, and download the schema of the RFC/BAPI to
be retrieved.

The following table lists the configurations on the General tab of the RFC BAPI Listener activity:

Field
Module
Property? Description

Name No Specify the name to be displayed as the label for the activity in the
process.
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Field
Module
Property? Description

SAP
Connection

Yes Click  to select an SAP Connection shared resource. The SAP
Connection shared resource establishes connections between the plug-
in and the SAP system.

Ensure that you have first created an SAP Connection shared resource
accordingly. See Creating and Configuring an SAP Connection for
details.

● The server connection created by clicking Create Shared
Resource cannot be enabled.

● When the server connection of an SAP Connection shared
resource is not enabled, you still can select this shared
resource by selecting the corresponding process property.
Therefore, if you want to select an SAP Connection
shared resource by selecting the corresponding process
property, ensure that the server connection of the shared
resource has been enabled.

73

TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions User's Guide



Field
Module
Property? Description

RFC/BAPI No Click Fetch Function Module to download the schema of the RFC/
BAPI to be received from the SAP system.

In the Fetch Function Module dialog, you can use the RFC/BAPI tab or
BOR tab to download the schema of the RFC/BAPI to be invoked in the
SAP system.

The RFC/BAPI tab is useful when the name of the function module,
function group, or both are known. The BOR tab is useful for browsing
SAP business objects based on application objects.

In the RFC/BAPI tab, complete the following tasks:

1. Specify the RFC/BAPI filter or the RFC/BAPI group filter to filter
out the required RFC/BAPI types with the RFC/BAPI type name.

Both the RFC/BAPI filter and the RFC/BAPI group filter support the
wildcard search.

2. Click Fetch RFC/BAPIs.

3. Select the RFC/BAPI type that you want to download and click OK.

Ensure that the selected RFC/BAPI type has been released in the
SAP system.

In the BOR tab, complete the following tasks:

1. Specify values for the Object Type Filter, Object Name Filter, and
Object Text Filter fields to filter out the required business objects.

All the object type filter, object name filter, and object text filter
support the wildcard search. The values of the preceding three
fields are case sensitive.

2. Click Fetch Object Types.

3. Expand one object type in the Object Type column, select the
method that you want to download, and click OK.

After the RFC/BAPI schema is downloaded, an XSD file is created. The
XSD file is intentionally invisible in the project, but it can be picked
from the activity if required.

● The plug-in does not support basXML and class-based
exceptions.

● When you download more than one page of the RFC/
BAPI schema spanning, only the first page is cached for
subsequent activities.

● If one RFC/BAPI function group is inactive in the SAP
system, the RFC/BAPIs in the function group are still
displayed in the search result.

● If a business object does not contain any released key
attributes, non-key attributes, or methods, the business
object is still displayed in the object type search result.

● If the SAP system publishes the request of an RFC/BAPI
that is not configured in the RFC BAPI Listener activity,
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Field
Module
Property? Description

an exception occurs in the SAP system, but no error or
exception occurs in the plug-in.

● If the schema for one RFC/BAPI activity is refreshed, then
the other RFC/BAPI activities in the same process that
using are using the same schema may not be refreshed.

Invocation
Protocol

No There are three types of Invocation Protocols:

● Request/Reply

● tRFC

● qRFC

The default value is Request/Reply.

SAP TID
Manager

Yes This field is available only when tRFC or qRFC is selected in the
Invocation Protocol field

Click  to select an SAP TIDManager shared resource. The SAP
TIDManager shared resource can manage the check of duplicate tRFC
or qRFC calls from SAP system.

If no matching SAP TIDManager shared resources are found, click
Create Shared Resource to create one. For more details, see Creating
and Configuring an SAP TIDManager Shared Resource.

Acknowledgm
ent Mode

No When tRFC and qRFC are selected in the Invocation Protocol field, the
following types of Acknowledgment Modes are displayed:

● Auto

● Client

The default value is Auto.

When Auto is selected, the activity automatically acknowledges the
transaction in SAP system when the output is successfully sent.
When Client is selected, the activity does not automatically
acknowledge the transaction in SAP system and waits for the
confirmation from the Confirm activity.

● When the TID Manager Shared Resource is configured as
Active, Client can be used as the Acknowledgment
Mode. If the TID Manager Shared Resource is configured
as None, then the acknowledgment mode is defaulted to
Auto.

● When a fault occurs prior to the Confirm activity, the
RFC BAPI Listener activity times out and the transaction
is rolled back.

● If transactions are pending in the RFC BAPI Listener
activity, then those transactions need to be completed
prior to the stopping of the application.
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Description Tab

On the Description tab, you can enter a short description for the RFC BAPI Listener activity.

Advanced Tab

On the Advanced tab, you can specify the timeout value for the activity to wait for a response to be sent to
the SAP system.

The following table lists the configurations on the Advanced tab of the RFC BAPI Listener activity:

Field
Module
Property? Description

Sequence Key No This field contains an XPath expression that specifies the order in
which the process runs. Process instances with sequencing keys that
have the same value are executed sequentially in the order in which the
process instances were created.

Custom Job Id No This field contains an XPath expression that specifies a custom job ID
for the process instance. This ID is displayed in the TIBCO
Administrator View Service dialog, and it is also available in the
$_processContext process variable. The custom job ID for the process
instance.

Response
Timeout(ms)

Yes The timeout value in milliseconds for the activity to wait for a response
to be sent to the SAP system.

The default value is 300000.

● When the value of the Response Timeout(ms) field
inherits a module property, if you set the module
property to 0 or a negative number, the value of the field
defaults to 300000.

● When setting the log level to debug or trace, you have to
adjust the value of the Response Timeout(ms) field
accordingly.

Confirmation
Timeout (ms)

Yes This field is available only when tRFC or qRFC is selected in the
Invocation Protocol field and Client is selected in the
Acknowledgment Mode field on the General tab.

The timeout value in milliseconds waiting to commit the transaction.

The default value is 300000.

While configuring Confirmation Timeout(ms) for tRFC or
qRFC, define the value in milliseconds, which should be
large enough to allow the subsequent activities prior to the
Confirm activity to complete. If the value is not sufficient,
then timeout would occur and the transaction would roll
back.

Output Tab

The Output tab shows the request of the RFC/BAPI.
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The following table lists the output elements on the Output tab of the RFC BAPI Listener activity:

Output Item Data Type Description

SAPJCO_RFCDESTINAT

ION

String Displays the RFC destination that connects an ABAP system to
an external system.

SAPJCO_CLIENT String Displays the SAP client number.

SAPJCO_CPICCONVID String Displays the low-level CPIC conversion ID for the SAP
connection.

SAPJCO_HOST String Displays the SAP application server used for dispatching the call
from the SAP system.

SAPJCO_SYSID String Displays the SAP system ID.

SAPJCO_USER String Displays the valid user name used to log on to the specified SAP
client.

Reply from RFC BAPI in SAP
Use the Reply from RFC BAPI in SAP activity to receive the return message from the SAP system when the
invocation of an RFC/BAPI is completed.

General Tab

On the General tab, you can select a RFC BAPI listener to retrieve the return message from the SAP system.

The following table lists the configurations on the General tab of the Reply from RFC BAPI in SAP activity:

Field
Module
Property? Description

Name No The name to be displayed as the label for the activity in the process.

Reply For No The RFC BAPI listener used to retrieve the return message from the
SAP system.

Description Tab

On the Description tab, you can enter a short description for the Reply from RFC BAPI in SAP activity.

Input Tab

On the Input tab, you can enter the response of the invoked RFC BAPI, the timeout value for the Reply
from RFC BAPI in SAP activity to wait for the response from the RFC BAPI Listener activity, and the error
code and message of the SAP system.

The following table lists the input elements on the Input tab of the Reply from RFC BAPI in SAP activity:
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Input Item Data Type Description

timeout Long Enter the timeout value in milliseconds for the Reply from RFC BAPI in
SAP activity to wait for the response from the RFC BAPI Listener
activity.

msg String Enter the error message of the SAP system.

msgCode String Enter the error code of the SAP system.

RfcResponse Complex Enter the response of the invoked RFC BAPI.

Fault Tab

On the Fault tab, you can find the error codes and error messages of the Reply from RFC BAPI in SAP
activity and the SAP system. The SAP system exceptions are returned by the RFC BAPI invoked in the SAP
system.

See Error Codes for more detailed explanation of errors.

The following table lists error schema elements on the Fault tab of the Reply from RFC BAPI in SAP
activity:

Error Schema
Element Data Type Description

msg String Displays the error message.

msgCode String Displays the error code.
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IDoc Processing without Messaging Service

This section contains information on how to use the TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP
Solutions IDoc activities without using messaging service, such as TIBCO Enterprise Message Service or
Apache Kafka.

The default behavior of the ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions for IDoc processing is
to use messaging.

This behavior can be changed based on requirements and the information provided from the below
sections:

● Outbound IDoc Processing

For receiving IDocs from the SAP system, the IDoc Listener activity is used.

If no messaging service is used, then the Messaging Source field on the General tab of the IDoc Listener
activity must be configured to NoMessaging.

When the IDoc is received from the SAP system, the raw IDoc is provided as output.

● When multiple IDocs are received in batch, a job is created for each IDoc.

● Confirmation to SAP is given only when the output from the IDoc Listener activity is
successful. After the output is successful, to avoid any loss of IDoc data in subsequent
processing, TIBCO recommends that you configure the project accordingly to make it
resilient if there is any disruption or errors during the processing.

If the IDoc received requires to be transformed to XML, then the IDoc Converter activity is required. The
transformation to XML by the IDoc Converter activity is consistent to that of the IDoc Parser activity.

For more information on how to receive and process IDocs without the need for TIBCO Enterprise
Message Service or Apache Kafka, see the below example processes included in ActiveMatrix
BusinessWorks Plug-in for SAP Solutions

● ReceiveIDocsFromSAPNoMessaging

● ProcessCustomerMasterIDocsNoMessaging

● ProcessVendorMasterIDocsNoMessaging

● Inbound IDoc Processing

To post IDocs to the SAP system without requiring TIBCO Enterprise Message Service, the Post IDoc to
SAP activity is used.

The Post IDoc to SAP activity receives IDoc in XML as input or raw IDoc format and sends the IDoc to
the SAP system. The processing and posting of IDoc to SAP system is consistent to the IDoc Reader
activity that requires TIBCO Enterprise Message Service.

If IDoc Confirmation mode is required to post IDoc to SAP system then the IDoc Confirmation Mode
field in the Advanced tab of Post IDoc to SAP activity must be configured to NoMessaging, for IDoc
Confirmation Mode to provide confirmation of the IDoc as part of the output activity.

For more information on how to post IDocs without the need for TIBCO Enterprise Message Service for
IDoc Confirmation Mode, see the below example process included in ActiveMatrix BusinessWorks Plug-
in for SAP Solutions.

● PostVendorMasterIDocsNoMessaging
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Mapping Data for SAP Palette Activities

For Populating IDoc Data to SAP System

This section contains information on how to populate IDoc Data in XML format for the following SAP
activities:

● IDoc Reader

● Post IDoc to SAP

● IDoc Renderer

To prevent the IDoc recognition error in the SAP system when invoking the Post IDoc to SAP activity, you
have to configure the SEGNAM property in different ways based on the protocol types. Depending on
whether you use tRFC or qRFC as the protocol, you need to map the segment name for an IDoc differently.
Run the we31 transaction in the SAP system to check a segment. The EIMARM segment type contains
multiple segment definitions. The property for the segment name in the Input tab of the activity is
SEGNAM that shows the SEGNAM property of one IDoc in the Input tab.
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● tRFC

If the SEGNAM property is left blank, the plug-in automatically specifies the property by using the IDoc
XSD.

● The attributes inside the EDI_DD40 data record do not need to be mapped unless below
criteria is met.

● When sending an empty IDoc segment to the SAP system, at least one attribute must be
mapped.

● qRFC

If the SEGNAM property is left blank, the Segment type value is derived by the plug-in using the IDoc
XSD.

When populating the IDoc Control Record Data - EDI_DC40, the DOCNUM attribute is not
required to be mapped
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Job Tuning

You can configure the SAP activities to control the number of messages being processed concurrently. For
more information, see "Engine and Job Tuning" in the TIBCO ActiveMatrix BusinessWorks Administration
guide for related information about job tuning.
To control the number of messages being processed concurrently, you can choose the required
configuration:

● IDoc Listener and RFC BAPI Listener activities

— Configure the Max Connections field of the referenced server connection according to the number
of all the IDoc Listener and RFC BAPI Listener activities.

For the IDoc Listener activity, you not only have to consider the number of all the IDoc
Listener and RFC BAPI Listener activities, but also the case of the TID management is
Active.

— Configure the RFC destination accordingly by using the SAP transaction code, SMQS.

The IDoc Listener and RFC BAPI Listener activities do not support the job tuning property,
FlowLimit.

● IDoc Parser and IDoc Reader activities

— Configure the Max Session field in the activity.

The priority of the Max Session field is higher than the job tuning property, Flow Limit.

● Invoke RFC/BAPI in SAP, Reply from RFC/BAPI in SAP, and Post IDoc to SAP activities

— Configure the RFC/BAPI No. of Threads property accordingly in the SAP Connection
shared resource being used to control the number of concurrent sessions between plug-in
and SAP. The number of threads configured must match the number of SAP connections
configured in Max Connections field of the referenced client connection. The
Asynchronous Timeout property maintained in TIBCO ActiveMatrix BusinessWorks™
needs to be maintained accordingly to avoid timeouts.

● Kafka Message Source

By default, only one partition is created. However, if more than one partition needs to be created, you
can add it using the Kafka command.
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Migration

You can migrate TIBCO ActiveMatrix® Adapter for SAP projects created on TIBCO ActiveMatrix
BusinessWorks™ 5.x or 6.x to TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions on
ActiveMatrix BusinessWorks™ 6.x. You can also migrate TIBCO ActiveMatrix® Adapter for SAP projects
created on ActiveMatrix BusinessWorks 5.x to ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions on
TIBCO BusinessWorks™ Container Edition.

Migrating Adapter Projects Created on TIBCO ActiveMatrix BusinessWorks™
5.x to Plug-In Projects

You can migrate a SAP Adapter and TIBCO ActiveMatrix BusinessWorks 5.x project created in TIBCO
Designer™ to ActiveMatrix BusinessWorks™ 6.x or TIBCO BusinessWorks™ Container Edition by using the
migration tool in TIBCO Business Studio™ for BusinessWorks™.

● In addition to the notes mentioned, it is a good practice to review the TIBCO ActiveMatrix BusinessWorks
6.x Migration guide for additional information such as naming conventions, and more.

● Migration is based on the information received from the AE activities. All the activities get migrated as
it is besides the Adapter Request Response Server, Respond to Adapter Request, Adapter Subscriber,
Invoke an Adapter Request-Response Service, and Publish to Adapter activities.

Prerequisite

● For databases using native drivers in ActiveMatrix BusinessWorks 6.x, the JAR files must be added to
the <TIBCO_HOME> directory before the migration is initiated.

Projects Supported for Migration

Migration is provided for the following project specifications:

Project Specification Supported for Migration To

Projects created in ActiveMatrix® Adapter for SAP
● ActiveMatrix BusinessWorks 6.x

● TIBCO BusinessWorks Container EditionActiveMatrix BusinessWorks 5.x projects created
in TIBCO Designer

Migration Restriction

● You can migrate ActiveMatrix® Adapter for SAP projects created on ActiveMatrix BusinessWorks 5.x to
ActiveMatrix BusinessWorks Plug-in for SAP Solutions. However, vice versa is not possible.

● Migration of SNC Client and Server Connections is not supported and after migration the required
connections must be created manually.

Considerations when migrating projects

● Due to TIBCO ActiveMatrix BusinessWorks 5.x project structure and the migration process, there are
some files in the TIBCO ActiveMatrix BusinessWorks 5.x project migrated to TIBCO ActiveMatrix
BusinessWorks 6.x, but are not used and must ignored. For example, - ae folder and ae2xsd.xsd
under Schemas folder, AESchemas folder, etc.

● An EMF validation error occurs in the migrated TIBCO ActiveMatrix BusinessWorks™ 6.x project when
one TIBCO ActiveMatrix BusinessWorks™ 5.x project is saved with another name and these two projects
are migrated to the plug-in. To resolve this issue, delete the Namespaces/Imports from Process >
Dependencies.
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● After Migrating a TIBCO ActiveMatrix BusinessWorks™ 5.x project to TIBCO ActiveMatrix
BusinessWorks™ 6.x project , in the JMS shared connection resource, if the Auto-generate ClientID field
is checked, the ClientID field will be disabled, which means no value can be added for ClientID. Also if
the Auto-generate ClientID field is unchecked, the ClientID field will be enabled, which means a
particular value can be added for ClientID.

● If there is a TIBCO ActiveMatrix BusinessWorks™ 5.x generic activity that uses the SAP adapter AE
schema in TIBCO ActiveMatrix BusinessWorks™ 5.x project, after migration the TIBCO ActiveMatrix
BusinessWorks 6.x generic activities would need to be manually fixed to use the plug-in activity schema.

● If you want to use the SAP schemas from the migrated TIBCO ActiveMatrix BusinessWorks™ 6.x
project, the project needs to be cleaned using the Project > Clean option from Business Studio. Once the
project is cleaned, the schemas can be selected from the .SAP folder. The schema can be re-fetched using
the Fetch IDoc or Fetch Function button, which will make it available in the .SAP folder and in the
schema picker.

● Ensure the value of the Operation field for the Respond to Adapter Request activity is available for the
ae.aepalette.aeOpClientReqActivity.ops field in the TIBCO ActiveMatrix BusinessWorks™ 5.x process
file.

● After migration, in TIBCO ActiveMatrix BusinessWorks™ 6.x project the shared resource created will
always be at the root level even if it is at a resource folder level in TIBCO ActiveMatrix BusinessWorks™
5.x project

● In TIBCO ActiveMatrix BusinessWorks™ 5.x project, the Subject and Destination fields configured in
the transport tab must have the same value for service and activity.

● For migration the command line data option should be used and the user workspace directory and
TIBCO ActiveMatrix BusinessWorks™ 6.x target directory should be the same. For example,
bwmigrator.exe -data <user workspace> -projectDir <BusinessWorks 6.x target

directory> <BusinessWorks 5.x project location>.

● For migration of TIBCO ActiveMatrix BusinessWorks 5.x projects to TIBCO ActiveMatrix
BusinessWorks 6.x projects, there are a few projects that need to be manually fixed after migration. For
example, in TIBCO ActiveMatrix BusinessWorks 5.x project any schemas where attributes are a SAP
predefined ABAP type like string, etc. Also in the TIBCO ActiveMatrix BusinessWorks 5.x project, the
schema contains a double underscore (__) while in TIBCO ActiveMatrix BusinessWorks 6.x project it is
underscore (_).

● Migration supports online schema migration, which means it retrieves the schema from the SAP server
during migration for the respective activity. Before migrating a project, ensure that the connection
parameters provided are correct in the project or in JSON reference file, otherwise errors might occur
post migration.

● Module property will get migrated to TIBCO ActiveMatrix BusinessWorks 6.x project only if it is created
in TIBCO ActiveMatrix BusinessWorks 5.x project and is referred in one of the TIBCO ActiveMatrix
BusinessWorks 5.x projects or it should be referred in JSON file.

Migrating projects from Adapter to Plug-in
You can migrate TIBCO ActiveMatrix® Adapter for SAP projects created in TIBCO Designer™ to TIBCO
ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions in the following manner

Before migration, backup the original TIBCO ActiveMatrix BusinessWorks™ 5.x projects.

Procedure

1. Start TIBCO Business Studio.

2. Click Project tab and select Migrate BW Projects.

3. In the Project Migration Wizard, click Browse in the Select Project(s) to be Migrated field and select the
project you want to migrate.
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The default selection is Migrate Single BusinessWorks 5.x Project.

4. Click Migrate Multiple BusinessWorks 5.x Projects to migrate multiple 5.x projects.

During migration if the Migrate as Shared Module check-box is selected it can be applied
only for shared resources and schema files. It is not applicable for event source activities.

5. Click Migrate Project > Start Migration. After the migration is complete, click Finish.

Migrating R3 adapter configuration to SAP Connection Resource in Plug-in
You can migrate R3 adapter configuration from TIBCO ActiveMatrix® Adapter for SAP projects created in
TIBCO Designer™ to SAP connection resource in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP
Solutions in the following manner

Procedure

1. Start TIBCO Business Studio.

2. Click Project tab and select Migrate BW Projects.

3. In the Migration Project Type section, the default selection is Migrate Single BusinessWorks 5.x
Project. Select the Migrate as Shared Module check box to migrate the 5.x projects as a shared resource.

During migration if the Migrate as Shared Module check-box is selected it can be applied
only for shared resources and schema files. It is not applicable for event source activities.

4. Click Migrate Project > Start Migration. After the migration is complete, click Finish.

The migration of adapter configurations of TIBCO ActiveMatrix BusinessWorks 5.x projects to
a shared resource in TIBCO ActiveMatrix BusinessWorks 6.x projects is based on the
Connection Type selected in the TIBCO ActiveMatrix BusinessWorks 5.x project. For more
information, see Connection Type for Adapter Configuration

Connection Type for Adapter Configuration

When a new adapter configuration is created in TIBCO ActiveMatrix BusinessWorks 5.x project a client
connection reference and server connection reference is created under R3Connections folder in the adapter.
This reference, points to the actual client or server connection in the adapter. If there are multiple client or
server connection references in R3Connections folder, the first reference is always selected.

Depending on the Connection Type selected in the adapter configuration, the connection reference is
created.

● Connection Type > Inbound

The inbound connection type uses the client connection reference. For each adapter configuration, an
equivalent shared resource is created in TIBCO ActiveMatrix BusinessWorks 6.x project. If the
preference file is present in projects root folder, values from the preference file will override values from
TIBCO ActiveMatrix BusinessWorks 5.x project. If there are multiple client connection references, the
first reference is used for migration. The server connection details are not migrated unless specified in
preference file.

● Connection Type > Outbound

The outbound connection type uses the server connection reference. For each adapter configuration, an
equivalent shared resource is created in TIBCO ActiveMatrix BusinessWorks 6.x project. In outbound
connection type the details for client connection will be fetched from design time connection in adapter.
If the preference file is present in projects root folder, values from the preference file will override values
from TIBCO ActiveMatrix BusinessWorks 5.x project. If there are multiple server connection references,
the first reference is used for migration.
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● Connection Type > Both

In the Connection Type > Both, both the client and server connection reference is used. For each adapter
configuration, an equivalent shared resource is created in TIBCO ActiveMatrix BusinessWorks 6.x
project. If the preference file is present in projects root folder, values from the preference file will
override values from TIBCO ActiveMatrix BusinessWorks 5.x project. If there are multiple client and
server connection references, the first reference is used for migration.

Migrating projects with Adapter Request Response Server Activity and Request-Response
Invocation Adapter Service

You can migrate your projects that use the Adapter Request Response Server Activity from
ActiveEnterprise Adapter palette and Request-Response Invocation Service of TIBCO ActiveMatrix®
Adapter for SAP to RFC/BAPI Listener Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP
Solutions

An additional mapper activity is created after RFC/BAPI Listener activity. This mapper activity is
configured with Schema from ActiveEnterprise Adapter palette. The mapper activity acts as a wrapper and
helps retain input mappings in the following activities. You need to manually provide inputs for the
mapper activity.

Procedure

1. Start TIBCO Business Studio.

2. Click Project tab and select Migrate BW Projects.

3. In the Project Migration Wizard, the default selection is Migrate Single BusinessWorks 5.x Project in
the Migration Project Type section. Click Migrate Multiple BusinessWorks 5.x Projects to migrate
multiple 5.x projects.

4. In the Select Project Location section, click Browse in the Select Project(s) to be Migrated field and
select the project you want to migrate.

5. Click Migrate Project.

6. Click Start Migration.

7. Click Finish after the migration is complete.
All the migrated projects are displayed in the Project Explorer view at the parent level.

All the schemas defined under AESchemas folder of the TIBCO ActiveMatrix BusinessWorks 5.x project
do not get migrated. In the Configuration tab of the Adapter Request Response Server activity in TIBCO
ActiveMatrix® Adapter for SAP, an Adapter Service should be mentioned for migration. Only the
schema that is referenced by the Adapter Request Response Server activity is refetched from the SAP
system. At a time the activity supports only a single schema.

If the schema for one RFC/BAPI activity is refreshed, then the other RFC/BAPI activities in the
same process that using are using the same schema may not be refreshed.

All the configurations of the Adapter Request Response Server activity is migrated to respective fields of
RFC/BAPI Listener activity under General and Advanced tab. In the General tab of the migrated RFC/
BAPI Listener activity, the migrated shared resource will be mapped to shared resource field. The
schema selected in the Adapter Request Response Server activity is mapped to the migrated RFC/BAPI
Listener activity.

In the migrated activity, the fields not present in the Adapter Request Response Server activity,
but are present in the RFC/BAPI Listener activity will have default values. These fields can be
configured through JSON preference file. For more information, see Working with Preference
File (JSON) for migration.

8. To run the migrated project, from the menu bar click Run > Debug Configurations.
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9. In the Debug Configurations window, click Debug.

Migrating projects with Respond to Adapter Request Activity
You can migrate your projects that use the Respond to Adapter Request activity from ActiveEnterprise
Adapter Palette to Reply from RFC/BAPI in SAP activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in
for SAP Solutions in the following manner

Procedure

1. Start TIBCO Business Studio.

2. Click Project tab and select Migrate BW Projects.

3. In the Project Migration Wizard, the default selection is Migrate Single BusinessWorks 5.x Project in
the Migration Project Type section. Click Migrate Multiple BusinessWorks 5.x Projects to migrate
multiple 5.x projects.

4. In the Select Project Location section, click Browse in the Select Project(s) to be Migrated field and
select the project you want to migrate.

5. Click Migrate Project > Start Migration. After the migration is complete, click Finish.
All the migrated projects are displayed in the Project Explorer view at the parent level.

All the schemas defined under AESchemas folder of the TIBCO ActiveMatrix BusinessWorks 5.x project
do not get migrated.

If the schema for one RFC/BAPI activity is refreshed, then the other RFC/BAPI activities in the
same process that using are using the same schema may not be refreshed.

All the configurations of the Respond to Adapter Request activity is migrated to respective fields of
Reply from RFC/BAPI in SAP activity under General and Advanced tab.

In the migrated activity, the fields not present in the Respond to Adapter Request activity, but
are present in the Reply from RFC/BAPI activity will have default values. These fields can be
configured through JSON preference file. For more information, see Working with Preference
File (JSON) for migration.

6. To run the migrated project, from the menu bar click Run > Debug Configurations.

7. In the Debug Configurations windows, click Debug.

Adapter Request Response Server Activity fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions, there are some fields in the Adapter Request Response Server
and Respond to Adapter Request activity of the SAP Adapter Configuration that are default or are not
supported during migration are listed in the following tables:

Adapter Request Response Server Activity
Fields not supported on the Transport tab of the Adapter Request Response Server activity in TIBCO
ActiveMatrix® Adapter for SAP during migration

● Transport Type
● Subject
● Service
● Network
● Daemon
● SSL
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Fields not supported on the Miscellaneous tab of the Adapter Request Response Server activity in TIBCO
ActiveMatrix® Adapter for SAP during migration

● Sequencing key
● Custom Id

Fields not supported on the Error Output tab of the Adapter Request Response Server activity in TIBCO
ActiveMatrix® Adapter for SAP during migration

● Error/Exceptions

Respond to Adapter Request Activity

Fields not supported on the Error Output tab of the Respond to Adapter Request activity in TIBCO
ActiveMatrix® Adapter for SAP during migration.

● Error/Exceptions

Migrating projects with Adapter Subscriber activity and Publication Service
You can migrate your projects that use the Adapter Subscriber Activity from ActiveEnterprise Adapter
palette and Publication Service of TIBCO ActiveMatrix® Adapter for SAP to IDoc Listener or IDoc Parser
Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions.

An additional mapper activity is created after the IDoc Parser activity. This mapper activity is configured
with the schema from the ActiveEnterprise Adapter palette. The mapper activity acts as a wrapper and
helps retain input mappings in the activities that come after Adapter Subscriber activity. You need to
manually provide inputs for the mapper activity.

Procedure

1. Start TIBCO Business Studio.

2. Click Project tab and select Migrate BW Projects.

3. In the Project Migration Wizard, the default selection is Migrate Single BusinessWorks 5.x Project in
the Migration Project Type section. Click Migrate Multiple BusinessWorks 5.x Projects to migrate
multiple 5.x projects.

4. In the Select Project Location section, click Browse in the Select Project(s) to be Migrated field and
select the project you want to migrate.

5. Click Migrate Project.

6. Click Start Migration.

7. Click Finish after the migration is complete.
All the migrated projects are displayed in the Project Explorer view at the parent level.

All the schemas defined under AESchemas folder of the TIBCO ActiveMatrix BusinessWorks 5.x project
do not get migrated. In the Configuration tab of the Adapter Subscriber activity in TIBCO
ActiveMatrix® Adapter for SAP, an Adapter Service should be mentioned for migration. Only the
schema that is referenced by the Adapter Subscriber activity is re-fetched from SAP system during
migration. At a time the activity supports only a single schema.

This release of TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions does not
support migration of Custom AESchema.

All the configurations of the Publication Service is migrated to respective fields of IDoc Listener or IDoc
Parser activity under General and Advanced tab. The activities are generated based on the Publishing
Mode selected in the Publication Service. For more information on publishing mode, see Publishing
mode for Adapter Subscriber Activity.
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In the General tab of the migrated activities, the migrated shared resource will be mapped to shared
resource field. The schema selected in the Publication Service is mapped to IDoc Name of migrated
activities.

In the migrated activity, the fields not present in the Publication Service but are present in the
IDoc Listener or IDoc Parser will have default values. These fields can be configured through
JSON preference file. For more information, see Working with Preference File (JSON) for
migration.

8. To run the migrated project, from the menu bar click Run > Debug Configurations.
A default JMS connection is created after migration if the TIBCO ActiveMatrix® Adapter for SAP project
does not have any JMS connection resource.

If a JMS connection is present, it is migrated. If there are multiple Adapter Subscriber activities or
Publish to Adapter AE activities with using different transports, then value of JMS properties overwrite
the last process created. If the JSON preference file is present the value from JSON file is used.

If the Transport tab has JNDI lookups and the SSLconfigurations enabled, a JNDI connection will be
created and the SSL configuration is migrated.

9. In the Debug Configurations windows, click Debug.

Publishing mode for Adapter Subscriber activity

Depending on the publishing mode selected the adapter subscriber activity is replaced by the IDOC Parser
or IDOC Listener activity in TIBCO ActiveMatrix BusinessWorks™ SAP Solutions projects

● Publishing mode > None

For adapter subscriber activity, the None publishing mode is not supported for migration. Although if
the publication mode is selected as None, the IDoc Parser activity is replaced with an empty activity.
IDoc Listener activity is not created.

● Publishing mode > IDoc Format

For adapter subscriber activity the IDoc Parser activity is replaced with an empty activity. An additional
process is created with IDoc Listener activity. The IDoc Listener activity is created per adapter
configuration. TIDManager Resource is also created. By default, the status of the TIDManager Resource
is set to None.

● Publishing mode > Explode/Explode Batch

An IDoc Parser activity is created that replaces the Adapter Subscriber activity. An additional mapper
activity is created which refers to the adapter schema. The IDoc Listener activity is created per adapter
configuration. TIDManager Resource is also created. By default, the status of the TIDManager Resource
is set to None.

Publication Service fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the adapter services (Publication
Service) of the SAP Adapter Configuration that may default or are not supported during migration are
listed in the following tables.

Fields not supported on the Configuration tab of the Publication Service in TIBCO ActiveMatrix® Adapter
for SAP during migration

● Wire Format
● Quality of Service or Delivery Mode
● Delivery Mode
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The fields in the Schema tab of the Publication Service in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

Fields not supported on the Advanced tab of the Publication Service in TIBCO ActiveMatrix® Adapter for
SAP during migration

● Endpoint Reference
● Class Reference
● Destination
● Format
● Log IDoc To Directory

Adapter Subscriber Activity fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the Adapter Subscriber activity of the
SAP Adapter Configuration that may default or are not supported during migration are listed in the
following tables.

Fields not supported on the Configuration tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix®
Adapter for SAP during migration

● Adapter Service
● Custom AESchema
● Custom AESchema Reference

The Transport tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

The Transport Type field in the adapter service and the adapter subscriber activity of the Transport tab
should be the same.

Fields not supported on the Miscellaneous tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix®
Adapter for SAP during migration

● Sequencing Key
● Custom ID

The Output tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

Fields not supported on the Fault tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix® Adapter
for SAP during migration

● Error Output

Migrating projects with Invoke an Adapter Request-Response Service Activity and Request-
Response Service

You can migrate your projects that use the Invoke an Adapter Request-Response Service activity of from
ActiveEnterprise Adapter palette and Request-Response Service of TIBCO ActiveMatrix® Adapter for SAP
to Invoke RFC/BAPI in SAP Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions

An additional mapper activity is created after the Invoke RFC/BAPI activity. This activity is configured with
schema from the ActiveEnterprise Adapter palette. The mapper activity acts as a wrapper and helps retain
input mappings in the following activities. You need to manually provide inputs for the mapper activity.
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Procedure

1. Start TIBCO Business Studio.

2. Click Project tab and select Migrate BW Projects.

3. In the Project Migration Wizard, the default selection is Migrate Single BusinessWorks 5.x Project in
the Migration Project Type section. Click Migrate Multiple BusinessWorks 5.x Projects to migrate
multiple 5.x projects.

4. In the Select Project Location section, click Browse in the Select Project(s) to be Migrated field and
select the project you want to migrate.

5. Click Migrate Project > Start Migration. After the migration is complete, click Finish
All the migrated projects are displayed in the Project Explorer view at the parent level.

All the schemas defined under AESchemas folder of the TIBCO ActiveMatrix BusinessWorks 5.x project
do not get migrated. In the Configuration tab of the Invoke Adapter Request Response Service activity
in TIBCO ActiveMatrix® Adapter for SAP, an Adapter Service should be mentioned for migration. Only
the schema that is referenced by the Invoke Adapter Request Response Service activity is re-fetched
during migration.

All the configurations of the Invoke an Adapter Request Response Service activity is migrated to
respective fields of Invoke RFC/BAPI activity under General and Advanced tab. In the General tab of
the migrated Invoke RFC/BAPI activity, the migrated shared resource will be mapped to shared
resource field. The schema selected in the Invoke an Adapter Request Response Service activity is
mapped to RFC/BAPI of the migrated Invoke RFC/BAPI in SAP activity.

In the migrated activity, the fields that are not present in the Invoke Adapter Request
Response Service activity but are present in the Invoke RFC/BAPI in SAP activity will have
default values. These fields can be configured through JSON preference file. For more
information, see Working with Preference File (JSON) for migration.

6. To run the migrated project, from the menu bar click Run > Debug Configurations.

7. In the Debug Configurations windows, click Debug.

Invoke an Adapter Request-Response Service Activity fields not supported for migration

While migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the Invoke an Adapter Request-
Response Service activity of the SAP Adapter Configuration that may default or are not supported during
migration are listed in the following tables.

The following tabs of the Invoke an Adapter Request-Response Service activity are not supported for
migration:

● Transport tab

● Input tab

● Output tab

● Error Output tab
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Migrating projects with Publish to Adapter activity and Subscription Service
You can migrate your projects that use the Publish to Adapter from ActiveEnterprise Adapter palette and
Subscription Service in TIBCO ActiveMatrix® Adapter for SAP to IDoc Reader or JMS Send Message
Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions in the following manner:

Procedure

1. Start TIBCO Business Studio.

2. Click Project tab and select Migrate BW Projects.

3. In the Project Migration Wizard, the default selection is Migrate Single BusinessWorks 5.x Project in
the Migration Project Type section. Click Migrate Multiple BusinessWorks 5.x Projects to migrate
multiple 5.x projects.

4. In the Select Project Location section, click Browse in the Select Project(s) to be Migrated field and
select the project you want to migrate.

5. Click Migrate Project > Start Migration. After the migration is complete, click Finish.
All the migrated projects are displayed in the Project Explorer view at the parent level.

All the schemas defined under AESchemas folder of the TIBCO ActiveMatrix BusinessWorks 5.x project
do not get migrated. In the Configuration tab of the Publish to Adapter activity in TIBCO
ActiveMatrix® Adapter for SAP, an Adapter Service should be mentioned for migration. Only the
schema that is referenced by the Publish to Adapter activity is re-fetched during migration.

This release of TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions does not
support migration of RequestReply and Custom AESchema.

All the configurations of the Subscription service is migrated to respective fields of IDoc Reader or JMS
Send Message activity under General and Advanced tab. In the General tab of the migrated activity, the
migrated shared resource will be mapped to shared resource field. The schema selected in the
Subscription service is mapped to IDoc Name of the migrated activity. The destination of these activities
is the same for both and it refers to the destination in the Transport tab of the subscription service in
TIBCO ActiveMatrix® Adapter for SAP.

In the migrated activity, the fields that are not present in the Subscription Service but are present in the
IDoc Reader activity will have default values. After migration, you need to manually provide the values
for the Confirm IDoc Destination field in the Advanced tab of the IDoc Reader activity. This is required
when the IDoc Confirmation check box is selected in the IDoc Reader activity. Also, the IDoc Error
Destination field in the Advanced tab of the IDoc Reader activity.

● In the migrated activity, the fields that are not present in the Subscription Service but are
present in the IDoc Reader will have default values. These fields can be configured through
JSON preference file. For more information, see Working with Preference File (JSON) for
migration.

● After migration, the JMS send activity must be recreated with IDoc Schema input as they
have different schema structures for ActiveMatrix BusinessWorks 5.x adapter and
ActiveMatrix BusinessWorks 6.x plug-in activities.

6. To run the migrated project, from the menu bar click Run > Debug Configurations.
A default JMS connection is created after migration if the TIBCO ActiveMatrix® Adapter for SAP project
does not have any JMS connection resource.

If a JMS connection is present, it is migrated. If there are multiple Adapter Subscriber activities or
Publish to Adapter AE activities with using different transports, then value of JMS properties overwrite
the last process created. If the JSON preference file is present the value from JSON file is used.

If the Transport tab has JNDI look ups and the SSL configurations enabled, a JNDI connection will be
created and the SSL configuration is migrated.
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7. In the Debug Configurations windows, click Debug.

Subscription Service fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the adapter services (Subscription
Service) of the SAP Adapter configuration that may default or are not supported during migration are
listed in the following tables.

Fields not supported on the Configuration tab of the Subscription Service in TIBCO ActiveMatrix® Adapter
for SAP during migration

● Wire Format
● Quality of Service or Delivery Mode
● Receive IDocs in Explode Batch Mode

The fields in the Schema tab of the Subscription Service in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

Fields not supported on the Advanced tab of the Subscription Service in TIBCO ActiveMatrix® Adapter for
SAP during migration

● Endpoint Reference
● Class Reference
● Destination
● Format
● Log IDoc To Directory
● Client Connection Reference

Publish to Adapter Activity fields not supported for migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the Publish to Adapter Activity of the
SAP Adapter Configuration that may default or are not supported during migration are listed in the
following tables.

Fields not supported on the Configuration tab of the Publish to Adapter Activity in TIBCO ActiveMatrix®
Adapter for SAP during migration

● Adapter Service
● Custom AESchema
● Custom AESchema Reference
● RequestReply

The Transport tab of the Publish to Adapter Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

The Transport Type field in the adapter service and the publish to adapter activity of the Transport tab
should be the same.

The Output tab of the Publish to Adapter Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

Fields not supported on the Fault tab of the Publish to Adapter Activity in TIBCO ActiveMatrix® Adapter
for SAP during migration
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● Error Output

Working with Preference File (JSON) for migration
When a user wants to migrate a TIBCO ActiveMatrix BusinessWorks 5.x project to a TIBCO ActiveMatrix
BusinessWorks 6.x project or TIBCO BusinessWorks™ Container Edition project and if they want to use the
feature of preferences, then a adapter2plugin.json file would need to be created in the root folder of
TIBCO ActiveMatrix BusinessWorks 5.x project.

A template of the preference file would be installed in the tools folder of the plug-in in the following
location:

$TIBCO_HOME/bw/palettes/sap/version/tools/adapter2plugin.json_template

A Preference file (JSON format) can be used in the following manner:

● To override configuration defined in the TIBCO ActiveMatrix BusinessWorks 5.x project and the adapter
services carried over to the plug-in.

● To provide the configuration available in the plug-in but not available in TIBCO ActiveMatrix
BusinessWorks 5.x project.

● The JSON preference file template should be used for reference only and should not be modified or used
as it is. The preference file should be edited with the necessary properties and their corresponding
values.

● The file created under the root folder of the TIBCO ActiveMatrix BusinessWorks™ 5.x projects will not
just contain SAP but also other plug-ins that supports adapter migration.

In terms of values, the values can either be literals or references to module properties, which would pertain
to global variables from TIBCO ActiveMatrix BusinessWorks 5.x project.

To configure as a Literal Value:

To set the value of client of clientConn object of sapConnection or SAPConnectionResource to 800 in
JSON file, set the values as

"client" : "800"

To configure as a Module Property:

To use a global variable in JSON file, the user needs to have a same global variable declared with a value in
the corresponding TIBCO ActiveMatrix BusinessWorks™ 5.x project. Then the user can add the global
variable in JSON file.

To set the value of client of clientConn object of sapConnection or SAPConnectionResource to 800
using JSON file as a global variable, add a global variable in TIBCO ActiveMatrix BusinessWorks™ 5.x
project as Client and set the value as 800. Now in the JSON file, set the value as

"client" : "%%Client%%"

Below notes should be considered prior to using the JSON preference files for a TIBCO ActiveMatrix™
5.x project.
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● The location and filename of the adapter2plugin.json preference file is not configurable.

● The usage of the preference file does not support the creation of new module properties in migrated
projects. For example, we should not specify a module property %%test%% in the preferences if it does
not exist in the TIBCO ActiveMatrix BusinessWorks 5.x project.

● The usage of preference file is applicable to all adapter configurations in the TIBCO ActiveMatrix
BusinessWorks 5.x project during migration.

● Since the module properties in TIBCO ActiveMatrix BusinessWorks 6.x project are case sensitive, the
module properties in the preference file should have the same case as the TIBCO ActiveMatrix
BusinessWorks 5.x project.

● When any value is applied from the preference file , the MigrationReport.log contains logs with key
and value in uppercase.

● The password used in the JSON file should be obfuscated. The bwobfuscator utility in the
<TIBCO_HOME>/bw/version/bin folder should be used to obfuscate the password. Any other password
obfuscators will not work. For more information about how to use the bwobfuscator, see TIBCO
ActiveMatrix™ BusinessWorks Application Developement guide.

● If the value of IDoc error destination is not specified in the TIBCO ActiveMatrix BusinessWorks™ 5.x
project, then it should be specified in the JSON preference file.

● If you have different client connection types defined in ActiveMatrix BusinessWorks 5.x, then you need
to set connType as empty string to migrate the different connections to the ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions

Migrating Adapter Projects Created on TIBCO ActiveMatrix BusinessWorks™
6.x to Plug-In Projects

You can migrate a SAP Adapter project created on TIBCO ActiveMatrix BusinessWorks™ 6.x to TIBCO
ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions project by using Refactor > Migrate Adapter to
Plug-in option in TIBCO Business Studio™ for BusinessWorks™.

For migrating a project successfully, the project should have at least one process using at least one of the
adapter palette activities.

● Migration from command line is not supported.

● Migration on TIBCO BusinessWorks™ Container Edition is not supported.

● RFC/BAPI containing complex types or table types are not supported.

Prerequisite

● For databases using native drivers in ActiveMatrix BusinessWorks 6.x, the JAR files must be added to
the <TIBCO_HOME> directory before the migration is initiated.

Projects Supported for Migration

Migration is provided for the following project specifications:

Project Specification Supported for Migration To

TIBCO ActiveMarix® Adapter for SAP projects
created on ActiveMatrix BusinessWorks 6.x in
TIBCO Business Studio for BusinessWorks

ActiveMatrix BusinessWorks™ Plug-in for SAP
Solutions

Migration Restrictions

● You can migrate ActiveMatrix® Adapter for SAP projects created on ActiveMatrix BusinessWorks 6.x to
ActiveMatrix BusinessWorks Plug-in for SAP Solutions. However, vice versa is not possible.
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● Migration supports only those ActiveMatrix® Adapter for SAP projects created on ActiveMatrix
BusinessWorks 6.x that have no designtime or runtime errors before refactoring. The projects must be
validated and processes must be run successfully end to end before migrating to ActiveMatrix
BusinessWorks Plug-in for SAP Solutions projects.

● After migration, the project should be imported into a new workspace and the studio should be
restarted.

● Migration is based on the information received from the AE activities. All the activities get migrated as
it is besides the Adapter Request Response Server, Respond to Adapter Request, Adapter Subscriber,
Invoke an Adapter Request-Response Service, and Publish to Adapter activities.

● If all ActiveMatrix® Adapter for SAP 6.x projects are not migrated to ActiveMatrix BusinessWorks Plug-
in for SAP Solutions projects, then export the adapter projects, import it to a new into a workspace or
TIBCO_HOME, and then perform the migration of the project.

● Migration of SNC Client and Server Connections is not supported and after migration the required
connections must be created manually.

Considerations when Migrating Projects

● Due to the structure of ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks
6.x and the migration process, there are some files in the project migrated to ActiveMatrix
BusinessWorks Plug-in for SAP Solutions, but are not used and must be ignored. For example, - ae
folder and ae2xsd.xsd under AESchemas folder, and so on.

● An EMF validation error occurs in the migrated ActiveMatrix BusinessWorks Plug-in for SAP Solutions
project when a ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks 6.x is
saved with another name and these two projects are migrated to the plug-in. To resolve this issue, delete
the Namespaces or Imports from Process > Dependencies.

● If you want to use the SAP schemas from the migrated ActiveMatrix BusinessWorks 6.x project, the
project needs to be cleaned using the Project > Clean option from TIBCO Business Studio for
BusinessWorks. Once the project is cleaned, the schemas can be selected from the .SAP folder. The
schema can be re-fetched using the Fetch IDoc or Fetch Function button, which will make it available in
the .SAP folder and in the schema picker.

● In ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks 6.x, the Subject and
Destination fields configured in the Transport tab must have the same value for service and activity.

● If there is a ActiveMatrix BusinessWorks 6.x generic activity that uses the SAP adapter AE schema in
ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks 6.x, after migration the
ActiveMatrix BusinessWorks 6.x generic activities might need to be manually fixed to use the plug-in
activity schema.

● For migration of ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks 6.x to
ActiveMatrix BusinessWorks Plug-in for SAP Solutions project, there are a few projects that need to be
manually fixed after migration. For example, in ActiveMatrix® Adapter for SAP project created on
ActiveMatrix BusinessWorks 6.x, any schema where attributes are a SAP predefined ABAP type like
string, or if the schema is present in ActiveMatrix® Adapter for SAP activity and not present in the
plug-in activities or vice-versa and so on. Also in the such adapter project, the schema contains a double
underscore (__) while in ActiveMatrix BusinessWorks Plug-in for SAP Solutions project it is underscore
(_).

● Migration supports online schema migration, which means it retrieves the schema from the SAP server
during migration for the respective activity. Before migrating a project, ensure that the connection
parameters provided are correct in the project or in JSON reference file, otherwise errors might occur
post migration.
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Migrating projects from Adapter to Plug-in
You can migrate TIBCO ActiveMatrix® Adapter for SAP projects (created in TIBCO Business Studio™ for
BusinessWorks™) to TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions in the following
manner

Before migration, backup the original TIBCO ActiveMatrix® Adapter for SAP project created on TIBCO
ActiveMatrix BusinessWorks™ 6.x.

Procedure

1. In TIBCO Business Studio for BusinessWorks, right-click on the project in the Project Explorer and select
Refactor > Migrate Adapter to Plug-in.

2. In the Migrate Adapter Activities window, select the project to migrate. Review the processes that are
displayed for migration and then click OK.

3. Open the processes and realign the mapper activity if required. Add mappings in the mapper activity.

Migrating R3 adapter configuration to SAP Connection Resource in Plug-in
You can migrate adr3 model adapter configuration from TIBCO ActiveMatrix® Adapter for SAP projects
created on TIBCO ActiveMatrix BusinessWorks™ to SAP connection resource in TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions in the following manner

Procedure

1. In TIBCO Business Studio™ for BusinessWorks™, right-click on the project in the Project Explorer and
select Refactor > Migrate Adapter to Plug-in.

2. In the Migrate Adapter Activities window, select the project to migrate. Review the processes that are
displayed for migration and then click OK.

3. Open the processes and realign the mapper activity if required. Add mappings in the mapper activity.

Connection Type for Adapter Configuration

When a new adapter configuration is created in TIBCO ActiveMatrix BusinessWorks™ 6.x project a client
connection reference and server connection reference is created under R3Connections folder in the adapter.
This reference, points to the actual client or server connection in the adapter. If the preference file is present
in the root folder, values from the preference file override the values from TIBCO ActiveMatrix® Adapter
for SAP project created on ActiveMatrix BusinessWorks™ 6.x. If there are multiple client or server
connection pool references in R3Connections folder, always the first reference is selected.

Migrating projects with Adapter Request Response Server Activity and Request-Response
Invocation Adapter Service

You can migrate your projects that use the Adapter Request Response Server Activity from
ActiveEnterprise Adapter palette and Request-Response Invocation Service of TIBCO ActiveMatrix®
Adapter for SAP to RFC/BAPI Listener Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP
Solutions

An additional mapper activity is created after RFC/BAPI Listener activity. This mapper activity is
configured with Schema from ActiveEnterprise Adapter palette. The mapper activity acts as a wrapper and
helps retain input mappings in the following activities. You need to manually provide inputs for the
mapper activity.
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Procedure

1. In TIBCO Business Studio™ for BusinessWorks™, right-click on the project in the Project Explorer and
select Refactor > Migrate Adapter to Plug-in.

2. In the Migrate Adapter Activities window, select the project to migrate. Review the processes that are
displayed for migration and then click OK.

3. Open the processes and realign the mapper activity if required. Add mappings in the mapper activity.
In the Configuration tab of the Adapter Request Response Server activity in TIBCO ActiveMatrix®
Adapter for SAP, an Adapter Service should be mentioned for migration. Only the schema that is
referenced by the Adapter Request Response Server activity is re-fetched from the SAP system. At a
time the activity supports only a single schema.

If the schema for one RFC/BAPI activity is refreshed, then the other RFC/BAPI activities in the
same process that using are using the same schema may not be refreshed.

All the configurations of the Adapter Request Response Server activity is migrated to respective fields of
RFC/BAPI Listener activity under General and Advanced tab. In the General tab of the migrated RFC/
BAPI Listener activity, the migrated shared resource will be mapped to shared resource field. The
schema selected in the Adapter Request Response Server activity is mapped to the migrated RFC/BAPI
Listener activity.

In the migrated activity, the fields not present in the Adapter Request Response Server activity,
but are present in the RFC/BAPI Listener activity will have default values. Some of these fields
can be configured through JSON preference file. For more information, see Working with
Preference File (JSON) for migration.

4. To run the migrated project, from the menu bar click Run > Debug Configurations.

5. In the Debug Configurations window, click Debug.

Migrating projects with Respond to Adapter Request Activity
You can migrate your projects that use the Respond to Adapter Request activity from ActiveEnterprise
Adapter Palette to Reply from RFC/BAPI in SAP activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in
for SAP Solutions in the following manner

Procedure

1. In TIBCO Business Studio™ for BusinessWorks™, right-click on the project in the Project Explorer and
select Refactor > Migrate Adapter to Plug-in.

2. In the Migrate Adapter Activities window, select the project to migrate. Review the processes that are
displayed for migration and then click OK.

3. Open the processes and realign the mapper activity if required. Add mappings in the mapper activity.

If the schema for one RFC/BAPI activity is refreshed, then the other RFC/BAPI activities in the
same process that using are using the same schema may not be refreshed.

All the configurations of the Respond to Adapter Request activity is migrated to respective fields of
Reply from RFC/BAPI in SAP activity under General and Advanced tab.

In the migrated activity, the fields not present in the Respond to Adapter Request activity, but
are present in the Reply from RFC/BAPI activity will have default values. Some of these fields
can be configured through JSON preference file. For more information, see Working with
Preference File (JSON) for migration.

4. To run the migrated project, from the menu bar click Run > Debug Configurations.

5. In the Debug Configurations windows, click Debug.
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Adapter Request Response Server Activity fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions, there are some fields in the Adapter Request Response Server
and Respond to Adapter Request activity of the SAP Adapter Configuration that are default or are not
supported during migration are listed in the following tables:

Adapter Request Response Server Activity
Fields not supported on the Advanced tab of the Adapter Request Response Server activity in TIBCO
ActiveMatrix® Adapter for SAP during migration

● Durable
● Durable Name
● JMS Application Properties

Migrating projects with Adapter Subscriber activity and Publication Service
You can migrate your projects that use the Adapter Subscriber Activity from ActiveEnterprise Adapter
palette and Publication Service of TIBCO ActiveMatrix® Adapter for SAP to IDoc Listener or IDoc Parser
Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions.

An additional mapper activity is created after the IDoc Parser activity. This mapper activity is configured
with the schema from the ActiveEnterprise Adapter palette. The mapper activity acts as a wrapper and
helps retain input mappings in the activities that come after Adapter Subscriber activity. You need to
manually provide inputs for the mapper activity.

Procedure

1. In TIBCO Business Studio™ for BusinessWorks™, right-click on the project in the Project Explorer and
select Refactor > Migrate Adapter to Plug-in.

2. In the Migrate Adapter Activities window, select the project to migrate. Review the processes that are
displayed for migration and then click OK.

3. Open the processes and realign the mapper activity if required. Add mappings in the mapper activity.
In the Configuration tab of the Adapter Subscriber activity in ActiveMatrix® Adapter for SAP, an
Adapter Service should be mentioned for migration. Only the schema that is referenced by the Adapter
Subscriber activity is re-fetched from SAP system during migration. At a time the activity supports only
a single schema.

This release of ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions does not support
migration of Custom AESchema.

All the configurations of the Publication Service is migrated to respective fields of IDoc Listener or IDoc
Parser activity under General and Advanced tab. The activities are generated based on the Publishing
Mode selected in the Publication Service. For more information on publishing mode, see Working with
Preference File (JSON) for migration.

In the General tab of the migrated activities, the migrated shared resource will be mapped to shared
resource field. The schema selected in the Publication Service is mapped to IDoc Name of migrated
activities.

In the migrated activity, the fields not present in the Publication Service but are present in the
IDoc Listener or IDoc Parser will have default values. Some of these fields can be configured
through JSON preference file. For more information, see Working with Preference File (JSON)
for migration.

4. To run the migrated project, from the menu bar click Run > Debug Configurations.
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A default JMS connection is created after migration if the ActiveMatrix® Adapter for SAP project does
not have any JMS connection resource. If the JSON preference file is present, the value from the JSON
file is used.
If there are multiple Adapter Subscriber activities with using different transports, then values of JMS
properties overwrites the last process created.

5. In the Debug Configurations windows, click Debug.

Publishing mode for Adapter Subscriber activity

Depending on the publishing mode selected the adapter subscriber activity is replaced by the IDOC Parser
or IDOC Listener activity in TIBCO ActiveMatrix BusinessWorks™ SAP Solutions projects. If the preference
file is present in the projects root folder, the values from the preference file will override values from the
TIBCO ActiveMatrix® Adapter for SAP project created on TIBCO ActiveMatrix BusinessWorks™ 6.x.

● Publishing mode > IDoc Format

An empty activity is created that replaces the Adapter Subscriber activity. Also, an additional process is
created with IDoc Listener activity. The IDoc Listener activity is created per adapter configuration.
TIDManager Resource is also created. By default, the status of the TIDManager Resource is set to None.

● Publishing mode > Explode/Explode Batch

An IDoc Parser activity is created that replaces the Adapter Subscriber activity. An additional mapper
activity is created which refers to the adapter schema. The IDoc Listener activity is created per adapter
configuration. TIDManager Resource is also created. By default, the status of the TIDManager Resource
is set to None.

Publication Service fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the adapter services (Publication
Service) of the SAP Adapter Configuration that may default or are not supported during migration are
listed in the following tables.

Fields not supported on the Configuration tab of the Publication Service in TIBCO ActiveMatrix® Adapter
for SAP during migration

● Wire Format
● Description
● Session Reference
● Endpoint Reference
● Class Reference
● Delivery Mode

The fields in the Schema tab of the Publication Service in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

Fields not supported on the Advanced tab of the Publication Service in TIBCO ActiveMatrix® Adapter for
SAP during migration

● Endpoint Reference
● Destination
● Format
● Log IDoc To Directory
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Adapter Subscriber Activity fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the Adapter Subscriber activity of the
SAP Adapter Configuration that may default or are not supported during migration are listed in the
following tables.

Fields not supported on the General tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix®
Adapter for SAP during migration

● Adapter Service
● Custom AESchema

The Description tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

The Transport Type field in the adapter service and the adapter subscriber activity of the Description tab
should be the same.

Fields not supported on the Advanced tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix®
Adapter for SAP during migration

● Sequence Key
● Custom ID
● Durable
● Durable Name
● JMS Application Properties

The Output tab of the Adapter Subscriber Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

Migrating projects with Invoke an Adapter Request-Response Service Activity and Request-
Response Service

You can migrate your projects that use the Invoke an Adapter Request-Response Service activity of from
ActiveEnterprise Adapter palette and Request-Response Service of TIBCO ActiveMatrix® Adapter for SAP
to Invoke RFC/BAPI in SAP Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions.

An additional mapper activity is created after the Invoke RFC/BAPI activity. This activity is configured with
schema from the ActiveEnterprise Adapter palette. The mapper activity acts as a wrapper and helps retain
input mappings in the following activities. You need to manually provide inputs for the mapper activity.

Procedure

1. In TIBCO Business Studio™ for BusinessWorks™, right-click on the project in the Project Explorer and
select Refactor > Migrate Adapter to Plug-in.

2. In the Migrate Adapter Activities window, select the project to migrate. Review the processes that are
displayed for migration and then click OK.

3. Open the processes and realign the mapper activity if required. Add mappings in the mapper activity.

In the Configuration tab of the Invoke Adapter Request Response Service activity in ActiveMatrix®
Adapter for SAP, an Adapter Service should be mentioned for migration. Only the schema that is
referenced by the Invoke Adapter Request Response Service activity is re-fetched during migration.

All the configurations of the Invoke an Adapter Request Response Service activity is migrated to
respective fields of Invoke RFC/BAPI activity under General and Advanced tab. In the General tab of
the migrated Invoke RFC/BAPI activity, the migrated shared resource will be mapped to shared
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resource field. The schema selected in the Invoke an Adapter Request Response Service activity is
mapped to RFC/BAPI of the migrated Invoke RFC/BAPI in SAP activity.

If one way check box is selected in the schema class reference of the Request-ResponseServer adapter
service, then after migrating the ActiveMatrix® Adapter for SAP project created on TIBCO ActiveMatrix
BusinessWorks™ 6.x to ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions project, the Invocation
Protocol field of the RFC BAPI Listener activity will have the trfc value by default. In this case, the
TIDManager Resource is also created. By default, the status of the TIDManager Resource is set to None.

In the migrated activity, the fields that are not present in the Invoke Adapter Request
Response Service activity but are present in the Invoke RFC/BAPI in SAP activity will have
default values. These fields can be configured through JSON preference file. For more
information, see Working with Preference File (JSON) for migration.

4. To run the migrated project, from the menu bar click Run > Debug Configurations.

5. In the Debug Configurations windows, click Debug.

Invoke an Adapter Request-Response Service Activity fields not supported for migration

While migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the Invoke an Adapter Request-
Response Service activity of the SAP Adapter Configuration that may default or are not supported during
migration are listed in the following tables.

The following tabs of the Invoke an Adapter Request-Response Service activity are not supported for
migration:

● Description tab

● Output tab

● Fault tab

● Advanced tab

Migrating projects with Publish to Adapter activity and Subscription Service
You can migrate your projects that use the Publish to Adapter from ActiveEnterprise Adapter palette and
Subscription Service in TIBCO ActiveMatrix® Adapter for SAP to IDoc Reader or JMS Send Message
Activity in TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions in the following manner:

Procedure

1. In TIBCO Business Studio™ for BusinessWorks™, right-click on the project in the Project Explorer and
select Refactor > Migrate Adapter to Plug-in.

2. In the Migrate Adapter Activities window, select the project to migrate. Review the processes that are
displayed for migration and then click OK.

3. Open the processes and realign the mapper activity if required. Add mappings in the mapper activity.

In the Configuration tab of the Publish to Adapter activity in TIBCO ActiveMatrix® Adapter for SAP, an
Adapter Service should be mentioned for migration. Only the schema that is referenced by the Publish
to Adapter activity is re-fetched during migration.

This release of TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions does not
support migration of RequestReply and Custom AESchema.

All the configurations of the Subscription service is migrated to respective fields of IDoc Reader or JMS
Send Message activity under General and Advanced tab. In the General tab of the migrated activity, the
migrated shared resource will be mapped to shared resource field. The schema selected in the
Subscription service is mapped to IDoc Name of the migrated activity. The destination of these activities
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is the same for both and it refers to the destination in the Transport tab of the subscription service in
TIBCO ActiveMatrix® Adapter for SAP.

In the migrated activity, the fields that are not present in the Subscription Service but are present in the
IDoc Reader activity will have default values. After migration, you need to manually provide the values
for the Confirm IDoc Destination field in the Advanced tab of the IDoc Reader activity. This is required
when the IDoc Confirmation check box is selected in the IDoc Reader activity. Also, the IDoc Error
Destination field in the Advanced tab of the IDoc Reader activity.

These fields can be configured through JSON preference file. For more information, see 
Working with Preference File (JSON) for migration.

4. To run the migrated project, from the menu bar click Run > Debug Configurations.
A default JMS connection is created after migration if the ActiveMatrix® Adapter for SAP project does
not have any JMS connection resource. If the JSON preference file is present, the value from the JSON
file is used.
If there are multiple Publish to Adapter activities with using different transports, then values of JMS
properties overwrites the last process created.

5. In the Debug Configurations windows, click Debug.

Subscription Service fields not supported for Migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the adapter services (Subscription
Service) of the SAP Adapter configuration that may default or are not supported during migration are
listed in the following tables.

Fields not supported on the Configuration tab of the Subscription Service in TIBCO ActiveMatrix® Adapter
for SAP during migration

● Wire Format
● Receive IDocs in Explode Batch Mode
● Description
● Session Reference
● Endpoint Reference
● Class Reference

The fields in the Schema tab of the Subscription Service in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

Fields not supported on the Advanced tab of the Subscription Service in TIBCO ActiveMatrix® Adapter for
SAP during migration

● Destination
● Format
● Log IDoc To Directory
● Client Connection Reference

Publish to Adapter Activity fields not supported for migration

When migrating projects from TIBCO ActiveMatrix® Adapter for SAP to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions there are some fields in the Publish to Adapter Activity of the
SAP Adapter Configuration that may default or are not supported during migration are listed in the
following tables.

Fields not supported on the General tab of the Publish to Adapter Activity in TIBCO ActiveMatrix®
Adapter for SAP during migration
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● Adapter Service
● Custom AESchema
● RequestReply

The Description tab of the Publish to Adapter Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

The Transport Type field in the adapter service and the publish to adapter activity of the Advanced tab
should be the same.

The Output tab of the Publish to Adapter Activity in TIBCO ActiveMatrix® Adapter for SAP is not
supported for migration.

The Fault tab of the Publish to Adapter activity in TIBCO ActiveMatrix® Adapter for SAP project is not
supported for migration.

Working with Preference File (JSON) for migration
When you want to migrate a TIBCO ActiveMatrix® Adapter for SAP project created on TIBCO
ActiveMatrix BusinessWorks™ 6.x to TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions
project and if you want to use the feature of preferences, then a adapter2plugin.json file would need to
be created in the root folder of ActiveMatrix® Adapter for SAP project created on ActiveMatrix
BusinessWorks™ 6.x

A template of the preference file would be installed in the tools folder of the plug-in in the following
location:

$TIBCO_HOME/bw/palettes/sap/version/tools/adapter2plugin.json_template

A Preference file (JSON format) can be used in the following manner:

● To override configuration defined in the ActiveMatrix® Adapter for SAP project created on
ActiveMatrix BusinessWorks 6.x and the adapter services carried over to the plug-in.

● To provide the configuration available in the plug-in but not available in ActiveMatrix BusinessWorks
6.x project.

● The JSON preference file template should be used for reference only and should not be modified or used
as it is. The preference file should be edited with the necessary properties and their corresponding
values.

● The file created under the root folder of the ActiveMatrix® Adapter for SAP project created on
ActiveMatrix BusinessWorks 6.x will not just contain SAP but also other plug-ins that supports adapter
migration.

In terms of values, the values can either be literal's or references to module properties, which would pertain
to module property from ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks
6.x

To configure as a Literal Value:

To set the value of client of clientConn object of sapConnection or SAPConnectionResource to 800 in
JSON file, set the values as

"client" : "800"

To configure as a Module Property:

To use a module property in JSON file, you need to have the same module property declared with a value
in the corresponding ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks 6.x.
Then you can add the module property in JSON file.
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To set the value of client of clientConn object of sapConnection or SAPConnectionResource to 800
using JSON file as a module property, add a module property in TIBCO ActiveMatrix BusinessWorks™ 6.x
project as Client and set the value as 800. Now in the JSON file, set the value as

"client" : "%%Client%%"

Below notes should be considered prior to using the JSON preference files for a ActiveMatrix® Adapter
for SAP project created on ActiveMatrix BusinessWorks 6.x .

● The location and filename of the adapter2plugin.json preference file is not configurable.

● The usage of the preference file does not support the creation of new module properties in migrated
projects. For example, we should not specify a module property %%test%% in the preferences if it does
not exist in the ActiveMatrix® Adapter for SAP project created on ActiveMatrix BusinessWorks 6.x .

● The usage of preference file is applicable to all adapter configurations in the ActiveMatrix® Adapter for
SAP project created on ActiveMatrix BusinessWorks 6.x during migration.

● Since the module properties in TIBCO ActiveMatrix BusinessWorks 6.x project are case sensitive, the
module properties in the preference file should have the same case as the ActiveMatrix® Adapter for
SAP project created on ActiveMatrix BusinessWorks 6.x.

● When any value is applied from the preference file, the RefactoringReport.log contains logs with key
and value in uppercase.

● The password used in the JSON file should be obfuscated. The bwobfuscator utility in the
<TIBCO_HOME>/bw/version/bin folder should be used to obfuscate the password. Any other password
obfuscators will not work. For more information about how to use the bwobfuscator, see TIBCO
ActiveMatrix™ BusinessWorks Application Development guide.

● If the value of IDoc error destination is not specified in the ActiveMatrix® Adapter for SAP project
created on ActiveMatrix BusinessWorks 6.x, then it should be specified explicitly in the JSON preference
file.

● If you have different client connection types defined in ActiveMatrix BusinessWorks 6.x, then you need
to set connType as empty string to migrate the different connections to the ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions

Migrating projects from SAP ECC to SAP S/4HANA
You can migrate the Invoke RFC BAPI in SAP activity of TIBCO ActiveMatrix BusinessWorks™ Plug-in for
SAP Solutions to the Consume OData Service activity of TIBCO ActiveMatrix BusinessWorks™ Plug-in for
SAP S/4HANA projects.

Prerequisites

Before migration, install the TIBCO ActiveMatrix BusinessWorks™ Plug-in for OData Services for SAP S/
4HANA 6.2.1 in <TIBCO_HOME>.

Before migration, backup the original TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions
project.

Procedure

1. Start TIBCO Business Studio.

2. Right-click on a new project or an imported project and select Refactor > Migrate Plugin Activities

3. In the Migrate Plugin Activities wizard, in the Select the BusinessWorks Projects: section select the
check box for the project to migrate and for the Options select the Migrate Invoke RFC BAPI in SAP
Activity to Consume OData Service Activity check box. By default these are already selected.
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4. Click the Preview button to preview the processes to migrate. You can manually select the processes
that you want to migrate and click OK.
An additional mapper activity is created after the Consume OData Service activity. This mapper
activity acts as a wrapper between the SAP Schema and the S/4HANA schema. All the migrated projects
are displayed in the Project Explorer view at the parent level.

The input fields of the Invoke RFC/BAPI in SAP activity are mapped to the input fields of the
Consume OData Service activity defined in the sapecc2saps4hana.json file. A new SAP S/4HANA
Connection Resource is created when a project is migrated for the first time based on the values
provided in the sapecc2saps4hana.json file.

Before migrating the project, add the JSON template file manually in the project. For more
information, see Working with Preference File (JSON) for SAP ECC to SAP S/4HANA
migration.

Working with Preference File (JSON) for SAP ECC to SAP S/4HANA migration
When you want to migrate a project from TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions
to TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP S/4HANA and use the feature of preferences then
you must add a sapecc2saps4hana.json in the root folder of the project before migration.

This converts the Invoke RFC BAPI in SAP activity of the TIBCO ActiveMatrix BusinessWorks™ Plug-in for
SAP Solutions to the Consume OData Service activity of the TIBCO ActiveMatrix BusinessWorks™ Plug-in
for SAP S/4HANA.

A template of the JSON preference file would be installed in the tools folder of the plug-in, in the following
location:

$TIBCO_HOME/bw/palettes/sap/version/tools/sapecc2saps4hana.json_template

You can use the JSON preference file to:

● To provide the properties related to the new Consume OData Service activity. The schema required for
the Consume OData Service activity can be fetched using the SAP S/4HANA Cloud Connection
Resource. To create the new SAP S/4HANA Cloud Connection Resource, you need to specify its
configuration details manually in the JSON preference file.

● To provide the input field mappings of the Invoke RFC/BAPI in SAP activity that are mapped to the
input fields of the Consume OData Service activity.

Two types of mappings are supported; Field and Literal mapping.

● Field mapping- The fields from Invoke RFC/BAPI in SAP activity are mapped to fields from the
Consume OData Service activity in the following manner from the JSON preference file, <field in
Invoke RC/BAPI in Activity>:<field in Consume OData Service activity>. If the field is
part of a hierarchy, the elements are separated by a slash (/).

For example, <parent1/parent2/child3>:<parent1/child4>

The type of mapping is preserved as of the original activity.

● Literal mapping- The mapping supports literal values in the format, <value>:<name of field in
Consume OData Service activity> .

Only string field data type is supported for literal mapping in the JSON preference file. For
values, the values can only be literals and all the password types must be obfuscated
passwords.

The JSON preference file contains a mapping section which maps the input field of the Invoke RFC/BAPI in
SAP activity to the Consume OData Service activity. The mappings can contain multiple levels. The value
types is preserved in the JSON preferences file. It is not possible to change the value or its type in the JSON
preference file.
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● You must use the JSON preference file template provided in the tools folder for reference only. Copy the
template file from the tools folder and paste in the root directory of the project as
sapecc2saps4hana.json. Then edit the preference file and provide the necessary properties and their
corresponding values.

● The JSON preference file contains a field service which is given in the format: <apiName>/
<serviceName>/<operation>. The migration is based on the combination of these schema name,
service name, and process. All the activities referred to the same schema will have the same mapping
instructions.

● After migration, the date data type is changed from "YYMMDD" to "YYYY-MM-DDTHH:MM:SS".

● If the authentication type is OAuth 2.0 for On-Premise/Private Cloud environment, you will have to
populate parameter "sysPassword" to download the schemas for the SAP S/4HANA Cloud Connection
Resource in the JSON preference file.

● When refactoring is performed on the same project a multiple number of times, you should use the
same s4hanaConnection parameters defined in the sapecc2saps4hana.json preference file, and you
need to delete the RefactoringReport.log file to receive the latest log for the refactoring report.

Note the following points prior to using the JSON preference file for TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions project:

● The location and filename of the sapecc2saps4hana.json preference file is not configurable.

● The password used in the JSON preference file should be obfuscated. The bwobfuscator utility in the
<TIBCO_HOME>/bw/version/bin folder should be used to obfuscate the password. Any other password
obfuscators will not work. For more information about how to use the bwobfuscator, see TIBCO
ActiveMatrix™ BusinessWorks Application Developement guide.

● The JSON preference file is case sensitive.

● While migrating any projects, any open processes are closed and reopened after migration.

● During migration a RefactoringReport.log file is created for the project. This log file contains the
name of the process, activity, and steps of migration. Any errors that are generated are logged in this
file. The RefactoringReport.log file is not appended. To receive new log file, you need to delete the
existing RefactoringReport.log file.
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Troubleshooting

When you encounter problems with the project, ensure that you have cleaned up the project.
If errors occur when you run a process in TIBCO Business Studio, you can do a cleaning first. Cleaning
deletes all the old files and reorganizes the project.

Procedure

1. Right-click the project in the Project Explorer view and click Refresh.

2. Select Project > Clean to start the cleaning.
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Working with Sample Projects

The plug-in packages sample projects with the installer. The sample projects show how TIBCO
ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions works. After installing the plug-in, you can locate
the sample projects in the following directory: TIBCO_HOME/bw/palettes/sap/version_number/
examples.

The plug-in provides three sample projects, IDoc_Examples, RFC_BAPI_Examples, and
Migration_Examples.

The examples mentioned in this section are compatible with only the latest ActiveMatrix BusinessWorks™
version supported. For supported versions, refer to the readme file.

● While importing the projects, if any warnings are encountered, use the Quick Fix option to resolve the
warning.

● The existing IDoc_Examples and RFC_BAP_Examples samples should not be used for migration from
SAP ECC to SAP S/4HANA

● While importing the examples to a new workspace if XSLT errors are observed, select the Show Check
and Repair option in the mapper to resolve the error and perform automatic fix.

IDoc_Examples

The IDoc_Examples project shows how to use the IDoc Listener, IDoc Parser, IDoc Acknowledgment, IDoc
Reader, and IDoc Confirmation activities to delivery IDocs between the plug-in and the SAP system.

This project contains the following processes:

● Outbound scenario

— ReceiveIDocsFromSAP

Use an IDoc Listener activity to listen on the SAP system and receive IDocs published from the SAP
system where the IDoc is processed by activity using TIBCO Enterprise Message Service.

— ProcessVendorMasterIDocs

Use an IDoc Parser activity to retrieve the CREMAS01 IDocs processed by the IDoc Listener activity,
and then parse the IDocs. Then, use an IDoc Acknowledgment activity to acknowledge the parsed
CREMAS01 IDocs. The retrieved IDoc number and type are displayed in the console view.

— ProcessIDocFromSAPNoXML

Use a JMS Receive Message activity to read the received CREMAS01 IDocs in a raw format.

— ProcessCustomerMasterIDocs

Use an IDoc Parser activity to retrieve the DEBMAS01 IDocs processed by the IDoc Listener activity,
and then parse the IDocs. Then, use an IDoc Acknowledgment activity to acknowledge the parsed
DEBMAS01 IDocs. The retrieved IDoc number and type are displayed in the console view.

— ReceiveIDocsFromSAPtoKafka

Use an IDoc Listener activity to listen on the SAP system and receive IDocs published from the SAP
system where the IDoc is processed by activity using Apache Kafka.

— ReceiveIDocsFromSAPNoMessaging

Use an IDoc Listener activity to listen on the SAP system and receive IDocs published from the SAP
system where the IDoc is processed by activity without the need for TIBCO Enterprise Message
Service or Apache Kafka.

— ProcessVendorMasterIDocsNoMessaging
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Use the IDoc Converter activity to output the CREMAS01 IDoc outputted by the IDoc Listener
activity, and parse the IDoc. Use an IDoc Acknowledgment activity to acknowledge the parsed
CREMAS01 IDoc. The retrieved IDoc number and type are displayed on the console view.

— ProcessCustomerMasterIDocsNoMessaging

Use the IDoc Converter activity to output the DEBMAS01 IDoc outputted by the IDoc Listener
activity, and parse the IDoc. Use an IDoc Acknowledgment activity to acknowledge the parsed
DEBMAS01 IDoc. The retrieved IDoc number and type are displayed on the console view.

● Inbound scenario

— StageVendorMasterIDocs

Use a JMS Send Message activity to send a specified CREMAS01 IDoc to the EMS server.
— PostVendorMasterIDocs

Use an IDoc Reader activity to post the CREMAS01 IDoc sent to the EMS server in the
StageVendorMasterIDocs.bwp process to the SAP system. The TID and the message ID of the IDoc
are displayed in the console view.

— PostVendorMasterIDocsNoMessaging

Use the Post IDoc to SAP activity to post the CREMAS01 IDoc passed as input to activity to the SAP
system. IDoc confirmation information is displayed on the Console view.

— ConfirmVendorMasterIDocs

Use an IDoc Confirmation activity to confirm the CREMAS01 IDoc posted to the SAP system by the
IDoc Reader activity.

— PostVendorMasterIDocMultiDestination

Use the IDoc Renderer and the PostIDoctoSAP activities to send same generated CREMAS01 raw
IDoc data to multiple SAP destinations. Here using Dynamic Connection activity to provide
different SAP connections to PostIDoctoSAP activity.

RFC_BAPI_Examples

The RFC_BAPI_Examples project shows how to use the Dynamic Connection, RFC BAPI Listener, Invoke
RFC BAPI in SAP, and Reply from RFC BAPI in SAP activities to create or terminate dynamic connections,
handle the exceptions, control the commit of a transaction externally, and achieve the request/response
scenario.

This project contains the following processes:

● DynamicConnection

Use a Dynamic Connection activity to establish a dynamic connection, and an Invoke RFC BAPI in SAP
activity to retrieve the entries in the T000 table in the SAP system by invoking the
RFC_GET_TABLE_ENTRIES function module. Then, use another Dynamic Connection activity to
terminate the dynamic connection.

In this example, the connection managed by the Dynamic Connection activity is not being used as an
inbound transaction.

● Before running this example, maintain the module properties used by the input schema of
the Dynamic Connection activity to establish a dynamic connection.

● An exception of data conversion might occur depending on the data returned from the SAP
system.

● ExceptionHandling

Use an Invoke RFC BAPI in SAP activity to retrieve the entries in the T002 table in the SAP system by
invoking the RFC_GET_TABLE_ENTRIES function module.
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If an exception occurs in the plug-in, the error code and message are displayed in the console view.

If an exception occurs in the SAP system, the error message is displayed in the console view.

An exception of the data conversion might occur depending on the data returned from the
SAP system.

● InvokeBAPIWithExternalCommit

Use an Invoke RFC BAPI in SAP activity to create a sales order in the SAP system by invoking the
BAPI_SALESORDER_CREATEFROMDAT1 function module.

If the Invoke RFC BAPI in SAP activity fails to create the sales order, the sales order is rolled back by
invoking the BAPI_TRANSACTION_ROLLBACK function module. The return message is displayed in
the console view.

Otherwise, the sales order is committed by invoking the BAPI_TRANSACTION_COMMIT function
module. Then, the delivery date and the number of the created sales order are got by invoking the
BAPI_SALESORDER_GETSTATUS function module, and displayed in the console view.

● Request_Reply

Use an RFC BAPI Listener activity to receive the request of the BAPI_XBP_EVENT_RAISE RFC/BAPI
function module.

If the event ID is VENDOR, an Invoke RFC BAPI in SAP activity invokes the
BAPI_VENDOR_GETDETAIL function module in the SAP system to check if the vendor number is
valid.

● If the vendor number is valid, the returned vendor name and number are displayed in the console
view.

● Otherwise, the return message is displayed in the console view.

If the event ID is CUSTOMER, an Invoke RFC BAPI in SAP activity invokes the
BAPI_CUSTOMER_GETDETAIL2 function module in the SAP system to check if the customer number
is valid.

● If the customer number is valid, the returned customer name and number are displayed in the
console view.

● Otherwise, the return message is displayed in the console view.

If the event ID is neither VENDOR nor CUSTOMER, the return message with the content of Bad
EventID is displayed in the console view.

Migration_Examples

The Migration_Examples project converts the Invoke RFC/BAPI in SAP activity of the TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP Solutions to the Consume OData Service activity of the TIBCO
ActiveMatrix BusinessWorks™ Plug-in for OData Services for SAP S/4HANA .

This project contains the following process:

● CheckMaterialFromCustomerPlant

This process has two invoke activities, GetPlantFromCustomer (Invoke RFC BAPI in SAP) and Material
ATP (Invoke RFC BAPI in SAP). This process retrieves information from the plant associated with the
customer using the Customer ID and use the information received from the plant to check availability of
the material.
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Importing Sample Projects
Before running the project, you must import the sample project to TIBCO Business Studio™ for
BusinessWorks™.

Procedure

1. Start TIBCO Business Studio for BusinessWorks using one of the following ways:

● Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business
Studio version_number > Studio for Designers.

● Mac OS and Linux: run the TIBCO Business Studio for BusinessWorks executable file located in the
TIBCO_HOME/studio/version_number/eclipse directory.

2. From the menu, click File > Import.

3. In the Import dialog, expand the General folder and select the Existing Studio Projects into Workspace
item and click Next.

4. Click Select archive file, and then click Browse next to the Select archive file field to locate the sample
projects.
The sample projects are located in the TIBCO_HOME/bw/palettes/sap/version_number/examples
directory.

5. In the Projects list, all the sample projects are selected. You can clear the sample projects that you do not
want to import, and then click Finish.

Result

The sample projects are imported to TIBCO Business Studio for BusinessWorks .
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Running the Project
After importing the sample project, you can run the project to see how the plug-in works.

When running the sample project, if an exception occurs, you have to refresh the schemas configured in the
activities.

Prerequisites

Ensure that you have imported the sample project to TIBCO Business Studio, as described in Importing
Sample Projects.

Procedure

1. In the Project Explorer view, expand the Resources folder, and then expand the shared resource
package.

2. Double-click the following shared resources and configure them in the shared resources editors.

● IDoc_Examples

— JMSConnectionResource.JMSConnectionResource
— SAPConnectionResource.sapconnectionResource
— SAPTIDManagerResource.saptidmanagerResource
— KafkaSAPConnectionResource.sapconnectionResource

● RFC_BAPI_Examples

— SAPConnectionResource.sapconnectionResource

See the TIBCO ActiveMatrix BusinessWorks documentation, SAP Connection and SAP TIDManager for
details.

3. From the menu, click Run > Run Configurations to run the sample processes.

4. In the Run Configurations dialog, expand BusinessWorks Application and click BWApplication.

5. In the Applications tab, all the sample applications are selected. You can clear the sample applications
that you do not want to run.

6. Click Run to run the processes.
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Managing Logs

When an error occurs, you can check logs to trace and troubleshoot the plug-in exceptions.

By default, error logs are displayed in the Console view when you run a process in the debug mode. You
can change the log level of the plug-in to trace different messages and export logs to a file. Different log
levels correspond to different messages. See Log Levels for details.

Log Levels
Different log levels include different information.

The plug-in supports the following log levels:

Log Level Description

Trace Includes all information regarding the running process.

Debug Indicates a developer-defined tracing message.

Info Indicates normal plug-in operations. No action is required. A tracing message
tagged with Info indicates that a significant processing step is reached, and logged
for tracking or auditing purposes. Only info messages preceding a tracking
identifier are considered as significant steps.

Warn Indicates that an abnormal condition occurred. Processing continues, but for best
practice, you can contact the administrator to investigate it.

Error Indicates that an unrecoverable error occurred. Depending on the severity of the
error, the plug-in might continue with the next operation or might stop.

Setting Up Log Levels
You can configure a different log level for the plug-in and plug-in activities to trace different messages.

If you do not configure any log levels, the plug-in uses the default log level of TIBCO ActiveMatrix
BusinessWorks. The default log level is Error.

Procedure

1. Navigate to the TIBCO_HOME/bw/version_number/config/design/logback directory and open the
logback.xml file.

2. Add the following node in the BusinessWorks Palette and Activity loggers area to specify a log level
for the plug-in:
<logger name="com.tibco.bw.palette.sap.runtime">
   <level value="DEBUG"/>
</logger>

The value of the level element can be Error, Info, or Debug.

If you set the log level to Debug, the input and output for the plug-in activities are also
displayed in the Console view. See Log Levels for more details regarding each log level.

3. Optional. Add one of the following nodes in the BusinessWorks Palette and Activity loggers area to
control a log level for the activity.
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● For example to control the log level for the IDoc Acknowledgment activity, set the following
parameters:

<logger name="com.tibco.bw.palette.sap.runtime.idocacknowledgment">
   <level value="TRACE"/>
</logger>

The value of the level element can be Trace, Warn, Error, Info, or Debug.

The activities not configured with specific log levels use the log level configured for the plug-
in.

Logger names for each activities are as follows:

● IDoc Acknowledgment

com.tibco.bw.palette.sap.runtime.idocacknowledgment

● IDoc Confirmation

com.tibco.bw.palette.sap.runtime.idocconfirmation

● IDoc Converter

com.tibco.bw.palette.sap.runtime.idocconverter

● IDoc Listener

com.tibco.bw.palette.sap.runtime.idoclistener

● IDoc Parser

com.tibco.bw.palette.sap.runtime.idocparser

● IDoc Reader

com.tibco.bw.palette.sap.runtime.idocreader

● Post IDoc to SAP

com.tibco.bw.palette.sap.runtime.postidoc

● IDoc Renderer

com.tibco.bw.palette.sap.runtime.idocrenderer

● Invoke RFC BAPI in SAP

com.tibco.bw.palette.sap.runtime.activities.InvokeRequestResponseActivity

● RFC BAPI Listener

com.tibco.bw.palette.sap.runtime.activities.RequestResponseServerEventSource

● Reply from RFC BAPI in SAP

com.tibco.bw.palette.sap.runtime.activities.Respond2RequestActivity

● Dynamic Connection

com.tibco.bw.palette.sap.runtime.activities.DynamicConnectionActivity

Logger names for shared resources

● SAP Connection

com.tibco.bw.sharedresource.sapconnection.runtime

● SAP TIDManager

com.tibco.bw.sharedresource.saptidmanager.runtime

4. Save the file.
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Exporting Logs to a File
You can update the logback.xml file to export plug-in logs to a file.

Procedure

1. Navigate to the TIBCO_HOME/bw/version_number/config/design/logback directory and open the
logback.xml file.

After deploying an application in TIBCO Enterprise Administrator, navigate to the
TIBCO_HOME/bw/version_number/domains/domain_name/appnodes/space_name/

node_name directory to find the logback.xml file.

2. Add the following node to specify the file where the log is exported:
<appender name="FILE" class="ch.qos.logback.core.FileAppender">
   <file>c:/bw6-sap.log</file>
      <encoder>
        <pattern>%d{HH:mm:ss.SSS} [%thread] %-5level %logger{36}-%msg%n</pattern>
      </encoder>
</appender>

The value of the file element is the absolute path of the file that stores the exported log.

3. Add the following node to the root node at the bottom of the logback.xml file:
<root level="DEBUG">
   <appender-ref ref="STDOUT" />
   <appender-ref ref="FILE" />
</root>

4. Save the file.
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Error Codes

The following tables list error codes, detailed explanation of each error, and where applicable, ways to solve
different errors.

SAP Connection Error Codes

Error Code and Error
Message Role Category Description Solution

TIBCO-BW-SR-
SAPCONNECTION-200002

Starting Shared Resource

{0}.

debug BW-Plug-in The SAP Connection
shared resource {0} is
being started.

None.

TIBCO-BW-SR-
SAPCONNECTION-200003

Updating Shared Resource

{0}.

debug BW-Plug-in The SAP Connection
shared resource {0} is
being updated.

None.

TIBCO-BW-SR-
SAPCONNECTION-200004

Stopping Shared Resource

{0}.

debug BW-Plug-in The SAP Connection
shared resource {0} is
being stopped.

None.

TIBCO-BW-SR-
SAPCONNECTION-200005

Deleting Shared Resource

{0}.

debug BW-Plug-in The SAP Connection
shared resource {0} is
being deleted.

None.

TIBCO-BW-SR-
SAPCONNECTION-200006

Set the default value of

thread number for SAP

Shared Resource {0},

current value is {1},

default is 8.

debug BW-Plug-in The invalid value is
specified for thread
number, instead use the
default value.

None.

TIBCO-BW-SR-
SAPCONNECTION-200007

Created the thread pool

for SAP Shared Resource

{0}, thread number is

{1}.

debug BW-Plug-in Indicates the information
on the thread pool for a
specific SAP Connection
Shared Resource.

None.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-SR-
SAPCONNECTION-201001

[{0}].

debug BW-Plug-in Debug information [{0}]
is generated when a
JCoException is received,
a function is being
removed from cache, or
the server connection
status is changed.

None.

TIBCO-BW-SR-
SAPCONNECTION-301007

Reconnect attempt {0}

for connection {1}

info BW-Plug-in This information is
generated to notice that
the SAP client or server
connection {1} is trying
to reconnect for the {0}th
attempt.

None.

TIBCO-BW-SR-
SAPCONNECTION-301020

Connection disconnected

info BW-Plug-in This information is
generated when the SAP
client connection starts
to be reconnected.

None.

TIBCO-BW-SR-
SAPCONNECTION-301021

Activated timer to check

connectivity to R/3 for

connection-pool {0}

info BW-Plug-in This information is
generated when the SAP
client connection starts
to be reconnected.

None.

TIBCO-BW-SR-
SAPCONNECTION-301022

Using SNC with Logon

Groups connection

info BW-Plug-in Indicates the current
connection type is SNC
with Logon Groups
connection.

None.

TIBCO-BW-SR-
SAPCONNECTION-401004

Server connection {0}

will not be initialized:

{1}

warn BW-Plug-in The server connection {0}
cannot be initialized
when creating a server
connection with the
combination of the
program ID, gateway
host, and gateway
service that have already
been used by another
server connection.

None.

TIBCO-BW-SR-
SAPCONNECTION-500001

Creating Shared Resource

{0} failed.

error BW-Plug-in Creating the SAP
Connection shared
resource {0} fails.

Check the items in
the error message.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-SR-
SAPCONNECTION-501001

Connection Error. Unable

to create a connection

with the target

application {0} using

connection parameters

{1} and the target

application error is {2}

error BW-Plug-in Creating a client
connection to the
application server {0}
fails.

The SAP JCo error is {2}.

Check the client
connection
parameters.

TIBCO-BW-SR-
SAPCONNECTION-501003

Client connection {0} is

invalid

error BW-Plug-in The client connection {0}
is invalid.

Check the client
connection
parameters and
the network
connectivity.

TIBCO-BW-SR-
SAPCONNECTION-501004

Connection Error. {0}

stopping due to

persistent connection

errors to the SAP R/3

system(s)

error BW-Plug-in The client or server
connection {0} is stopped
because of the persistent
connection errors.

Check the client or
server connection
parameters and
the network
connectivity.

TIBCO-BW-SR-
SAPCONNECTION-501007

Server connection {0} is

invalid: {1}

error BW-Plug-in The server connection {0}
is invalid.

Check the server
connection
parameters and
the network
connectivity.

TIBCO-BW-SR-
SAPCONNECTION-501008

Starting Shared Resource

{0} failed.

error BW-Plug-in Starting the SAP
Connection shared
resource {0} fails.

Check the items in
the error message.

TIBCO-BW-SR-
SAPCONNECTION-501009

Server Error: {0}

error BW-Plug-in The server error {0}
occurs.

Check the server
connection
parameters, the
network
connectivity, and
whether the SAP
system is shut
down.

TIBCO-BW-SR-
SAPCONNECTION-501010

Server Exception: {0}

error BW-Plug-in The server exception {0}
occurs.

Check the items in
the error message.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-SR-
SAPCONNECTION-501011

Server connection pool:

{0} suspended due to

exceeded attempts to

connect to SAP system

error BW-Plug-in The server connection
pool is suspended when
the server connection
cannot be established
after the maximum time
interval between two
successive attempts.

Check the server
connection
parameters, the
network
connectivity, and
whether the SAP
system is shut
down.

SAP TIDManager Error Codes

Error Code and Error
Message Role Category Description Solution

TIBCO-BW-SR-
SAPTIDMANAGER-200002

Starting Shared Resource

{0}.

debug BW-Plug-in The SAP TIDManager
shared resource {0} is
being started.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-200003

Updating Shared Resource

{0}.

debug BW-Plug-in The SAP TIDManager
shared resource {0} is
being updated.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-200004

Stopping Shared Resource

{0}.

debug BW-Plug-in The SAP TIDManager
shared resource {0} is
being stopped.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-200005

Deleting Shared Resource

{0}.

debug BW-Plug-in The SAP TIDManager
shared resource {0} is
being deleted.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-500001

Creating Shared Resource

{0} failed.

error BW-Plug-in Creating the SAP
TIDManager shared
resource {0} fails.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-500002

Starting TIDmanager

Shared Resource {0}.

error BW-Plug-in Starting the TIDManager
shared resource {0} fails.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-500003

Can't register JDBC

driver {0}.

error BW-Plug-in The JDBC driver for the
TID management cannot
be registered.

None.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-SR-
SAPTIDMANAGER-500004

Can't deregistered JDBC

driver {0}.

error BW-Plug-in The JDBC driver for the
TID management cannot
be unregistered.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-500005

Sql Exception {0}.

error BW-Plug-in The SQL exception
occurs in the database.

None.

TIBCO-BW-SR-
SAPTIDMANAGER-500006

Table TIDManager does

not exist in database,

the URL is

\u201C{0}\u201D, Please

create table first!

error BW-Plug-in The database table for
the TID management
does not exist.

None.

SAP Palette Error Codes

Error Code and Error
Message Role Category Description Solution

TIBCO-BW-PALETTE-
SAP-101015

Using JMS as Messaging

Source

debug BW-Plug-in Indicates the message
source that has been
used.

None

TIBCO-BW-PALETTE-
SAP-101016

Using Kafka as

Messaging Source

debug BW-Plug-in Indicates the message
source that has been
used.

None

TIBCO-BW-PALETTE-
SAP-101017

Using No Messaging as

Messaging Source

error BW-Plug-in Indicates the
NoMessaging as current
messaging resource.

None

TIBCO-BW-PALETTE-
SAP-102011

Received invocation

request for {0} with

invocation protocol

{1}.

trace BW-Plug-in Indicates the
information on request.

None.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-PALETTE-
SAP-102021

Completed invocation

request for {0} with

TID {1}.

trace BW-Plug-in Indicates the completion
of request.

None.

TIBCO-BW-PALETTE-
SAP-104001

Received IDoc(s). RFC

Function=[{0}], IDOC

Name=[{1}],

Number=[{2}], Receiving

Partner=[{3}],

Count=[{4}].

debug BW-Plug-in The information about
the request from the
SAP system is
displayed.

None.

TIBCO-BW-PALETTE-
SAP-104002

Start marshaling the

IDoc(s), TID:[{0}].

error BW-Plug-in Indicates the start of
marshaling IDoc(s)

None.

TIBCO-BW-PALETTE-
SAP-104003

Finish marshaling the

IDoc(s), Elapsed Time:

{0} ms, TID: {1}.

error BW-Plug-in Indicates the end of
marshaling IDoc(s)

None.

TIBCO-BW-PALETTE-
SAP-104004

Message has been sent

to queue [{0}]

successfully. The

content of message is

{1}

debug BW-Plug-in An IDoc message is sent
to the queue [{0}]
successfully, and the
content of the message is
{1}.

None.

TIBCO-BW-PALETTE-
SAP-104005

Error occurred when

processing the IDoc.

The error message is

[{0}].

error BW-Plug-in The error [{0}] occurs
when processing the
IDoc.

None.

TIBCO-BW-PALETTE-
SAP-104006

Message has been sent

to Topic [{0}]

successfully. The

content of message is

{1}

debug BW-Plug-in An IDoc message is sent
to the Topic[{0}]
successfully, and the
content of the message is
{1}.

None
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-PALETTE-
SAP-104007

Kafka Producer started.

debug BW-Plug-in Indicates that the Kafka
Producer has been
started.

None

TIBCO-BW-PALETTE-
SAP-104008

Shutting down Kafka

Producer.

debug BW-Plug-in Indicates that Kafka
Producer has been
shutdown.

None

TIBCO-BW-PALETTE-
SAP-104009

The content of the

output message:\n {0}

error BW-Plug-in Indicates the content of
the output message

None

TIBCO-BW-PALETTE-
SAP-104010

IDOC RFC Function

invoked: {0}

error BW-Plug-in Indicates the function
module invoked by SAP

None

TIBCO-BW-PALETTE-
SAP-104011

Received IDOC Name/TID/

Receiving Partner:

{0}/{1}/{2}, Count: {3}

error BW-Plug-in Indicates the summary
of input messages

None

TIBCO-BW-PALETTE-
SAP-104012

error BW-Plug-in Indicates the
information associated
with IDoc received from
SAP

None

TIBCO-BW-PALETTE-
SAP-105001

Received the raw type

of IDoc from the queue

[{0}]. IDoc Name=[{1}],

IDoc Number=[{2}].

debug BW-Plug-in The information about
the IDoc in raw type
received from the queue
[{0}] is displayed.

None.

TIBCO-BW-PALETTE-
SAP-105002

Output has been

generated. The content

of the output is {0}

debug BW-Plug-in An IDoc message is
converted into the XSD
format. The converted
content is {0}.

None.

TIBCO-BW-PALETTE-
SAP-105003

Connection Exception

occurred. EventSource

will deactivate.

error BW-Plug-in The EMS server is not
accessible.

Start the EMS
server.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-PALETTE-
SAP-105009

On exception in IDoc

Parser from

AbstractJmsReceive.

Started value is [{0}].

debug BW-Plug-in An exception is returned
from
AbstractJmsReceive.

None.

TIBCO-BW-PALETTE-
SAP-105010

On stop in IDoc Parser

from

AbstractJmsReceive.

Started value is [{0}].

debug BW-Plug-in The stop method is
invoked by
AbstractJmsReceive.

None.

TIBCO-BW-PALETTE-
SAP-105011

The IDocParser failed

to a generate a new

event due to schema

mismatch. The IDoc set

for IDocParser[{0}],

the IDoc received

[{1}].

error BW-Plug-in The IDoc Parser activity
fails to generate a new
event due to the schema
mismatch.

None.

TIBCO-BW-PALETTE-
SAP-105013

Error=[{0}], IDoc

Name=[{1}], IDoc

Number=[{2}].

error BW-Plug-in Indicates the message
contains the invalid
character. For example,
control character.

Remove the
invalid
character(s) from
the message

TIBCO-BW-PALETTE-
SAP-107002

Failed to create

connection to the JMS

server. {0}

error BW-Plug-in Creating connections to
the EMS server fails.

Check the JMS
Connection shared
resource and
whether the EMS
server is running.

TIBCO-BW-PALETTE-
SAP-107003

Unable to find

destination [{0}] on

JMS server

error BW-Plug-in The JMS destination [{0}]
cannot be found on the
EMS server.

Check whether the
specified
destination exists
on the EMS server.

TIBCO-BW-PALETTE-
SAP-107004

Error occurred when

attempting to create

MessageConsumer

error BW-Plug-in An error occurs when
creating a message
consumer.

Check the JMS
Connection shared
resource and
whether the EMS
server is running.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-PALETTE-
SAP-107005

Error occurred when

attempting to receive a

JMS message

error BW-Plug-in An error occurs when
receiving a JMS
message.

Check the activity
configuration, the
JMS Connection
shared resource,
and whether the
EMS server is
running.

TIBCO-BW-PALETTE-
SAP-107006

Error occurred when

attempting to send a

JMS message

error BW-Plug-in An error occurs when
sending a JMS message.

Check the activity
configuration,
input data, JMS
Connection shared
resource, and
whether the EMS
server is running.

TIBCO-BW-PALETTE-
SAP-107007

Error occurred when

attempting to resolve

destination

error BW-Plug-in An error occurs when
resolving the
destination.

Check the JMS
Connection shared
resource and
whether the EMS
server is running.

TIBCO-BW-PALETTE-
SAP-107008

Invalid configuration

data. JMS connection

reference is not

specified.

error BW-Plug-in The JMS connection
reference is not
specified.

Check the activity
configuration for
the JMS
Connection
reference.

TIBCO-BW-PALETTE-SAP-
108001

Posting the

Acknowledgment IDoc to

the client. TID=[{0}].

debug BW-Plug-in The plug-in is posting
an acknowledgment
IDoc to the client.

None.

TIBCO-BW-PALETTE-SAP-
108002

For IDoc=[{0}] posted

the Acknowledgment IDoc

to the client.

TID=[{1}].

debug BW-Plug-in The acknowledgment
IDoc with TID=[{1}] for
IDoc=[{0}] is posted the
to the client.

None.

TIBCO-BW-PALETTE-SAP-
108003

Error occurred when

posting an

acknowledgment to IDoc

[{0}] to SAP, error

message=[{1}]

error BW-Plug-in The error [{1}] occurs
when posting an
acknowledgment to the
IDoc [{0}] to the SAP
system.

None.
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Error Code and Error
Message Role Category Description Solution

TIBCO-BW-PALETTE-SAP-
108005

Both the successMessage

and the errorMessage

are missing in the

input data, will have

no acknowledgment sent

back to SAP, the

Acknowledgment to the

IDoc [{0}] will be

skipped.

debug BW-Plug-in Both the
successMessage and
the errorMessage items
are missing in the input
data, and no
acknowledgment is sent
back to the SAP system.
The acknowledgment to
IDoc [{0}] is to be
skipped.

None.

TIBCO-BW-PALETTE-SAP-
109001

Received message from

the queue [{0}]. TID =

[{1}], The

correlationID = [{2}].

debug BW-Plug-in The information about
the IDoc confirmation
message from the queue
[{0}] is displayed.

None.

TIBCO-BW-PALETTE-SAP-
109002

Successfully invoked

function [{0}]. TID =

[{1}], IDoc Number =

[{2}].

debug BW-Plug-in The IDoc number
related to the TID = [{1}]
is returned by invoking
function [{0}]
successfully.

None.

TIBCO-BW-PALETTE-SAP-
109003

Successfully invoked

function [{0}]. IDoc

Number = [{1}], IDoc

status = [{2}].

debug BW-Plug-in The IDoc status for the
IDoc with IDoc number
being [{1}] is returned by
invoking function [{0}]
successfully.

None.

TIBCO-BW-PALETTE-SAP-
109004

Received message from

the queue [{0}]. The

correlationID is [{1}].

The error message is

[{2}].

debug BW-Plug-in The IDoc Confirmation
activity receives a
confirmation message
with the error message
[{2}] from the queue [{0}]
with JMS correlation ID
being [{1}]. The error
message includes
information related to
the reason the IDoc fails
to be sent to the SAP
server.

Check the
structure of the
IDoc that fails to
be sent to the SAP
server.
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TIBCO-BW-PALETTE-SAP-
109006

On exception in IDoc

Confirmation from

AbstractJmsReceive.

Started value is [{0}].

debug BW-Plug-in The status [{0}] of JMS is
displayed when an
exception is returned
from JMS in the IDoc
Confirmation activity.

Check the JMS
Connection shared
resource and
whether the EMS
server is running.

TIBCO-BW-PALETTE-SAP-
109007

Acknowledged the

message with the ID

[{0}] from the queue

[{1}].

debug BW-Plug-in The confirmation
message is confirmed
from the queue [{1}]
with JMS correlation ID
being [{0}].

None.

TIBCO-BW-PALETTE-SAP-
109008

Acknowledged the

message with the ID

[{0}] from the queue

[{1}].

debug BW-Plug-in The information about
the output of the IDoc
Confirmation activity is
displayed.

None.

TIBCO-BW-PALETTE-SAP-
109009

JMS Exception occurred,

the error message is

[{0}].

error BW-Plug-in The error [{0}] occurs
when trying to confirm
the message but the JMS
is not in an appropriate
state.

Check the JMS
Connection shared
resource and
whether the EMS
server is running.

TIBCO-BW-PALETTE-SAP-
109010

IDoc sent to SAP via

qRFC. IDoc number is

unavailable. The

original TID is [{0}].

debug BW-Plug-in The original TID [{0}] is
displayed in the IDoc
Confirmation activity if
the IDoc is sent to the
SAP server through
qRFC by the IDoc
Reader activity.

None.

TIBCO-BW-PALETTE-SAP-
109011

RFC function execution

failure : {0}; function

name : [{1}].

error BW-Plug-in The error [{0}] occurs if
an exception is returned
from the SAP server
when invoking the
function [{1}].

Check whether the
IDoc exists on the
SAP server.

TIBCO-BW-PALETTE-
SAP-201001

{0}

debug BW-Plug-in The input of the Job
Data view is displayed.

None.

TIBCO-BW-PALETTE-
SAP-201002

{0}

debug BW-Plug-in The output of the Job
Data view is displayed.

None.
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TIBCO-BW-PALETTE-
SAP-201003

{0}

debug BW-Plug-in The data in the console
is displayed.

None.

TIBCO-BW-PALETTE-
SAP-201004

JCo Attributes {0}

trace BW-Plug-in JCo attributes are
displayed.

None.

TIBCO-BW-PALETTE-
SAP-201005

Dynamic connection {0}

is closed.

trace BW-Plug-in The dynamic connection
is closed.

None.

TIBCO-BW-PALETTE-
SAP-201007

Context timeout for

transaction is {0} ms

trace BW-Plug-in The context of the
transaction times out.

None.

TIBCO-BW-PALETTE-
SAP-201008

Context Timeout for

transaction context in

dynamic connection

activity either

contains no or invalid

value, value defaulted

to 30000ms{0}

trace BW-Plug-in The context of the
transaction times out.
No value or an invalid
value is specified for the
contextTimeout input
item of the Dynamic
Connection activity. The
default value of 30000
milliseconds is used.

None.

TIBCO-BW-PALETTE-
SAP-201009

Reply to RFC/BAPI

Listener Activity: {0},

Job ID: {1}, CPIC

Conversation ID: {2}

debug BW-Plug-in Displays the Job ID and
CPIC Conversation ID of
the RFC/BAPI Listener
activity.

None.

TIBCO-BW-PALETTE-
SAP-202001

Received a message in

the RAW format. IDoc

Number = [{0}].

debug BW-Plug-in An IDoc message in raw
format is received.

None.

TIBCO-BW-PALETTE-
SAP-202002

Received a message in

the XML format. IDoc

Number = [{0}].

debug BW-Plug-in An IDoc message in
XML format is received.

None.
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TIBCO-BW-PALETTE-
SAP-202003

Posting the IDoc to the

client. TID=[{0}], IDoc

Input Mode=[{1}].

debug BW-Plug-in An IDoc is being posted
to the client.

None.

TIBCO-BW-PALETTE-
SAP-202004

Posted the IDoc to the

client. TID=[{0}].

debug BW-Plug-in An IDoc is posted to the
client.

None.

TIBCO-BW-PALETTE-
SAP-202005

The transaction is

confirmed. The TID is

[{0}].

debug BW-Plug-in The transaction of
posting an IDoc to the
SAP system is
confirmed.

None.

TIBCO-BW-PALETTE-
SAP-202006

Confirmation report has

been published on the

queue [{0}].

debug BW-Plug-in A confirmation report is
published in the
confirmation queue [{0}].

None.

TIBCO-BW-PALETTE-
SAP-203001

Received the message of

IDoc from the queue

[{0}]. IDoc Name=[{1}],

IDoc Number=[{2}]

debug BW-Plug-in An IDoc message is
received from the queue
[{0}].

None.

TIBCO-BW-PALETTE-
SAP-203002

Acknowledged the

message with the ID

[{0}] from the queue

[{1}].

debug BW-Plug-in The received message
with the ID [{0}] is
acknowledged.

None.

TIBCO-BW-PALETTE-
SAP-203003

Posting the IDoc to the

client. TID=[{0}], IDoc

Input Mode=[{1}].

debug BW-Plug-in An IDoc is being posted
to the client.

None.

TIBCO-BW-PALETTE-
SAP-203004

Posted the IDoc to the

client. TID=[{0}].

debug BW-Plug-in An IDoc is posted to the
client.

None.
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TIBCO-BW-PALETTE-
SAP-203005

The transaction is

confirmed. The TID is

[{0}].

debug BW-Plug-in The transaction of
posting an IDoc to the
SAP system is
confirmed.

None.

TIBCO-BW-PALETTE-
SAP-203006

On exception in IDoc

Reader from

AbstractJmsReceive.

Started value is [{0}].

debug BW-Plug-in An exception is returned
from
AbstractJmsReceive.

None.

TIBCO-BW-PALETTE-
SAP-203007

On stop in IDoc Reader

from

AbstractJmsReceive.

Started value is [{0}].

debug BW-Plug-in The stop method is
invoked by
AbstractJmsReceive.

None.

TIBCO-BW-PALETTE-
SAP-203008

Confirmation report has

been published on the

queue [{0}].

debug BW-Plug-in A confirmation report is
published in the
confirmation queue [{0}].

None.

TIBCO-BW-PALETTE-
SAP-203009

Received a message in

the RAW format. IDoc

Number = [{0}].

debug BW-Plug-in An IDoc message in raw
format is received.

None.

TIBCO-BW-PALETTE-
SAP-203010

Received a message in

the XML format. IDoc

Number = [{0}].

debug BW-Plug-in An IDoc message in
XML format is received.

None.

TIBCO-BW-PALETTE-
SAP-203011

The connection to EMS

server has been

established.

debug BW-Plug-in The connection to the
EMS server has been
established.

None.

130

TIBCO ActiveMatrix BusinessWorks™ Plug-in for SAP Solutions User's Guide



Error Code and Error
Message Role Category Description Solution

TIBCO-BW-PALETTE-
SAP-203012

The segment instance

{0} does not contain

attribute {1}

debug BW-Plug-in The attribute is absent in
the segment instance,
see log for details.

None.

TIBCO-BW-PALETTE-
SAP-203013

The default values will

be used

debug BW-Plug-in Show default value is
used as attribute is
absent in the segment
instance.

None.

TIBCO-BW-PALETTE-
SAP-203014

Segment name: {0} added

debug BW-Plug-in Show the segment name
added for EDI_DD40,
see log for details.

None.

TIBCO-BW-PALETTE-
SAP-204001

Received message IDoc

Number = [{0}].

debug BW-Plug-in Received message IDoc
Number = [{0}].

None.

TIBCO-BW-PALETTE-
SAP-204002

Received message IDoc

Name = [{0}].

debug BW-Plug-in Received message IDoc
Name = [{0}].

None.

TIBCO-BW-PALETTE-
SAP-204003

Doc XML parsing with

Input mode = [{0}].

debug BW-Plug-in IDoc XML parsing with
Input mode = [{0}].

None.

TIBCO-BW-PALETTE-
SAP-204004

Input IDoc XML parsed

successfully.

debug BW-Plug-in Input IDoc XML parsed
successfully.

None.

TIBCO-BW-PALETTE-
SAP-206001

debug BW-Plug-in Input received message
type and IDoc number
to IDocConverter after
parsing

None

TIBCO-BW-PALETTE-
SAP-401001

Unable to convert

string "{0}" to {1} for

{2} in {3}, data

suppressed.

warn BW-Plug-in The string {0} in the {2}
field cannot be
converted to the data
type {1} in the {3} tab.

Check the field
configuration.
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TIBCO-BW-PALETTE-
SAP-500001

Invalid SAP Connection

reference. SAP

Connection is not

specified.

error BW-Plug-in The SAP connection is
not specified for the
activity.

Specify the SAP
connection for the
activity.

TIBCO-BW-PALETTE-
SAP-500002

Invalid Server

Connection reference or

Server Connection is

disabled. Please pick a

enabled sever

connection.

error BW-Plug-in The server connection
reference is invalid, or
the server connection is
disabled.

Select an enabled
server connection.

TIBCO-BW-PALETTE-
SAP-500003

Cannot get server

connection {0}

error BW-Plug-in Using the server
connection {0} fails.

Check the server
connection
parameter.

TIBCO-BW-PALETTE-
SAP-500004

{0}

error BW-Plug-in Initializing the RFC
BAPI Listener activity
fails.

Check the
program ID,
gateway service,
or gateway host in
the SAP
connection.

TIBCO-BW-PALETTE-
SAP-500005

{1}

error BW-Plug-in Failed to dump IDoc to
file.

Check the specific
error message.

TIBCO-BW-PALETTE-
SAP-500006

Invalid Client

Connection reference.

Please check your

connection

configuration.

error BW-Plug-in Invalid Client
Connection reference.

Check your
connection
configuration.

TIBCO-BW-PALETTE-
SAP-501002

Context timeout is

Zero, cannot continue

RFC invoke in context

error BW-Plug-in The timeout value of the
context is zero.

Reset the timeout
value for the
context.
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TIBCO-BW-PALETTE-
SAP-501003

Invalid Connection for

pool {0}

error BW-Plug-in The connection to the
connection pool {0} is
invalid.

Check the
connection
parameters.

TIBCO-BW-PALETTE-
SAP-501007

Cannot find transaction

with SessionID: {0} to

Continue.

error BW-Plug-in Finding the transaction
with the session ID {0}
fails.

Check the session
ID.

TIBCO-BW-PALETTE-
SAP-501009

Request Response error.

ErrorMessage : {0}

error BW-Plug-in The error {0} occurs
when the RFC/BAPI
request fails.

Check the
configuration
parameters.

TIBCO-BW-PALETTE-
SAP-501010

The transaction

committed failure for

RFC function : {0}

errorMessage: {1}

error BW-Plug-in The error {1} occurs
when the transaction of
the function {0} fails to
be committed.

Check the
configuration
parameters.

TIBCO-BW-PALETTE-
SAP-501011

RFCBAPI Listener error.

Timeout waiting for

reply, Function: {0}.

error BW-Plug-in The response of the
function {0} times out.

Check the
configuration
parameters.

TIBCO-BW-PALETTE-
SAP-501013

Request Response error.

errorMessage : {0}

error BW-Plug-in The error {0} occurs
when failing to find the
function in the SAP
system.

Check the function
configuration.

TIBCO-BW-PALETTE-
SAP-501014

RFC error encountered

and AutoCommit would be

skipped for RFC

function : {0} error:

{1}

error BW-Plug-in The error {1} occurs, and
the function module {0}
can skip the automatic
commit.

Check whether the
return TYPE is "S"
or " " or "I" in the
case of the
associated TYPE
starting with
"BAPIRET" from
EXPORT
parameters and
TABLE parameters
on the SAP server.
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TIBCO-BW-PALETTE-
SAP-501015

Transaction with

SessionID: {0} timed

out.

error BW-Plug-in The transaction with the
session ID {0} times out.

Check the earlier
error messages in
the log file.

TIBCO-BW-PALETTE-
SAP-501016

{0}

error BW-Plug-in Reconnecting to the SAP
system fails.

Check connection
parameters and
the network
connectivity.

TIBCO-BW-PALETTE-
SAP-501017

There is an empty

string or invalid

character at the

attribute of connection

type. {0}

error BW-Plug-in An empty string or
invalid character exists
in the value of the
connectionType input
element.

Check the value of
the
connectionType

input element.

TIBCO-BW-PALETTE-
SAP-501018

Created Dynamic

connection failed. -{0}

error BW-Plug-in Creating a dynamic
connection fails.

None.

TIBCO-BW-PALETTE-
SAP-501020

SessionID Invalid,

please check whether

mapping it.

error BW-Plug-in The session ID of the
Dynamic Connection
activity is invalid.

Check the value of
the seeionID
input element.

TIBCO-BW-PALETTE-
SAP-501021

Unexpected scene. {0}

error BW-Plug-in An unexpected scene
happens.

None.

TIBCO-BW-PALETTE-
SAP-501022

Connection Error due to

Invalid logon

credentials. Unable to

create a connection

with the target

application {0} using

connection parameters

{1} and the target

application error is

{2}

error BW-Plug-in Indicates the error
specific to invalid
credentials

Indicates the error
specific to invalid
credentials
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TIBCO-BW-PALETTE-
SAP-502001

Error in posting IDOC.

ErrorMessage : {0}

error BW-Plug-in The error {0} occurs in
Post IDoc to SAP
activity while posting
the IDoc.

None.

TIBCO-BW-PALETTE-
SAP-502002

Error occurred when

trying to send the

confirmation message.

The error message is

[{0}].

error BW-Plug-in The error {0} occurs
when trying to send the
confirmation message.

None.

TIBCO-BW-PALETTE-
SAP-502003

Error occurred when

initialization. The

error message is [{0}].

error BW-Plug-in The error [{0}] occurs
when initializing the
Post IDoc to SAP
activity.

None.

TIBCO-BW-PALETTE-
SAP-502004

Error occurred when

initialize the

confirmation IDoc

destination [{0}]. The

error message is [{1}].

error BW-Plug-in The error {1} occurs
when initializing the
confirmation IDoc
destination [{0}].

Please check that
the EMS server is
up and running
and destinations
are allowed to be
created on it

TIBCO-BW-PALETTE-
SAP-502005

Could not find the

mandatory property

EDI_DC40 in the

message.

error BW-Plug-in The mandatory property
EDI_DC40 cannot be
found in the message.

Provide input to
mandatory input
field in the
EDI_DC40 section
of input

TIBCO-BW-PALETTE-
SAP-503001

Sent the message to the

error destination

[{0}], due to the error

[{1}].

error BW-Plug-in An IDoc is sent to the
error destination [{0}]
because of the error
[{1}].

None.

TIBCO-BW-PALETTE-
SAP-503002

Error occurred when

initialization. The

error message is [{0}].

error BW-Plug-in The error [{0}] occurs
when initializing the
IDoc Reader activity.

None.
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TIBCO-BW-PALETTE-
SAP-503003

Could not find the

mandatory property

EDI_DC40 in the

message.

error BW-Plug-in The mandatory property
EDI_DC40 cannot be
found in the message.

Provide input to
mandatory input
field in the
EDI_DC40 section
of input

TIBCO-BW-PALETTE-
SAP-503004

Error occurred when

getting JCo attributes.

The error message is

[{0}].

error BW-Plug-in The error {0} occurs
when getting JCo
attributes.

None.

TIBCO-BW-PALETTE-
SAP-503005

Error occurred when

initialize the error

IDoc destination [{0}].

The error message is

[{1}].

error BW-Plug-in The error {1} occurs
when initializing the
error IDoc destination
[{0}].

Please check that
the ems server is
up and running
and destinations
are allowed to be
created on it

TIBCO-BW-PALETTE-
SAP-503006

Error occurred when

initialize the

confirmation IDoc

destination [{0}]. The

error message is [{1}].

error BW-Plug-in The error {1} occurs
when initializing the
confirmation IDoc
destination [{0}].

Please check that
the ems server is
up and running
and destinations
are allowed to be
created on it

TIBCO-BW-PALETTE-
SAP-503007

Error occurred when

trying to send the

confirmation message.

The error message is

[{0}].

error BW-Plug-in The error {0} occurs
when trying to send the
confirmation message.

None.

TIBCO-BW-PALETTE-
SAP-503008

Application will try to

establish the

connection in 3

seconds.

error BW-Plug-in The plug-in tries to
establish the connection
in 3 seconds.

None.
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TIBCO-BW-PALETTE-
SAP-503009

Error occurred during

the inbound process,

the error = [{0}]

error BW-Plug-in IDoc Reader generic
Error.

None.

TIBCO-BW-PALETTE-
SAP-503010

Sent message to the

error destination {0}.

{1}.

error BW-Plug-in Indicates the mismatch
error occurs.

None.

TIBCO-BW-PALETTE-
SAP-504001

Error in preparing raw

IDOC. ErrorMessage :

{0}.

error BW-Plug-in Unexpected errors while
parsing XML IDoc.

Please check the
XML data.

TIBCO-BW-PALETTE-
SAP-504002

Error occurred when

initialization. The

error message is [{0}].

error BW-Plug-in Error while initializing
the IDoc Renderer.

Please check the
connection
parameters,
initialization
parameters.

TIBCO-BW-PALETTE-
SAP-505001

Failed to create

connection to the KAFKA

server. Check SAP

Connection shared

resource's 'Message

Source Configuration'

tab and if the KAFKA

server is running.

error BW-Plug-in Indicates that Kafka
server is not running.

None

TIBCO-BW-PALETTE-
SAP-505002

Error occurred while

sending IDoc to Kafka

Server. The error

message is [{0}].

error BW-Plug-in Indicates there was
some problem in
sending IDoc to Kafka
server and detailed error
message is: {0}.

None

TIBCO-BW-PALETTE-
SAP-506001

error BW-Plug-in Throws error when
invalid IDoc Received
other than configured

Verify and set the
correct IDoc xpath
expression to
process correct
IDoc's
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly in
HTML and PDF formats.
The TIBCO Product Documentation website is updated frequently and is more current than any other
documentation included with the product.

Product-Specific Documentation

The following documents for this product are available on the TIBCO ActiveMatrix BusinessWorks™ Plug-
in for SAP Solutions page.

● TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions Release Notes

● TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions Installation

● TIBCO ActiveMatrix BusinessWorks Plug-in for SAP Solutions User's Guide

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support website.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO. You
also need a user name and password to log in to TIBCO Support website. If you do not have a user
name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
TIBCO Community.
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